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Revision History

The following table summarizes the revisions made to this manual.These revisions are
noted in this manual with revision marks in the left margin.

Release Date Description
NetBackup 4.5 March 2002 Original publication.
Feature Pack January 2003  This document version describes new features provided for NetBackup

for Microsoft Exchange Server in NetBackup Feature Pack 4.5 3 F.
Ensure that you are installing this feature pack for use with this
document.

New Features:

Differential-incremental- and cumulative-incremental backups can
now be performed of mailboxes.

Backups and restores can be performed of folders and messages in
the Microsoft Exchange Public store.

The Microsoft Exchange Site Replication Service and the Microsoft
Exchange Key Management Server databases can now be backed up
and restored.

The NetBackup for Microsoft Exchange Server Agent is now
installed with the server and client software. It is no longer
necessary to perform a separate installation of this agent.

Users can enable Single Instance Storage for message attachments so
only one copy of an attachment is written to the backup.
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About This Guide

This guide explains how to configure and use NetBackup for Microsoft Exchange Server
to perform online backups and restores of Microsoft Exchange Server.

This document is the same as Net Backup_Admi nCQui de_MSExchg_NT. pdf distributed
with the NetBackup for Microsoft Exchange Server software.
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Audience

Audience

This guide is intended for system administrators responsible for configuring and
maintaining systems using Microsoft Exchange Server.

This guide assumes that you have:

a
a

A basic understanding of system administration.

A working understanding of the NetBackup client and server software and are
familiar with the information covered in the following NetBackup manuals:

- NetBackup User’s Guide for Windows

- NetBackup System Administrator’s Guide for Windows or NetBackup System
Administrator’s Guide for UNIX

- NetBackup Troubleshooting Guide for UNIX or NetBackup Troubleshooting Guide for
Windows

A thorough understanding of the following Microsoft Exchange Server topics:
- Database file types and their relationships at recovery time

- Data recovery scenarios

Organization

This guide is organized as follows:

O

The “Introduction” chapter describes the features of NetBackup for Microsoft
Exchange Server.

The “Requirements and Installation” chapter describes how to install the NetBackup
for Microsoft Exchange Server.

The “Configuration” chapter provides details for configuring NetBackup for
Microsoft Exchange Server.

The “Operating Instructions” chapter describes NetBackup backup and restore
options for NetBackup for Microsoft Exchange Server.

The “Troubleshooting NetBackup” chapter describes the debug logs NetBackup
creates that can be used for troubleshooting.

The “Troubleshooting the Exchange Server” chapter describes the common, however
infrequent, problems encountered with the daily operations and management of the
Exchange Servers.

The Appendix “ESEUTIL and ISINTEG Line Switches” provides an in-depth
discussion of the ESEUTIL and ISINTEG command line switches.

-—w Xiv
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Related Documents

0O The Appendix “Sample Server Configuration Worksheets” contains sample
worksheets to use when preparing a disaster recovery Kit.

Related Documents

The following documents provide related information. For a more detailed listing of
NetBackup documents, refer to NetBackup Release Notes.

If you have a UNIX server, refer to these documents:
O NetBackup System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup on a UNIX server.
O NetBackup Media Manager System Administrator’s Guide for UNIX

Explains how to configure and manage the storage devices and media on UNIX
NetBackup servers. Media Manager is part of NetBackup.

0O VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup
DataCenter and BusinesServer products, including Media Manager.

If you have a Windows server, refer to these documents:
O NetBackup System Administrator’s Guide for Windows

Explains how to configure and manage NetBackup on a Windows server.
0O NetBackup Media Manager System Administrator’s Guide for Windows

Explains how to configure and manage the storage devices and media on Windows
NetBackup servers. Media Manager is part of NetBackup.

0O VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup
DataCenter and BusinesServer products, including Media Manager.

You may also need the following resources from Microsoft Corporation:

Microsoft Exchange Server white papers and FAQs (go to
http://ww. m crosoft.com exchange and search for “Disaster Recovery”)

Microsoft Exchange Administrator's Guide
Microsoft Exchange Concepts and Planning Guide
Microsoft TechNet

Microsoft BackOffice Resource Kit

About This Guide xv ¥



Accessibility Features

http://ww. msexchange. org

Glossary

If you encounter unfamiliar terminology, consult the NetBackup online glossary. The
glossary contains terms and definitions for NetBackup and all additional NetBackup
options and agents.

The NetBackup online glossary is included in the NetBackup help file.
To access the NetBackup online glossary

1. Inthe NetBackup Administration Console (or from the Backup, Archive, and Restore
client interface), click Help > Help Topics.

2. Click the Contents tab.

3. Click NetBackup Glossary of Terms.

The glossary displays in a help window. Use the scroll function to navigate through the
glossary.

Accessibility Features

NetBackup contains features that make the user interface easier to use by people who are
visually impaired and by people who have limited dexterity. Accessibility features
include:

O Support for assistive technologies such as screen readers and voice input (Windows
servers only)

O Support for keyboard (mouseless) navigation using accelerator keys and mnemonic
keys

For more information, see the NetBackup System Administrator’s Guide.

Conventions

The following section explains typographical and other conventions used in this guide.

-—w XVi
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Conventions

Type

Style

The table below describes type face and type style conventions.

Typographical Conventions

Typeface

Usage

Bol d fixed width

Fi xed wi dth

Italics

Bold type (no italics)

Input typed at the keyboard. For example, you might see, “Type cd to
change directories.”

Paths, commands, filenames, or output. For example, you might see,
“The default installation directory is / opt / openv.”

Book titles, new terms, or terms used for emphasis. For example, you
might see, “Do not ignore cautions.”

Used for placeholder text or variables, as in, “Replace filename with the
name of your file.”

This font is also used to point out NetBackup product-specific or
platform-specific differences. For example: This option is only applicable
for NetBackup DataCenter.

Graphical user interface (GUI) objects, such as fields or menu choices.

For example, you might see, “Enter your password in the Password
field.”

Notes and Cautions

Note This is a Note. Notes are used to call attention to information that makes using the
product easier or helps in avoiding problems.

Caution This is a Caution. Cautions are used to warn about situations that could cause

data loss.

Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example,
holding down the Ctrl key while pressing another key. Keyboard command sequences are
indicated by connecting the keys with a plus sign, as in the following example:

Press Ctrl+t

About This Guide
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Conventions

Command Usage

The following conventions are frequently used in the synopsis of command usage.
brackets [ ]

The enclosed command line component is optional.
Vertical bar or pipe (])

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command ar gl| arg2

In this example, the user can use either the argl or arg2 variable.

Navigating Multiple Menu Levels

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a
continued action.

The following example shows how the > is used to condense a series of menu selections
into one step:

O Select Start > Programs > VERITAS NetBackup > NetBackup Administration
Console.

The corresponding actions could be described in more steps as follows:
1. Click Start in the task bar.

2. Move your cursor to Programs.

3. Move your cursor to the right and highlight VERITAS NetBackup.

4. Move your cursor to the right. First highlight and then click NetBackup
Administration Console.

Terms

The following term is used in VERITAS NetBackup documentation to increase readability
while maintaining technical accuracy.

O Microsoft Windows, Windows

xviii
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Getting Help

Terms used to describe a specific product or operating system developed by
Microsoft, Inc. Some examples are, Windows 2000, Windows .NET, Windows servers,
Windows clients, Windows platforms, or Windows GUI. For more information on the
Windows operating systems that NetBackup supports, refer to the VERITAS
NetBackup Release Notes for UNIX and Windows or go to the VERITAS support web site
athttp://ww. support.veritas.com

Note When a specific Windows product is identified in the documentation, only that

particular product is valid in that instance.

Getting H

For

elp

updated information about this product, including system requirements, supported

platforms, supported peripherals, and a list of current patches available from Technical

Sup

port, visit our web site:

http://ww. support.veritas. conf

VERITAS Customer Support has an extensive technical support structure that enables you
to contact technical support teams that are trained to answer questions to specific
products. You can contact Customer Support by sending an e-mail to
support@veritas.com, or by finding a product-specific phone number from the VERITAS
support web site. The following steps describe how to locate the proper phone number.

1.

2.

Open htt p: //www. support.veritas.conl inyourweb browser.
Click Contact Support. The Contacting Support Product List page appears.
Select a product line and then a product from the lists that appear. The page will

refresh with a list of technical support phone numbers that are specific to the product
you just selected.

About This Guide
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Introduction

1

NetBackup for Microsoft Exchange Server extends the capabilities of NetBackup to
include online backups and restores of MS Exchange databases when MS Exchange Server
has been installed. This capability is provided as an add-on or extension to the NetBackup
for Windows client software. Because this product is tightly integrated with the Backup,
Archive, and Restore interface for Windows, this document only gives an overview of
NetBackup functionality. In general, backup and restore operations for MS Exchange files
are identical to other NetBackup file operations, except where noted in this document.

Features

Online Backup

Minimal Back Up Time

Microsoft Exchange
Server Backup Methods

Microsoft Exchange Server data and transaction logs can be backed up
without taking the Microsoft Exchange Server offline. This ensures the
availability of Microsoft Exchange services and data during the Microsoft
Exchange Server backup.

An administrator has the choice of performing full or incremental
backups (differential-incremental backup or cumulative-incremental
backup). A full backup may take considerable time, so it may be
performed infrequently. In the interim, updates that have occurred since
the full backup can be quickly and incrementally backed up by backing
up only the transaction logs. In the event of a failure, the full and
incremental backups would be restored.

During recovery, the Microsoft Exchange Server will update the
databases, applying each of the logged transactions to the database. After
the Microsoft Exchange Server recovery has completed, the system will
have been brought back to the state as it existed when the last incremental
backup was performed.

NetBackup supports all Microsoft Exchange Server backup methods: full
backup, cumulative-incremental backup, differential-incremental backup
and copy.




Features

Tight NetBackup
Integration

Central Administration

Media Management

Automated Backups

Restore Operations

Redirected Restores

Individual Mailbox
Backup and Restore

Tight integration with NetBackup means two things:

1. An administrator already familiar with NetBackup procedures and
software can easily configure and use NetBackup to perform
Microsoft Exchange Server backup and restore operations.

2. Features and strengths of the NetBackup product suite are available to
the Microsoft Exchange Server backup user. These features include
software data compression and encryption, scheduled and
user-directed operations, multiple data stream backups, in-line tape
copy, etc. Many of these features are described, in detail, in the
NetBackup System Administrator’s Guide for Windows.

Administrators can define, back up, and restore Microsoft Exchange
Servers and other NetBackup client machines from a central location.

Microsoft Exchange Server backups are saved directly to a wide variety of
storage devices supported by the NetBackup master server.

Administrators can set up schedules for automatic, unattended backups
for local or remote clients across the network. These backups can be full or
incremental and are managed entirely by the NetBackup server from a
central location. The administrator can also manually back up clients.

An administrator using the Backup, Archive, and Restore interface can
browse backups and select the ones to be restored.

In a redirected restore, you restore an object (database, mailbox, folder, or
message) to a new location.

Administrators can perform backup and restore operations on individual
mailboxes and folders. The capabilities of this feature are:

o Scheduled backups of individual mailboxes and folders
o User-directed backups of individual mailboxes and folders

o Restore of individual mailboxes, folders, or messages, which can be
performed using the Backup, Archive, and Restore interface (on the
server or on the client) or the Remote Administration Console for
Windows or UNIX

NetBackup for Microsoft Exchange Server System Administrator’s Guide



Backup Operations

Microsoft Exchange
2000 Backup and
Restore Features

Backup and Restore of
the Exchange Public
Store

NetBackup can back up and restore storage groups, as well as back up
and restore databases within the storage group. The capabilities of this
feature are:

o Scheduled backups of individual storage groups and databases
o User-directed backups of individual storage groups and databases

o Restore of individual storage groups and databases, which can be
performed using the Backup, Archive, and Restore interface (on the
server or on the client) or the Remote Administration Console for
Windows or UNIX

NetBackup can also perform backups and restores of the Microsoft
Exchange Key Management Server (KMS) and Microsoft Exchange Site
Replication Service (SRS) databases.

NetBackup can backup and restore the Exchange Public Store. The
capabilities of this feature are:

o Scheduled backups of individual folders
o User-directed backups of individual folders

o Restore of individual folders or messages, which can be performed
using the Backup, Archive, and Restore interface (on the server or on
the client) or the Remote Administration Console for Windows or
UNIX

Single Instance Storage - Users can enable Single Instance Storage for message attachments so

(SIS) of message
attachments

only one copy of an attachment is written to the backup.

Backup Operations

This section presents overview information on NetBackup for Microsoft Exchange Server

backup operations.

Limitations

The following limitations exist for NetBackup for Microsoft Exchange Server.

Individual Mailbox Operations

When performing an individual mailbox backup and restore, be aware of the following

limitations:

Chapter 1, Introduction



Backup Operations

0O Only backups of mailboxes or folders or both are allowed. You cannot specify the
backup of an individual message.

NetBackup Java Policy Wizard

Mailboxes and Exchange 2000 storage groups cannot be added to the Files list when using
the Java Administration Console’s NetBackup Policy Wizard to create a policy. In order to
backup individual mailboxes or storage groups, add no entries on the Files screen and
continue through the Wizard. Once the policy has been created, manually add the
mailboxes or storage groups you wish to back up to the Files list.

Exchange 2000 Backups
When performing an Exchange 2000 backup, be aware of the following limitations:

0O Incremental and differential backups are ONLY supported at storage group level.
Incremental and differential backups of individual databases within storage group are
not supported.

Methods

NetBackup provides three methods to perform backups: automatic, manual, and
user-directed. This section contains an overview of these methods. For more information
on these backup methods and other administrator-directed activities, refer to the
NetBackup System Administrator’s Guide for UNIX if you are using a UNIX server or to the
NetBackup System Administrator’s Guide for Windows if you are using a Windows server.

Automatic Backups

The NetBackup administrator can schedule full backup and incremental backups
(differential incremental backup or cumulative incremental backup) that occur
automatically and unattended, under the control of the NetBackup server. Automatic
backups will meet most of your backup requirements.

Manual Backups

NetBackup allows the administrator to perform immediate manual backups of files
associated with any policy, client, or schedules. The manual backup option can be useful
for the following situations:

O Testing a configuration

O When workstations miss their regular backups

! NetBackup for Microsoft Exchange Server System Administrator’s Guide



Backup Operations

0O Before installing new software (to preserve the old configuration)
O Preserving records before a special event such as when companies split or merge

In some cases, it may be useful to create a policy and schedule that you use only for
manual backups. You can do this by creating a policy with a single schedule that has no
backup window defined (and therefore never executes automatically).

User-Directed Backups

User-directed backups require a User Backup schedule type to be defined in the
MS-Exchange-Server policy. Performing user-directed backups of MS Exchange databases
is similar to using the Backup, Archive, and Restore interface to back up normal files. The
example described in “Performing User-Directed Backups of Exchange Server” on

page 68 uses the Backup, Archive, and Restore interface to perform an online backup of
the Microsoft Exchange Server Information Store database.

Microsoft Exchange Server Files That are Backed Up

This section describes the set of files that may be backed up during a backup operation.

Database Files

MS Exchange 5.x

There are three Microsoft Exchange Server database files, one for the Directory and two
for the Information Store. The following table gives the database names and their default
locations.

Default locations for MS Exchange 5.x database files

Database File Name Default Directory

Directory Dir.edb ... \exchsrvr\dsadat a
Information Store - Public Pub. edb ... \exchsrvr\ ndbdat a
Information Store - Private Priv. edb ... \exchsrvr\ ndbdat a

Chapter 1, Introduction 5 Y
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MS Exchange 2000

There can can be up to 16 database stores, each consisting of 2 database files. The
following table gives the database hames and their default locations for the first Exchange
2000 Storage group.

Default locations for MS Exchange 2000 database files

Database File Name Default Directory
Mailbox Store Privl. edb ... \exchsrvr\ ndbdat a
Privl.stm ... \exchsrvr\ ndbdat a

Note Subsequent storage groups and databases may have different locations and names
(user-defined).

Database Patch Files

Database patch files are used to handle transactions being written to the database during a
backup. During the backup operation, data is read from the . edb file. If a transaction
causes an update to a part of the . edb file that has already been backed up, then it is
written to the patch file for that database. Patch files only exist during the backup process.
These patch files are used during the Microsoft Exchange Server recovery process to
update the restored database file with the transactions that were in progress during the
backup. The following table gives the names of the patch files and their default locations.

Default locations for patch files

Database Patch File File Name Default Directory

Directory Dir. pat ...\exchsrvr\dsadata
Information Store - Public Pub. pat ...\'exchsrvr\ ndbdat a
Information Store - Private Priv. pat ...\'exchsrvr\ ndbdat a

Transaction Logs

For performance and recoverability, the Microsoft Exchange database uses transaction
logs to accept, track, and maintain data. All transactions are first written to transaction
logs and memory, and then to their respective databases. Transaction logs can be used to

A NetBackup for Microsoft Exchange Server System Administrator’s Guide
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recover Directory or Information Store databases in the event that a failure has corrupted
the database. The Information Store has two separate databases but transaction logs are
kept in a single set.

Since transactions are first written to the edb. | og file and then later written to the
database, the current actual or effective database is a combination of the uncommitted
transactions in the transaction log file and the actual . edb database file. When the

edb. | og file is filled with transaction data, it is renamed and a new edb. | og file is
created. When an edb. | og file is renamed, the renamed log files are stored in the same
subdirectory. The renamed log files are named in a sequential numbering order (for
instance: edb00014. | og, edb00015. | 0g, etc. using hexadecimal).

The following table gives the names of the transaction logs and their default locations.

Default locations for transaction logs

Database Transaction Log File Name Default Directory
Directory edbXXXXX. | og ...\exchsrvr\dsadata
Information Store edbXXXXX. | og ... \exchsrvr\ ndbdat a

Where XXXXX is a five digit hexadecimal number that is incremented each time an
edb. | og file is renamed.

For full backups and differential incremental backups, the committed transaction logs are
truncated (deleted) by MS Exchange after a successful backup.

Note After every 5MB of transaction log data is written, a new log is created, even though
the transaction data may not be committed to the database. There may be several
transaction logs containing uncommitted data, and therefore they will not be
purged.

Transactions in log files are committed to the respective edb file when the service is
shut down normally. For example, when the Information Store service experiences a
normal shutdown (service shuts down with no errors), any transactions that existed
in log filesand not in the pri v. edb and or pub. edb files are committed to the edb
files. Log files should not be manually purged; it is best to purge logs through the
backup process.

The following process takes place during a full backup:
0O Database files are written to the backup media.
O Patch files are created to accommodate updates to the database during the backup.

O Transaction logs are written to the backup media.
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Restore Operations

O Patch files are written to the backup media.

0O Committed transaction logs are truncated (deleted) by MS Exchange. These logs are
no longer required since they have been committed to the database file and they have
been written to the backup media.

Restore Operations

Using a few simple operations, an administrator using the Backup, Archive, and Restore
interface can browse Microsoft Exchange Server backups and select the ones to be
restored.

Limitations with Exchange 2000 restores

The following limitations exist for NetBackup for Microsoft Exchange Server when
performing Exchange 2000 restore operations.

O Arrestore of more than one storage group at a time (per job) will fail.

Methods

NetBackup provides three methods to perform restores:
O server-directed

O redirecting a restore to a different client

O redirecting a restore to a different path

An overview of these methods is given in the following sections. For more information on
these restore methods and other administrator-directed activities, refer to the NetBackup
System Administrator’s Guide for UNIX or NetBackup System Administrator’s Guide for
Windows.

Server-Directed Restore

An administrator can browse NetBackup for Microsoft Exchange Server files and select
the ones to be restored. When the administrator initiates the restore, the request is passed
from the client to the NetBackup master server. Once the server validates the request, the
restore operation becomes fully managed by the server, which identifies the storage
device and the volume containing the MS Exchange databases by querying the
NetBackup database. The server then transmits the data back to the client.
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Restore Operations

NetBackup restores MS Exchange databases and transaction log extents from a range of
backups. By default, this range includes the last full backup and all user-directed and
incremental backups appropriate since that full backup.

NetBackup will allow you to select the NetBackup server from which files will be
restored, to view the backup history, and to select items to restore for:

0O aspecific client

O other clients that were backed up by the selected NetBackup server

Redirecting a Restore to a Different Client

Files or folders can be restored to a client other than the one from which they were backed
up. This is possible only if the NetBackup administrator sets up the configuration to allow
it and the NetBackup for Lotus Notes agent has been installed on the alternate client. The
administrator using the NetBackup Administration Console on the master server or using
the Remote Administration Console can direct restores to any NetBackup client
(regardless of which client the files came from). Please see the appropriate NetBackup
manuals for the configuration needed for this type of redirected restore.

Because the Microsoft Exchange Directory database contains machine and security
information, it can only be restored to the original computer or a clone of the original
computer. The Microsoft Exchange Information Store databases may be restored to a
different Microsoft Exchange Server.

Additional Requirements for MS Exchange 2000
Before redirecting the restore of storage groups or individual databases:
0O The storage groups and databases must exist on the target server.

0O The storage groups and databases must have the same names as the original storage
groups or databases.

0O The target databases must be configured so that they can be overwritten. Using the
Exchange System Manager, right-click the database you want to overwrite, click
Properties, and then on the Database tab, select This database can be overwritten by
arestore.

0O The target server must have the same Organization and Administrative Group name
as the source server.

Redirecting a Restore to a Different Path

A user can restore mailbox objects and Public folder objects to folders that are different
from the folders from which the objects were backed up. Database objects should not be
redirected to different paths.
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Requirements and Installation 2

This chapter describes the requirements for using NetBackup for Microsoft Exchange
Server and how to install the agent.




Requirements

Requirements

The following are the requirements for using NetBackup for Microsoft Exchange Server.

O Version 4.5 Feature Pack of the NetBackup client for Windows, Remote
Administration Console for Windows, or the NetBackup Server for Windows,
installed on the Microsoft Exchange Server.

O Microsoft Exchange Server, version 5.0 or greater.

O To back up messages or mailboxes, a MAPI email client must be installed on the
Microsoft Exchange Server.

Exchange Cluster Environment

In an Exchange cluster environment, the virtual Exchange name is used as the client name
for performing backup and restore operations of Exchange objects (databases, mailboxes,
and folders).

The following requirements need to be met for each Exchange node in the cluster;
0O The NetBackup Windows client installed.
O The NetBackup Client Service Account configured for the Mailbox feature.

O The Mailbox for NetBackup Client Service configured for the Mailbox feature.

Backup Operations

The following are the requirements to perform an online backup of Microsoft Exchange
Server databases and mailboxes.

Mailboxes

The following Exchange Server services must be running on the target Microsoft
Exchange Server computer that will be used to back up individual mailbox objects or to
which individual mailbox objects will be restored.

0O System Attendant (MSEXCHANGESA)
0O For Exchange 5.x, Directory (MSEXCHANGEDS)
0O Information Store (MSEXCHANGEIS)

Microsoft Exchange 5.x
0O The following services must be running on the NetBackup client machine:

- Microsoft Exchange System Attendant (MSEXCHANGESA)
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- Microsoft Exchange Directory (MSEXCHANGEDS)
- Microsoft Exchange Information Store (MSEXCHANGEIS)
0O NetBackup client for Windows installed.

Microsoft Exchange 2000

0O The following services must be running on the NetBackup client machine:
- Microsoft Exchange System Attendant (MSEXCHANGESA)
- Microsoft Exchange Information Store (MSEXCHANGEIS)

O NetBackup client for Windows installed.

O All Databases being backed up must be mounted.

Microsoft Key Management Service
0O A functioning KMS database

0O The Microsoft Exchange Key Management Service must be running on the NetBackup
Client machine. (MSEXCHANGEKMS)

Microsoft Site Replication Service
O A functioning SRS database

0O The Microsoft Exchange Site Replication Service must be running on the NetBackup
Client machine. (MSEXCHANGESRS)

Restore Operations

This section explains any special requirements you may need to consider before
performing Microsoft Exchange Server restores.

Mailbox Restores

The requirements for restoring mailbox objects are the same as for mailbox backups. Refer
to “Mailboxes” on page 12 for more information.

Permissions

To restore a Microsoft Exchange Server backup, the account used by the NetBackup client
services must be added to the local computer’s Administrators group. It is not necessary
to add the account to the domain Administrators or domain Admins groups. The
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Administrator privilege is necessary because only administrators can shut down services
in Windows NT. Microsoft Exchange services need to be shut down in order to restore
Microsoft Exchange Server.

Microsoft Exchange Services

Microsoft Exchange System Attendant (MSEXCHANGESA) must be running on the
NetBackup client machine.

Existing Transaction Logs

Depending upon the data recovery scenario you are attempting, you have to take existing
transaction logs into consideration.

Example considerations:
O Keeping existing transaction logs, overwriting any transaction logs that exist.

After you restore the files and the service starts up, the database will commit the
transactions in the logs you have restored. If contiguous logs exist on the server
beyond the log with the highest number you have restored, those transactions will
also be committed.

If there is any gap in the numeric sequence of log names, no further transactions will
be committed beyond the gap. This scenario is useful when the transaction logs are
intact but you require the database to be restored. By keeping existing transaction
logs, Microsoft Exchange Server will be able to recover to the point of the failure
instead of the time of the last full backup or an incremental backup (differential
incremental backup or cumulative incremental backup).

O Delete the existing transaction logs.

Certain situations—such as restoring the Information Store to a different server,
restoring to a previous date without recommitting all the logs that are still on the disk,
or performing a full restore—require existing transaction logs to be deleted.

Additional Requirements For Exchange 2000

O All databases being restored must be dismounted prior to the start of restore
operation.

O The location where the associated log and patch files are to be kept until the database
is restored is the MS Exchange working directory (. . . \ exchsr vr\ ndbdat a). If
storage groups are being restored, a subdirectory is created under the working
directory for each storage group.
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0O After the database is restored, the log and patch files in the temporary location are
applied to the database, and then the current log files are applied. After the restore is

complete, the log and patch files are automatically deleted from the temporary
location (including any subdirectories).

Note Make sure the temporary location for log and patch files is empty before you start a
restore job. If a restore job fails, check the temporary location (including

subdirectories) to make sure any previous log and patch files from a previous
restore job were deleted.
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Registering NetBackup for Microsoft Exchange Server

| Registering NetBackup for Microsoft Exchange Server

| v

NetBackup for Microsoft Exchange Server is installed with the server and client software.
To use this agent you need to register a valid license key for it on the master or media
server.

To register a license key

O Open the NetBackup Administration Console on the master or media server and
choose Help > License Keys.

Refer to the NetBackup System Administrator’s Guide for full details on adding license
keys.

NetBackup for Microsoft Exchange Server System Administrator’s Guide



Configuration 3

This section provides an overview of how to configure NetBackup to perform backup and
restore operations.

0O “Configuring NetBackup for Individual Mailbox Operations”
“Configuration Using the NetBackup Administration Console”

g
0O “Configuring a NetBackup Policy”
g

“Testing NetBackup for Microsoft Exchange Server Configuration Settings”
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Configuring NetBackup for Individual Mailbox Operations

This section provides the configuration information necessary for NetBackup to perform
backup and restore operations of individual mailboxes and folders and of items in the
Public Folders.

NetBackup Client Service Account

By default, the NetBackup Client service uses LocalSystem as the account on which to log
on. To perform individual mailbox backups or restores, the service account needs to be
changed to valid Windows NT domain account.

To verify or modify the Log On account for the NetBackup Client service

1. Open the Windows NT Services control panel application.

2. Double-click on the NetBackup Client Service entry.

3. Ifthe Log On As account is not configured as System Account, proceed with step 6.

4. Change the Log On As account to the account you wish to use for backups and
restores on this client.

Note To change this account, you must have administrator group privileges.

5. Stop and start the NetBackup Client Service.

6. Close the Windows NT Services control panel application.

Creating a Mailbox for the NetBackup Client Service

In order for NetBackup to gain access to the mailboxes and folders to perform backup and
restore operations, the NetBackup Client service account needs to be associated with a
valid Exchange mailbox. It is recommended that you create a uniquely named mailbox for
the NetBackup Client service account.

Exchange 5.x

For Exchange 5.x, if a mailbox is not created for the NetBackup Client service, you can use
any existing mailbox on the Exchange Server to which the NetBackup Client service
account is granted logon rights.
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v To create a mailbox for the NetBackup Client service account

1. Using Exchange Administrator, create a new mailbox with a unique name.

A unigque name is one that does not already exist within the Exchange Organization.
This name cannot be contained as a set of characters in an existing name.

For example, if EXCHL1 has been entered as the unique mailbox name, and there are
other mailbox names such as EXCH1BACKUP or BACKUPEXCH1, backups or
restores of individual mailboxes, or both, will fail.

If you cannot create a unique mailbox name, you must enter the fully qualified name
when configuring the mailbox for the NetBackup Client service account (see
“Configuring NetBackup to Use the Mailbox Associated with the NetBackup Client
Service Account” on page 22). For example:

/ O=Or g_Nane/ OU=Si t e_Nane/ CN=Ser ver _Nane/ CN=EXCH1
or

Create a new mailbox and assign a unique alias to the mailbox. Then, when
configuring the mailbox for the NetBackup Client service account, enter only the alias.
(See “Configuring NetBackup to Use the Mailbox Associated with the NetBackup
Client Service Account” on page 22.)

2. On the General tab in the Properties dialog box for the new mailbox:
a. Click Primary Windows NT Account.
b. Select the NetBackup Client service account.
c. Click Add.
d. Click OK.

3. Select either a site container or recipient container that contains the mailboxes you
want to back up.

a. Click the property button to display the Properties dialog box.
b. Click the Permissions tab.

c. Select the NetBackup Client service account, add it to Windows NT accounts with
Permissions, select the Admin Role, and click OK.

Note The minimum rights required for backing up and restoring a mailbox are Modify
User Attributes and Modify Administrator Attributes. By default, the Admin role
includes Add Child, Modify User Attributes, Modify Administrator Attributes, and

R R ———
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v

Delete and Logon rights. The Admin role can be edited as a Custom role with only
the minimum rights.

If you elect to grant permissions individually to each mailbox rather than to grant
access to all mailboxes at the site or recipient container level, you can assign the
User role, which allows backing up and restoring mailboxes to which permissions
have been given. This role can also be edited to include only the Modify User
Attributes and the Modify Administrator Attributes.

Exchange 2000

To create a mailbox for the NetBackup Client service account

1.

Using Active Directory Users and Computers, create a mailbox with a unique name.

A unigque name is one that does not already exist within the Exchange Organization.
This name cannot be contained as a set of characters in an existing name.

For example, if EXCH1 has been entered as the unique mailbox name, and there are
other mailbox names such as EXCH1BACKUP or BACKUPEXCH1, backup or restore
of individual mailboxes or both will fail.

Make this account a member of Domain Admins group.

Using the Exchange Administration Delegation Wizard, select the NetBackup Client
service account and grant the Exchange Administrator access to the account.

a. Start the Exchange System Manager program.
b. Select the appropriate Administrative Group.

c. Right-click on the Administrative Group and select Delegate Control.

In the first dialog box, click Next.
In the second dialog box, click Add.

In the Delegate Control dialog box, click on the Browse button to select the
NetBackup Client service account created in step 1.

d. From the Role list, select Exchange Full Administrator.

e. Click OK.
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f. Click Next.
g. Click Finish.

7. For Active/Active configuration only Using the Exchange System Manager, for each
virtual server in the cluster, grant the NetBackup Client service account “Receive As”
and “Send As” advanced permission by performing the following steps:

a. Select the Virtual Exchange Server name.

b. Right-click on the virtual name and select Properties.

QUACK1 Propetties EHE
Policies | Security %I Monitaring I Full-Text Indexing I
General | Locales I Diagnostics Logging I Dretailz

a QUACKT

Wergion 6.0 [Build 4417.5)

" Enable subject lngging and display
™ Enable message tracking

Log file maintenance

V¥ Remove log files

Femaove files older than [days]: I?

™ This iz a front-end server

Clients connect here, and commands are relayed to a back-end server.

Domain controller uzed by services on this server:

Ifaith.min.veritas.com

QK I Cancel Apply Help
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c. Click on the Security tab.

QUACK1 Propetties EHE
General | Locales | Diagnostics Logging I Dretailz I
Policies Security | Monitaring I Full-Text Indexing
Mame [~ Add. |

!ﬁ Exchange Domain Servers [MIN-ADSAExchan... =
ﬂ javdster [japdsterE@min, veritas. com) ﬂl

ﬁ meenster [meenster{@min. veritas. com)
ﬂ Metbackup [netbackup{@min. veritas. com)

€ kevin L. Haltz (kih@rmin, veritas.com) J

Permizzions: Allow Deny
Fiead metabase properties O ;I
Adminizter information store O
Create named properties in the information store O
Wiew information store status O
Receive Az %

Send Az -
Advanced.. |

= All_ow inheritable permizzions from parent to propagate to this
o

biect
QK I Cancel | Apply | Help |

d. Select the NetBackup Client service account under the Name pane.

e. Under Permissions, select Receive As and Send As.

f. Click OK.

g. Repeat the above steps for each Virtual Exchange Server in the cluster.

Configuring NetBackup to Use the Mailbox Associated with
the NetBackup Client Service Account

This configuration can be performed with the NetBackup Adminstration Console for
Windows or for UNIX or through the Remote Administration Console.

v To configure the mailbox for the NetBackup Client service account
1. Open the NetBackup Adminstration Console or the Remote Administration Console.
2. Inthe left pane, expand Host Properties.

3. Click Clients.
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4. Inthe right pane, right-click on the client you wish to configure and choose
Properties.

5. Click on the Exchange tab.
6. Inthe Mailbox for message level backup and restore box, specify the mailbox. The
mailbox may be specified as:
- An Exchange mailbox name
- Afully-qualified name:
- /0=0rg_Name/OU=Site_Name/CN=Server_Name/CN=Mailbox_Name

- A mailbox alias

ent Properties

El, PC Cliert Settings I lg\p\p"mdmp\tsEllent I JNetwnrk | °:¢ OoTM I @ Timeovts

E Client Name I General Client I % Lagging | Q Firgwall
General I @ Univerzal Settings I % Servers I Bﬂ Media Servers | @1 Exclude I % Include
0:6 WSP | é Encryption I m Lotus Motes @ Exchange & GO

Mailbax for message level backup and restore
F’EHITAS Webmaster

r {Enable single instance backup for message attachments
{{for mailbox backups only] H

7. Click OK.

Chapter 3, Configuration 23 —d



Configuration Using the NetBackup Administration Console

Configuration Using the NetBackup Administration
Console

Although the database agent is installed on the NetBackup client, some configuration
procedures are performed using the NetBackup Administration Console on the server.

These procedures include:
O Configuring a NetBackup policy
O Testing NetBackup for Microsoft Exchange Server configuration settings

See the next section for instructions on starting the NetBackup Administration Console.

Starting the NetBackup Administration Console for Windows

This section contains information on launching the Windows server version of the
NetBackup Administration Console.

v To launch the NetBackup Administration Console for Windows
1. Logon to the server as administrator.

2. Choose Start > Programs > VERITAS NetBackup > NetBackup Administration
Console.
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The NetBackup Administration Console appears.

ik NetBackup Administration Console

File Action Edt View Help -

=N # B
e VERITAS
-y . . T
Activity Monitor NetB Eleup Datacente r
Bl MetBackup Management
¥ Reparts mal Getting Started
+ @ Palicies Get step-by-step help setting up MetBackup.
+-ZH Storage Units
Catalog . Configure Storage Devices
+ Host P.[DD.EIEIES Define robots and drives.
S Authorization

=2} Media and Device Manageme
@ Device Monitar
+- B Media
+ Devices

Configure Yolumes
Inventary robots and define volumes for uze in standalone drives.

Configure the Catalog Backup
Specify how and when MetBackup configuration and catalog information is to be backed up.

Create a Backup Policy
Define schedules for backing up data on a single client or a et of clients.

Import Wizard.
Thiz wizard will assizt you in stepping through an import.

=l o W alEy

Configure a Shared Drive
: Configure MetBackup to use a new shared drive or reconfigure an existing shared drive.

_l.-., ‘l. |

| 3

]

<

For Help. press F1 Master Server: gyifalcon Connected

Starting the NetBackup Administration Console for UNIX

This section contains information on launching the UNIX version of the NetBackup
Administration Console.

v To launch the NetBackup Administration Console for UNIX
1. Logonto the UNIX server as root.

2. Start the NetBackup Administration Console by executing:
i nstal | _pat h/ net backup/ bin/jnbSA &
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The Login dialog is displayed.

Host name

Vou may administer NetBaskup on any NetBackup host. To lagin, enter the
usemame and password for the specified NetBackup host

hagar

User

[

Passuard

Help

3. Type the name of the master server where you initially want to manage NetBackup.
You can specify any NetBackup master server. Indicate the User and Password.

4. Click Login. The NetBackup Administration Console appears.

NetBackup Administ

le [l d into hagar.min.

VERITAS NetBackup: Batacenter -

File BT ew SeTons  Help

= o= = [ |m

Backup, frchive, and Restore
Jetivity Monitor

- Mt Backup hianagament
E] Repens

| Policies

Fk5g Host Properties

= Media and Dewice hianagement
%@ Devise hionitor
_-'|-_|- hiedia
il- Devices

il-@ “ault hanagement

Getting Started
- Get step-by-step help setting up MetBackup from start to finish.
Lo

M| —5 Corfigure Storage Devices
E:"' Define robots and drives.

T Configure Volurmes
_ 2D)]j Inventory robots and define volumes for use in standalone drives.
|
E
4
F

T Corfigure the Catalog Backup
i* Specify how and when MetBackup configuration and cataleg information is to be
- backed up.

-

Create = Backup Palicy
Define schedules for backing up data on a single dlient or a sat of clients.
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Configuring a NetBackup Policy

A NetBackup policy defines the backup criteria for a specific group of one or more clients.
These criteria include:

O storage unit and media to use

O backup schedules

O items (database objects) to be backed up
O clients to be backed up

To use NetBackup for Microsoft Exchange Server, at least one MS-Exchange-Server policy
with the appropriate schedules needs to be defined. A configuration can have a single
policy that includes all clients or there can be many policies, some of which include only
one client.

Most requirements for MS-Exchange-Server policies are the same as for file system
backups. In addition to the attributes described here, there are other attributes for a policy
to consider. Refer to the NetBackup System Administrator’s Guide for detailed configuration
instructions and information on all the attributes available.

NetBackup Administration Console for Windows

Use this procedure when configuring a policy from a Windows server or from a
NetBackup Remote Administration Console host.

v To add a new policy
1. Logon to the server as administrator.
2. Start the NetBackup Administration Console.

3. If your site has more than one master server, choose the one where you want to add
the policy.
4. Inthe left pane, right-click Policies and choose New Policy.

The Add a New Policy dialog is displayed.

Add a New Policy E

Folicy name:

™ Use Backup Policy Configuration ‘wizard.

Cancel
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a. Inthe Policy name box, type a unique name for the new policy.

b. Choose whether to use the wizard for configuring the policy. The wizard guides
you through most of the setup process and simplifies it by automatically choosing
default values that are good for most configurations. If necessary, you can change
the defaults later by editing the policy. You will need to manually add entries to
the Files list after completing the wizard.

- To use the wizard, select the Use Backup Policy Configuration Wizard box
and click OK. The wizard starts and you create the policy by following the
prompts. When prompted, select the MS-Exchange-Server policy type.

- If you require more control over the settings than the wizard provides, then
do not select the Use Backup Policy Configuration Wizard box and proceed
to step 5.
5. Click OK.

A dialog is displayed in which you can specify the general attributes for the policy.

attibutes | & Schedules | By Cients | ) Fies |
Palicy type: ¥ Active. Gointo effect at
[ eoooopm =J12/311983 =]
[fthost back thiod:
e ™| Al frozen image: clients
ILocaI Huost j
. ™ Backup Netwark Drives
Destination
Paolicy storage unit: ™ Cross mount points
I Any Available j ™ Collect true image restore information
Palicy wolume pool: I with move detection
MetBackup -
I J " Compression
[ Limit jobs per policy: I~ EncEncry
I =l ™| Idividual file: restore from rav
Juob priority: ) . .
0 —1 [higher nurber iz ™ Collect disaster recovery information
=1 greater priority)
Keyward phrase: [optional] | Black level incremental
I [~ Allow multiple data streams

QK I Cancel | Help |

6. From the Policy Type box, select the MS-Exchange-Server policy type.

7. Complete the entries on the Attributes tab as explained in “Description of
Attributes.”

8. Add other policy information:
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- To add schedules, see “Adding New Schedules.”

- To add Exchange objects to the File list, see “Specifying the Exchange Objects to
Back Up.”

- To add clients, see “Adding Clients to a Policy.”

9. Click OK. The new policy will be created.

Description of Attributes

With a few exceptions, NetBackup manages a database backup like a file system backup.
Policy attributes that are different for MS Exchange backups are explained below.

Your other policy attributes will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for detailed
explanations of the policy attributes.

Description of Policy Attributes

Attribute Description

Policy type Determines the type of clients that can be in the policy and in some cases
the types of backups that can be performed on those clients.
To use NetBackup for Microsoft Exchange Server, you must have defined at
least one MS-Exchange-Server policy.

Keyword phrase A textual description of a backup. Useful for browsing backups and
restores.
Encryption Protects sensitive data by encoding it during the backup process. The data

is decoded during the restore process. See the NetBackup Encryption System
Administrator’s Guide for details.

Allow multiple data Specifies that, depending on directives in the file list, NetBackup can divide

streams automatic backups for each client into multiple jobs, with each job backing
up only a part of the file list. The jobs are in separate data streams and can
occur concurrently. The number of available storage units, multiplex
settings, and the maximum jobs parameters determines the total number of
streams and how many can run concurrently.

Adding New Schedules

Each policy has its own set of schedules. These schedules control initiation of automatic
backups and also specify when user operations can be initiated.
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Note It is recommended that you develop a backup policy schedule that includes both
full and differential-incremental backups. Including both backup types will reduce
backup time, since differential-incremental backups back up only the transaction
logs. Also, this will help to avoid low disk capacity caused by the creation of too
many transaction logs.

v To add a schedule

1. Inthe left pane, right-click on the name of the policy and select New Schedule.

A dialog is displayed. The title bar shows the name of the policy to which you are
adding the schedules.

Add New Schedule - Policy sample 2=l

By Attibutes |% Start W'indowl @& Exclude Datesl

r— Destination:

Mame:
I I~ | Multiple: copies Canfigure... |

™ Ovenide policy storage unit:
Tvpe of backup: I

I Full Backup j

™ Ovenide policy volurme pool:

Schedule type: I _
 LCalendar

™| Retries allawed|after mnday Retention:
‘ ?equenc}l:w m Media multiplexing

vess = o

QK I Cancel Help

2. Specify a unique name for the schedule.

3. Select the Type of backup.

For information on the types of backups available for this policy, see “Types of
Backups” on page 31.

4. Specify the other properties for the schedule as explained in “Schedule Properties.”

5. Click OK.
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Types of Backups

Description of Types of Backups

Type of Backup

Description

Full Backup

Differential-
incremental backup

User Backup

For server backups, this schedule type will back up the Microsoft Exchange
Server database and associated transaction logs. All committed transaction
logs will be truncated (deleted) after they are successfully backed up.

For mailbox backups, this schedule type will back up the entire mailbox,
including all the folders and messages in that mailbox.

For the Public Store, this schedule type will backup the entire Public Store,
including all the folders and messages within the Public Store.

A differential-incremental backup will only back up changes since the last
full or differential-incremental backup. Differential-incremental backups can
be performed of databases, the KMS and SRS services, mailboxes and of the
Public Share.

When using this method to back up a database, only transaction logs are
backed up. After the successful backup of the transaction logs, all
committed logs will be truncated (deleted). The truncation of the transaction
logs sets the context for the next backup.

To perform a full restore the data needed is contained in multiple
NetBackup images. One image for the full backup and another image for
each differential-incremental that was performed.

A user backup is not automatically scheduled and is initiated on the target
client machine.

A user-directed backup of a database is identical to a full backup except that
the transaction logs are not truncated. Because of this, user backups are like
taking a snapshot of the databases at a given point in time without
impacting the content of ongoing full and incremental backups.

You may want to consider creating a separate policy for User Backup
schedule types. This will allow you to easily separate user-directed and
scheduled backups when restoring files. If you decide to create separate
policies for User Backup schedule types, the considerations are similar to
those for automatic backups. A Files list is not needed because users select
the files before starting the operation.
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Description of Types of Backups (continued)

Type of Backup

Description

Cumulative-increme
ntal backup

A cumulative-incremental backup backs up all changes since the last full
backup or differential-incremental backup (However, it is not standard
practice to mix cumulative- and differential-incremental backups between
full backups). Cumulative-incremental backups can be performed of
databases, the KMS and SRS services, mailboxes and of the Public Share.

When using this method to back up databases, only transaction logs are
backed up and they are not truncated upon completion of the backup.

When performing a full restore the data is contained in two NetBackup
images. When restoring databases, transaction logs remain intact since the
last full backup.

In a Microsoft Exchange Server data recovery scenario where it has been
determined that the transaction logs are all intact, you only need to restore
the database from the last full backup. During recovery, Microsoft Exchange
Server will replay all the load in the log folder. This will bring the Microsoft
Exchange Server database back to the current date instead of to the time of
the last full or incremental backup.

Caution Differential-incremental and cumulative-incremental backup types will fail if
Database Circular Logging is configured for the Microsoft Exchange Server. By
disabling Circular Logging, incremental backups may then be performed. See
your Exchange Server Administration Guide for more information on configuring
Circular Logging.

Note You are allowed to configure incremental schedule types, but incremental backups
will not be performed for individual databases within storage groups. The backup
job will still run according to the configured incremental schedules, but the job will
log warnings for attempted incremental backups of these objects.

Schedule Properties

Some of the schedule properties have a different meaning for database backups than for a
regular file system backup. These properties are explained below.
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Other schedule properties will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for detailed
explanations of the schedule properties.

Description of Schedule Properties

Property Description

Type of backup Specifies the type of backup that this schedule will control. The selection list
shows only the backup types that apply to the policy you are configuring.

For more information see “Types of Backups.”

Frequency This setting is used only for scheduled backups, and not for user-directed
backups. Frequency specifies the period of time that will elapse until the
next backup operation can begin on this schedule. For example, if the
frequency is seven days and a successful backup occurs on Wednesday, the
next full backup will not occur until the following Wednesday. Normally,
incremental backups will have a shorter frequency than full backups.

Calendar This setting is used only for scheduled backups, and not for user-directed
backups. The Calendar option allows you to schedule backup operations
based on specific dates, recurring week days, or recurring days of the
month.

Retention Specifies a retention period for keeping backup copies of files before
deleting them. The retention level also denotes a schedules priority within
the policy, with Level 9 schedules having the highest priority and Level 0 the
lowest.

Specifying the Exchange Objects to Back Up

The Files list defines the Exchange objects (databases, mailboxes, and mailbox folders) to
be backed up and the grouping of Exchange objects for multiple data streams. When
specifying Exchange objects and multiple data streams, the Files list is entered in the same
manner as for regular file system backups.

Note Directives from different directives sets should not be added to the same policy. For
example, M crosoft Exchange Server:\Information Store\,an
Exchange 5.5 directive, and M cr osoft I nformation Store:\First
St orage Group\, an Exchange 2000 directive, should not be added to the same
policy. Nor should M crosoft Exchange Mai | boxes: \*, a mailbox directive,
and M crosoft Information Store:\,anExchange 2000 directive, be added
to the same policy.
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Enabling Multiple Data Streams

When Allow multiple data streams is enabled (on the Attributes tab for a specific policy),
automatic backups are divided into multiple jobs, with each job backing up only a part of
the Files list. Exchange mailboxes or storage groups defined in the Files list with wildcard
characters will be backed up in multiple streams.

You can choose to have NetBackup automatically determine where to begin new streams,
or you can control where each stream begins by inserting the NEW_STREAM directive at
a certain point or points in the Files list. For example, if you enable multiple datastreams
and specify the following in the Files list, NetBackup will create a new stream for each
mailbox.

M crosoft Exchange Mail boxes:\[a-ni*
M crosoft Exchange Mail boxes:\[n-2z]*

If instead you specify the following in the Files list, NetBackup will create only two
streams, one for mailboxes “a-m” and one for mailboxes “n-z”.

NEW _STREAM
M crosoft Exchange Mil boxes:\[a-nj*
NEW _STREAM
M crosoft Exchange Mail boxes:\[n-2z]*

For more information on the multiple data streams feature, refer to the NetBackup System
Administrator’s Guide for Windows or NetBackup System Administrator’s Guide for UNIX.

Wildcards in Exchange Path Names

Wildcard characters can be used to define groups of mailboxes, storage groups, or Public
folders. This way multiple objects can be backed up without having to specify the objects
individually in the Files list. This will only be successful if multiple data streams have
been enabled. If this feature has not been enabled, the backup will fail.

The supported wildcard characters for MS-Exchange-Server policy Files lists are
described below.

Supported wildcard characters

Wildcard character Action

Asterisk (*) Use as a substitute for zero or more characters. To specify all objects that
start with an ‘a’ use “a*”.

Question Mark (?) Use as a substitute for a single character in a name. For example, “s?z”
would process all objects that had ‘s’ for a first character, any character for a
second character, and ‘z’ for a third character.
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Supported wildcard characters (continued)

Wildcard character Action

Left & Right Brackets Use to match any one character enclosed in square brackets. A minus (-)

(€

)} may be used to indicate a range of consecutive characters; for example, [0-9]

is equivalent to [0123456789].
Note The - loses this special meaning if it occurs last in the string.

Note The right square bracket (]) does not terminate such a string when it is
the first character within it; for example, [] a-f] matches either a right
square bracket (]) or one of the ASCII letters a through f inclusive.
Asterisk (*) and Question Mark (?) stand for themselves within such a
string of characters.

The following rules apply when using wildcard characters in the Files list.

O
O
O

Only one wildcard pattern per Files list entry is allowed.
Wildcard patterns will only be honored in the final segment of the path name.

Wildcard patterns in Exchange 2000 directives will only be honored in the Storage
Group segment of the path.

If a wildcard pattern is not honored it will be treated literally.

For an Exchange Mailbox path any segment of the path may contain wildcard
characters, including mailbox names, folders, or messages within the Mailbox
hierarchy, as long as the wildcard characters are the last characters in the segment.

For Exchange Public folders any segment of the path may contain wildcard
characters, including workspace names or workspace folders, as long as the wildcard
characters are the last characters in the segment.

Adding Exchange Mailbox Objects

This section describes how to back up mailbox objects by adding these objects to the Files
list of a policy.

v To add a mailbox or mailbox folder to the Files list

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy nhame
and click New File.
The Add a New File dialog box is displayed.
2. From the Directive set list, select MS_Exchange_Mailbox.
3. From the Folder, file, or directive box, select Microsoft Exchange Mailboxes:\.
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4. Click in the Folder, file, or directive box and, after the directive name, specify the
mailbox(es) or mailbox folder(s) to back up.

Add a New File - Policy gla-exchange EHE
Directive zet:
I M5_Exchange_Mailbox j Add Template |
Folder, file or directive:
IMicrosoft Exchange Mailboxes: WM ailbox 14 j Browse... |

Inzert I Add | Cloze | Help |

See the Table “Example mailbox entries in the Files list” for example entries.

- Foran individual mailbox or mailbox folder, append the name of the mailbox or
folder.

- For multiple mailboxes or folders, use the supported wildcard characters to
specify the names of the mailboxes or folders. Multiple data streams must be
enabled in order for backups to be successful.

For information on the supported wildcard characters, see “Wildcards in
Exchange Path Names” on page 34. For information on using multiple data
streams, see “Enabling Multiple Data Streams” on page 34.

5. Click Add.

6. Click Close.

Example mailbox entries in the Files list

To back up Example path

An individual Microsoft Exchange Mailboxes:\Mailbox 1\

mailbox

A mailbox folder Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\Inbox

Multiple mailboxes, NEW_STREAM
using two ) Microsoft Exchange Mailboxes:\[a-m]*
datastreams NEW_STREAM

Microsoft Exchange Mailboxes:\[n-z]*

Multiple mailboxes, Microsoft Exchange Mailboxes:\*
using one stream for
each mailbox’
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Example mailbox entries in the Files list (continued)

To back up Example path
Multiple folders NEW_STREAM
using two Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\[a-m]*
datastreams’
NEW_STREAM

Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\[n-z]*

*Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.

Adding the Microsoft Exchange Public Folders

This section describes how to back up the MS Exchange Public folders by adding the
appropriate directive to the Files list of a policy.

v To add the Microsoft Exchange Public folders to the Files list

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy name

and click New File.

The Add a New File dialog box is displayed.

2. From the Directive set list, select Microsoft_Exchange Public_Folders.

3. From the Folder, file, or directive box, select Microsoft Exchange Public Folders:\.

Add a New File - Policy gla-exchange
Directive zet:

I M5_Exchange_Public_Folders

Folder, file or directive:
ticrozaft Exchange Public Fr

Inzert I

j Add Template |
Browse... |

Cloze | Help |

4. To specify a specific folders or folders, click in the Pathname or directive box, and
append the name of the folder(s) as follows:

See the Table “Example Public folder entries in the Files list” for example entries.

- Foran individual folder, append the name of the folder.

- For multiple folders, use the supported wildcard characters to specify the names
of the folders. Multiple data streams must be enabled in order for backups to be

successful.
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For information on the supported wildcard characters, see “Wildcards in Exchange
Path Names” on page 51. For information on using multiple data streams, see
“Enabling Multiple Data Streams” on page 51

Example Public folder entries in the Files list

To back up Example path

An individual Folder Microsoft Exchange Public Folders:\Folderl\

A Public subfolder  Microsoft Exchange Public Folders:\Folder1\Subfolderli\

Multiple folders, NEW_STREAM
gsmg two . Microsoft Exchange Public Folders:\Folder1\
atastreams NEW_STREAM

Microsoft Exchange Mailboxes:\Folder2\

Multiple folders, Microsoft Exchange Public Folders:\*
using one stream for
each folder*

*Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.

5. Click Add.
6. Click Close.

Adding the Microsoft Information Store to the Files list

This section describes how to back up the Microsoft Information Store by adding it to the
Files list of a policy.

v To add the Microsoft Information Store to the Files list

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy name
and click New File.

The Add a New File dialog box is displayed.

2. From the Directive set list, select MS_Exchange_2000.
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From the Folder, file, or directive box, select Microsoft Information Store:\.

Add a New File - Policy gla-exchange EHE
Directive zet:
|MS_Exchangs_2000 =] AddTemplate |

Folder, file or directive:
Iic Informatio

j Browse... |

Inzert I Add | Cloze | Help |

Click Add.

Click Close.

Adding a Storage Group or database to the Files list

This section describes how to back up a Storage Group or Storage Group database by
adding these object to the Files list of a policy. See the Table “Example Storage Group
entries in the Files list” for example entries.

O

For an individual Storage Group or database, append the name of the Storage Group
or database.

For multiple Storage Groups or databases, use the supported wildcard characters to
specify the names. Multiple data streams must be enabled in order for backups to be
successful.

For information on the supported wildcard characters, see “Wildcards in Exchange
Path Names” on page 34. For information on using multiple data streams, see
“Enabling Multiple Data Streams” on page 34.

v To add a Storage Group or database to the Files list

1.

In the left pane of the NetBackup Administrative Console, right-click the policy name
and click New File.

The Add a New File dialog box is displayed.
From the Directive set list, select MS_Exchange_2000.

From the Folder, file, or directive list, select Microsoft Information Store:\.
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4. Click in the Folder, file, or directive box, and append the name of the Storage Group
or database.

Add a New File - Policy Exch-Mbox EHE
Directive zet:
|MS_Exchangs_2000 =] AddTemplate |

Folder, file or directive:

IMicrosoft Information Store:\First Storage Group j Browse... |

Inzert I Add | Cloze | Help |

Example Storage Group entries in the Files list

To back up Example path

An individual Microsoft Information Store:\First Storage Group\
Storage Group

A database withina Microsoft Information Store:\First Storage Group\Mailbox Store\
Storage Group

Multiple Storage NEW_STREAM
Groups, using two  \Mjcrosoft Information Store:\Storage Group[1-3]

datastreams NEW_STREAM
Microsoft Information Store:\Storage Group[4-6]
Multiple Storage Microsoft Information Store:\Storage Group*

Groups, using one
stream for each
Storage Group*

* Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.

5. Click Add.
6. Click Close.

Adding the Site Replication Service to the Files list

This section describes how to back up the Site Replication Service by adding it to the Files
list of a policy.
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v To add the Site Replication Service to the Files list

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy hame
and click New File.

The Add a New File dialog box is displayed.
2. From the Directive set list, select MS_Exchange_SRS.

3. From the Folder, file, or directive box, select Microsoft Site Replication Service:\.

Add a New File - Policy gla-exchange EHE
Directive zet:
|MS_Exchangs_SRS =] AddTemplate |

Folder, file or directive:

Microzoft Site Replication Service: | Browse... |

Inzert I Add | Cloze | Help |

4. Click Add.
5. Click Close.

Adding the Key Management Service

This section describes how to back up the Key Management Service by adding it to the
Files list of a policy.

v To add the Key Management Service to the Files list

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy hame
and click New File.

The Add a New File dialog box is displayed.

2. From the Directive set list, select MS_Exchange_KMS.
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3. From the Folder, file, or directive box, select Microsoft Key Management Service:\.
Add a New File - Policy gla-exchange HE
Directive zet:
j Add Template |
Browse... |
Inzert I Add | Cloze | Help |
4. Click Add.
5. Click Close.

Adding Exchange 5.x Objects

This section describes how to back up Exchange 5
Files list of a policy.

v To add Exchange 5.x objects to the Files list

X objects by adding these objects to the

1. Inthe left pane of the NetBackup Administrative Console, right-click the policy hame
and click New File.
The Add a New File dialog box is displayed.
2. From the Directive set list, select MS_Exchange_5.x.
3. From the Folder, file, or directive box, select the appropriate directive:
Add a New File - Policy gla-exchange HE
Directive zet:
I M5_Exchange B.x j Add Template |
Folder, file or directive:
5 Browse... |
Inzert I Add | Cloze | Help |

click Add.

To backup the Information Store, select M
Information Store\ and click Add.

To backup the Directory Store, select Microsoft Exchange Server:\Directory\ and

icrosoft Exchange Server:\
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- To backup the Exchange 5.x Server, add both the Microsoft Exchange
Server:\Directory\ and Microsoft Exchange Server:\Information Store\
directives.

4. Click Close.

Adding Clients to a Policy
The client list is the list of clients that will be backed up during an automatic backup. A
NetBackup client must be in at least one policy but can be in more than one.
v To add clients to a policy
1. In the left pane of the NetBackup Administration Console, right-click on the policy
name and click New Client.

The Add New Client dialog is displayed. The title bar shows the name of the policy to
which you are adding the clients.

Add Mew Client - Policy sample EHE
Client name:
| Browse...
Hardware and operating syzten:
[P windowsNT -
Add ok | Oose | Hem |

2. Inthe Client name text box, type the name of the client that you are adding.

For a clustered MS Exchange server, specify the virtual Exchange Server name to be
the client.

On the client the following should be installed:
- MS Exchange

- NetBackup client or server
3. Choose the hardware and operating system type.
4. Click Add.

5. To add another client, repeat step 2 through step 4. If this is the last client, click Close
to close the dialog.
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NetBackup Administration Console for UNIX

Use this procedure when configuring a policy from a UNIX server.

To add a new policy

1.

2.

Log onto the server as root.
Start the NetBackup Administration Console.

If your site has more than one master server, choose the one to which you want to add
the policy.

In the left pane, click on Policies. The right pane splits into an All Policies pane and a
details pane.

In the All Policies pane, right-click on the Master Server, and click New.
The Add a New Policy dialog is displayed.

Add a Mew cy —I

Paolicy name:

| Use add policy wizard.

Ok Cancel |

a. Inthe Policy name box, type a unique name for the new policy.

b. Choose whether to use the wizard for configuring the policy. The wizard guides
you through most of the setup process and simplifies it by automatically choosing
default values that are good for most configurations. If necessary, you can change
the defaults later by editing the policy. You will need to manually add entries to
the Files list after completing the wizard.

- To use the wizard, select the Use add policy wizard box and click OK. The
wizard starts and you create the policy by following the prompts. When
prompted, select the MS-Exchange-Server policy type.

- If you require more control over the settings than the wizard provides, do not
select the Use add policy wizard box and proceed to step 6.

6. Click OK.
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A dialog is displayed in which you can specify the general attributes for the policy.

|— fof

Aoy _available

T |
pase 5]

Met Backup

7. From the Policy type box, select the MS-Exchange-Server policy type.

8. Complete the entries on the Attributes tab as explained in “Description of Attributes”
and click Apply to save the attribute entries.

9. Add other policy information:
- To add schedules, see “Adding New Schedules.”

- To add Exchange objects to the File list, see “Specifying the Exchange Objects to
Back Up.”

- Toadd clients, see “Adding Clients to a Policy.”

10. Click OK. The new policy is created.
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Description of Attributes

With a few exceptions, NetBackup manages a database backup like a file system backup.
Policy attributes that are different for MS Exchange backups are explained below.

Your other policy attributes will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for detailed
explanations of the policy attributes.

Description of Policy Attributes

Attribute Description

Policy type Determines the type of clients that can be in the policy and in some cases
the types of backups that can be performed on those clients.
To use NetBackup for Microsoft Exchange Server, you must have defined at
least one MS-Exchange-Server policy.

Keyword phrase A textual description of a backup. Useful for browsing backups and
restores.

Encryption Protects sensitive data by encoding it during the backup process. The data
is decoded during the restore process. See the NetBackup Encryption System
Administrator’s Guide for details.

Allow multiple data Specifies that, depending on directives in the file list, NetBackup can divide

streams automatic backups for each client into multiple jobs, with each job backing
up only a part of the file list. The jobs are in separate data streams and can
occur concurrently. The number of available storage units, multiplex
settings, and the maximum jobs parameters determines the total number of
streams and how many can run concurrently.

Adding New Schedules

Each policy has its own set of schedules. These schedules control initiation of automatic
backups and also specify when user operations can be initiated.

v To add a schedule
1. Inthe left pane, click Policies.

2. Inthe All Policies pane, expand the policy you wish to configure. Right-click on
Schedules and choose New.

3. Specify a unique name for the schedule.
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A dialog is displayed. The title bar shows the name of the policy to which you are
adding the schedules.

TEETE NG

|||

4. Select the Type of backup.
For information on the types of backups available for this policy, see “Types of
Backups™ on page 48.

5. Specify the other properties for the schedule as explained in “Schedule Properties.”

6. If this is the last schedule, click OK. To add more schedules, click Add and repeat
step 3 through step 5. Click Close to cancel changes that you have not yet added and
close the dialog.
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Types of Backups

Description of Types of Backups

Type of Backup

Description

Full Backup

Differential-
incremental backup

User Backup

For server backups, this schedule type will back up the Microsoft Exchange
Server database and associated transaction logs. All committed transaction
logs will be truncated (deleted) after they are successfully backed up.

For mailbox backups, this schedule type will back up the entire mailbox,
including all the folders and messages in that mailbox.

For the Public Store, this schedule type will backup the entire Public Store,
including all the folders and messages within the Public Store.

A differential-incremental backup will only back up changes since the last
full or differential-incremental backup. Differential-incremental backups can
be performed of databases, the KMS and SRS services, mailboxes and of the
Public Share.

When using this method to back up a database, only transaction logs are
backed up. After the successful backup of the transaction logs, all
committed logs will be truncated (deleted). The truncation of the transaction
logs sets the context for the next backup.

To perform a full restore the data needed is contained in multiple
NetBackup images. One image for the full backup and another image for
each differential-incremental that was performed.

A user backup is not automatically scheduled and is initiated on the target
client machine.

A user-directed backup of a database is identical to a full backup except that
the transaction logs are not truncated. Because of this, user backups are like
taking a snapshot of the databases at a given point in time without
impacting the content of ongoing full and incremental backups.

You may want to consider creating a separate policy for User Backup
schedule types. This will allow you to easily separate user-directed and
scheduled backups when restoring files. If you decide to create separate
policies for User Backup schedule types, the considerations are similar to
those for automatic backups. A Files list is not needed because users select
the files before starting the operation.
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Description of Types of Backups (continued)

Type of Backup

Description

Cumulative-increme
ntal backup

A cumulative-incremental backup backs up all changes since the last full
backup or differential-incremental backup (However, it is not standard
practice to mix cumulative- and differential-incremental backups between
full backups). Cumulative-incremental backups can be performed of
databases, the KMS and SRS services, mailboxes and of the Public Share.

When using this method to back up databases, only transaction logs are
backed up and they are not truncated upon completion of the backup.

When performing a full restore the data is contained in two NetBackup
images. When restoring databases, transaction logs remain intact since the
last full backup.

In a Microsoft Exchange Server data recovery scenario where it has been
determined that the transaction logs are all intact, you only need to restore
the database from the last full backup. During recovery, Microsoft Exchange
Server will replay all the load in the log folder. This will bring the Microsoft
Exchange Server database back to the current date instead of to the time of
the last full or incremental backup.

Caution Differential-incremental and cumulative-incremental backup types will fail if
Database Circular Logging is configured for the Microsoft Exchange Server. By
disabling Circular Logging, incremental backups may then be performed. See
your Exchange Server Administration Guide for more information on configuring
Circular Logging.

Note You are allowed to configure incremental schedule types, but incremental backups
will not be performed for individual databases within storage groups. The backup
job will still run according to the configured incremental schedules, but the job will
log warnings for attempted incremental backups of these objects.

Schedule Properties

Some of the schedule properties have a different meaning for database backups than for a
regular file system backup. These properties are explained below.
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Other schedule properties will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for detailed
explanations of the schedule properties.

Description of Schedule Properties

Property

Description

Type of backup

Frequency

Calendar

Retention

Specifies the type of backup that this schedule will control. The selection list
shows only the backup types that apply to the policy you are configuring.

For more information see “Types of Backups.”

This setting is used only for scheduled backups, and not for user-directed
backups. Frequency specifies the period of time that will elapse until the
next backup operation can begin on this schedule. For example, if the
frequency is seven days and a successful backup occurs on Wednesday, the
next full backup will not occur until the following Wednesday. Normally,
incremental backups will have a shorter frequency than full backups.

This setting is used only for scheduled backups, and not for user-directed
backups. The Calendar option allows you to schedule backup operations
based on specific dates, recurring week days, or recurring days of the
month.

Specifies a retention period for keeping backup copies of files before
deleting them. The retention level also denotes a schedules priority within
the policy, with Level 9 schedules having the highest priority and Level 0 the
lowest.

Specifying the Exchange Objects to Back Up

The Files list defines the Exchange objects (databases, mailboxes, and mailbox folders) to
be backed up and the grouping of Exchange objects for multiple data streams. When
specifying Exchange objects and multiple data streams, the Files list is entered in the same
manner as for regular file system backups.

Note Directives from different directives sets should not be added to the same policy. For
example, M crosoft Exchange Server:\Information Store\,an
Exchange 5.5 directive, and M cr osoft I nformation Store:\First
St orage Group\, an Exchange 2000 directive should not be added to the same
policy. Nor should M crosoft Exchange Mai |l boxes: \*, a mailbox directive,
and M crosoft Information Store:\,anExchange 2000 directive, be added
to the same policy.
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Enabling Multiple Data Streams

When Allow multiple data streams is enabled (on the Attributes tab for a specific policy),
automatic backups are divided into multiple jobs, with each job backing up only a part of
the Files list. Exchange mailboxes or storage groups defined in the Files list with wildcard
characters will be backed up in multiple streams.

You can choose to have NetBackup automatically determine where to begin new streams,
or you can control where each stream begins by inserting the NEW_STREAM directive at
a certain point or points in the Files list. For example, if you enabled multiple datastreams
and specified the following in the Files list, NetBackup would create a new stream for
each mailbox.

M crosoft Exchange Mail boxes:\[a-nj*
M crosoft Exchange Mail boxes:\[n-2z]*

If instead you specified the following in the Files list, NetBackup would create only two
streams, one for mailboxes “a-m” and one for mailboxes “n-z”.

NEW _STREAM
M crosoft Exchange Mil boxes:\[a-nj*
NEW _STREAM
M crosoft Exchange Mail boxes:\[n-2z]*

For more information on the multiple data streams feature, refer to the NetBackup System
Administrator’s Guide for Windows or NetBackup System Administrator’s Guide for UNIX.

Wildcards in Exchange Path Names

Wildcard characters can be used to define groups of mailboxes, storage groups, or Public
folders. This way multiple objects can be backed up without having to specify the objects
individually in the Files list. This will only be successful if multiple data streams have
been enabled. If this feature has not been enabled, the backup will fail.

The supported wildcard characters for MS-Exchange-Server policy Files lists are *, ?, and [
]. The following rules apply when using wildcard characters in the Files list.

Supported wildcard characters

Wildcard character Action

Asterisk (*) Use as a substitute for zero or more characters. To specify all objects that
start with an ‘a’ use “a*”.

Question Mark (?) Use as a substitute for a single character in a name. For example, “s?z”
would process all objects that had ‘s’ for a first character, any character for a
second character, and ‘z’ for a third character.
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Supported wildcard characters (continued)

Wildcard character Action

Left & Right Brackets Use to match any one character enclosed in square brackets. A minus (-)
€---D may be used to indicate a range of consecutive characters; for example, [0-9]

is equivalent to [0123456789].
Note The - loses this special meaning if it occurs last in the string.

Note The right square bracket (]) does not terminate such a string when it is
the first character within it; for example, [] a-f] matches either a right
square bracket (]) or one of the ASCI|I letters a through f inclusive.
Asterisk (*) and Question Mark (?) stand for themselves within such a
string of characters.

Only one wildcard pattern per Files list entry is allowed.
Wildcard patterns will only be honored in the final segment of the path name.

Wildcard patterns in Exchange 2000 directives will only be honored in the Storage
Group segment of the path.

If a wildcard pattern is not honored it will be treated literally.

For an Exchange Mailbox path any segment of the path may contain wildcard
characters, including mailbox names, folders, or messages within the Mailbox
hierarchy, as long as the wildcard characters are the last characters in the segment.

For Exchange Public folders any segment of the path may contain wildcard
characters, including workspace names or workspace folders, as long as the wildcard
characters are the last characters in the segment.

Adding Exchange Mailbox Objects

This section describes how to back up mailbox objects by adding these objects to the Files
list of a policy.

To add a mailbox or mailbox folder to the Files list

1.

2.

In the left pane, click Policies.
In the center pane, expand the policy where you want to add the mailbox to backup.

Under the policy name, right-click Files and choose New.

The Add File dialog is displayed. The title bar shows the name of the policy to which
you are adding the mailbox.

From the Directive set list, select MS_Exchange_Mailbox.
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5. From the Directive set list, select Microsoft Exchange Mailboxes:\.

ﬂndd File - Policy exchange-sample2 ﬂ
‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add ta the file list.
Directive set:

IMS_Exchange_Mailbox | agg |

Fathname or directive:

IMicrosoﬂ Exchange Mailboxes\Mailbox 11 LI Add |

Li=t of pathnames and directives to add to file list:

ks | gancell Help |

6. Click in the Pathname or directive box and specify the mailbox(es) or mailbox
folder(s) to back up.

See the Table “Example mailbox entries in the Files list” for example entries.

- Foran individual mailbox or mailbox folder, append the name of the mailbox or
folder.

- For multiple mailboxes or folders, use the supported wildcard characters to
specify the names of the mailboxes or folders. Multiple data streams must be
enabled in order for backups to be successful.

For information on the supported wildcard characters, see “Wildcards in
Exchange Path Names” on page 51. For information on using multiple data
streams, see “Enabling Multiple Data Streams” on page 51.

Example mailbox entries in the Files list

To back up Example path

An individual Microsoft Exchange Mailboxes:\Mailbox 1\

mailbox

A mailbox folder Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\Inbox
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Example mailbox entries in the Files list (continued)

To back up Example path

Multiple mailboxes, NEW_STREAM
using two ) Microsoft Exchange Mailboxes:\[a-m]*
datastreams NEW_STREAM

Microsoft Exchange Mailboxes:\[n-z]*

Multiple mailboxes, Microsoft Exchange Mailboxes:\*
using one stream for
each mailbox

Multiple folders NEW_STREAM
gsmg two ) Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\[a-m]*
atastreams NEW_STREAM

Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\[n-z]*

*Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.
7. Click the Add button to the right of the Directive set box.
The new entry appears in the list.
8. If there are no more items to add, click OK.

Adding the Microsoft Exchange Public Folders

This section describes how to back up the MS Exchange Public folders by adding the
appropriate directive to the Files list of a policy.

To add the Microsoft Exchange Public folders to the Files list
1. Inthe left pane, click Policies.

2. Inthe center pane, expand the policy where you want to add the Public folders to
backup.

3. Under the policy name, right-click Files and choose New.

The Add File dialog is displayed. The title bar shows the name of the policy to which
you are adding the Public folders.

4. From the Directive set list, select Microsoft_Exchange_Public_Folders.
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5. From the Directive set list, select Microsoft Exchange Public Folder:\.

ﬂndd File - Policy exchange-sample2 ﬂ
‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add to the file list.

Directive set:

MS_Exchange_Public_Folders LI Add |

Fathname or directive:
Exchange Public Folders: LI Add |

Li=t of pathnames and directives to add to file list:
F

ak | gancell Help |

6. To specify a specific folders or folders, click in the Pathname or directive box, and
append the name of the folder(s) as follows:

See the Table “Example Public folder entries in the Files list” for example entries.
- Foran individual folder, append the name of the folder.

- For multiple folders, use the supported wildcard characters to specify the names
of the folders. Multiple data streams must be enabled in order for backups to be
successful.

For information on the supported wildcard characters, see “Wildcards in Exchange
Path Names” on page 51. For information on using multiple data streams, see
“Enabling Multiple Data Streams” on page 51

Example Public folder entries in the Files list

To back up Example path

An individual Folder Microsoft Exchange Public Folders:\Folder1\

A Public subfolder  Microsoft Exchange Public Folders:\Folder1\Subfolder1\

Multiple folders, NEW_STREAM
35”"9 two Microsoft Exchange Public Folders:\Folder1\
atastreams NEW_STREAM

Microsoft Exchange Mailboxes:\Folder2\
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Example Public folder entries in the Files list (continued)

To back up Example path

Multiple folders, Microsoft Exchange Public Folders:\*
using one stream for

each folder:

*Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.

7. Click the Add button to the right of the Pathname or directive box.

The new entry appears in the list.
8. If there are no more items to add, click OK.

Adding the Microsoft Information Store to the Files list

This section describes how to back up the Microsoft Information Store by adding it to the
Files list of a policy.

v To add the Microsoft Information Store to the Files list
1. Inthe left pane, click Policies.

2. Inthe center pane, expand the policy where you want to add the Exchange 2000
objects.

3. Under the policy name, right-click Files and choose New.
The Add File dialog is displayed.

4. From the Directive set list, select MS_Exchange_2000.
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5. From the Pathname or directive list, select Microsoft Information Store:\.

ﬂndd File - Policy exchange-sample2 ﬂ
‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add to the file list.

Directive set:

MS_Exchange_Public_Folders LI Add |

Fathname or directive:

Microsoft Exchange Public Folders:) LI Add |

Li=t of pathnames and directives to add to file list:
F

ak | gancell Help |

6. Click the Add button to the right of the Pathname or directive box.

The new entry appears in the list.

7. If there are no more items to add, click OK.

Adding a Storage Group or database to the Files list

This section describes how to back up a Storage Group or Storage Group database by
adding these object to the Files list of a policy. See the Table “Example Storage Group
entries in the Files list” for example entries.

O For an individual Storage Group or database, append the name of the Storage Group
or database.

O For multiple Storage Groups or databases, use the supported wildcard characters to
specify the names. Multiple data streams must be enabled in order for backups to be
successful.

For information on the supported wildcard characters, see “Wildcards in Exchange
Path Names” on page 51. For information on using multiple data streams, see
“Enabling Multiple Data Streams” on page 51.
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v To add a Storage Group or database to the Files list

1. Inthe left pane, click Policies.

2. Inthe center pane, expand the policy where you want to add the Exchange 2000

objects.

3. Under the policy name, right-click Files and choose New.

The Add File dialog is displayed.

4. From the Directive set list, select MS_Exchange_2000.

5. From the Pathname or directive list, select Microsoft Information Store:\.

6. Click in the Folder, file, or directive box, and append the name of the Storage Group

or database.

Add a New File - Policy Exch-Mbox
Directive zet:

|MS_Exchangs_2000

Folder, file or directive:

j Add Template |

IMicrosoft Information Store:\First Storage Group

Inzert I Add

j Browse... |

Cloze | Help |

Example Storage Group entries in the Files list

To back up

Example path

An individual
Storage Group

Microsoft Information Store:\First Storage Group\

A database withina Microsoft Information Store:\First Storage Group\Mailbox Store\

Storage Group

Multiple Storage NEW_STREAM
S"OUDS’ usingtwo  Mijcrosoft Information Store:\Storage Group[1-3]
atastreams NEW_STREAM

Microsoft Information Store:\Storage Group[4-6]
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Example Storage Group entries in the Files list (continued)

To back up Example path

Multiple Storage Microsoft Information Store:\Storage Group*
Groups, using one

stream for each

Storage Group*

* Allow multiple data streams must be enabled in order for this Files list to be backed up successfully.

7. Click the Add button to the right of the Pathname or directive box.

The new entry appears in the list.
8. If there are no more items to add, click OK.

Adding the Site Replication Service to the Files list

This section describes how to back up the Site Replication Service by adding it to the Files
list of a policy.

v To add the Site Replication Service to the Files list
1. Inthe left pane, click Policies.

2. Inthe center pane, expand the policy where you want to add the Exchange 2000
objects.

3. Under the policy name, right-click Files and choose New.

The Add File dialog is displayed.

4. From the Directive set list, select MS_Exchange_SRS.
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5. From the Pathname or directive list, select Microsoft Site Replication Service:\.

ﬂndd File - Policy exchange-sample2 ﬂ
‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add to the file list.

Directive set:

WS _Exchange_SRS LI ﬂl

Fathname or directive:
Microsoft Site Replication £ LI Add |

Li=t of pathnames and directives to add to file list:
F

ak | gancell Help |

6. Click the Add button to the right of the Pathname or directive box.

The new entry appears in the list.
7. If there are no more items to add, click OK.

Adding the Key Management Service

This section describes how to back up the Key Management Service by adding it to the
Files list of a policy.

v To add the Key Management Service to the Files list
1. Inthe left pane, click Policies.

2. Inthe center pane, expand the policy where you want to add the Exchange 2000
objects.

3. Under the policy name, right-click Files and choose New.
The Add File dialog is displayed.

4. From the Directive set list, select MS_Exchange KMS.
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5. From the Folder, file, or directive box, select Microsoft Key Management Service:\.

ﬂndd File - Policy exchange-sample2 ﬂ

‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add to the file list.

Directive set:

WS _Exchange_kKhs LI ﬂl

Fathname or directive:
nagement Service:| LI Add |

Li=t of pathnames and directives to add to file list:
F

ak | gancell Help |

6. Click the Add button to the right of the Pathname or directive box.

The new entry appears in the list.
7. If there are no more items to add, click OK.

Adding Exchange 5.x Objects

This section describes how to back up Exchange 5.x objects by adding these objects to the
Files list of a policy.

v To add Exchange 5.x objects to the Files List
1. Inthe left pane, click Policies.
2. Inthe center pane, expand the policy where you want to add the Exchange 5.x objects.

3. Under the policy name, right-click Files and choose New.

The Add File dialog is displayed. The title bar shows the name of the policy to which
you are adding the Exchange 5.x objects.
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4. From the Directive set list, select MS_Exchange_5.x.

ﬂndd File - Policy exchange-sample2 ﬂ
‘ 5} server:

hagar ‘

Construct a list of pathnames {and directives, if applicable) to add to the file list.

Directive set:

WS _Exchange_&x LI ﬂl

Fathname or directive:

= [

Li=t of pathnames and directives to add to file list:

ak | gancell Help |

5. From the Pathname or directive box, select the appropriate directive:

- To backup the Directory Store, select Microsoft Exchange Server:\Directory\ and
click Add.

- To backup the Information Store, select Microsoft Exchange Server:\
Information Store\ and click Add.

- To backup the Exchange 5.x Server, add both Microsoft Exchange
Server:\Directory\ and Microsoft Exchange Server:\Information Store\
directives.

6. If there are no more items to add, click OK.

Adding Clients to a Policy

The client list is the list of clients that will be backed up during an automatic backup. A
NetBackup client must be in at least one policy but can be in more than one.

v To add clients to a policy
1. Inthe left pane, expand Policies.
2. Inthe All Policies pane, expand the policy you wish to configure.

3. Right-click on Clients and choose New.
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The Add Client dialog is displayed. The title bar shows the name of the policy where
you are adding clients.

Senver: Ihagar.min.o\r.com

#dd |
Client name:

ak |
I |

Close |
Hardware and operating system:
IMACINTDSH.MacDS vl Help |

4. Inthe Client name text box, type the name of the client that you are adding.

For a clustered MS Exchange server, specify the virtual Exchange Server name to be
the client.

On the client the following should be installed:
- MS Exchange

- NetBackup client or server
5. Choose the Hardware and Operating System type and click Add.

6. Ifthisisthe lastclient, click OK. If you are going to add more clients, repeat step 4 and
step 5.
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Testing NetBackup for Microsoft Exchange Server
Configuration Settings

After you have configured the master server for NetBackup for Microsoft Exchange
Server, you should test the configuration settings. For a description of status codes, refer
to the NetBackup Troubleshooting Guide for UNIX and Windows.

NetBackup Administration Console for Windows

Use this procedure to test a policy configuration from a Windows server or from the
Remote Administration Console.

v To test the configuration settings on a Windows server

1.

2.

Log onto the server as administrator.

Start the NetBackup Administration Console.

In the left pane, click Policies. The policy list appears in the right pane.
Click on the policy you wish to test.

Choose Actions > Manual Backup.
The Manual Backup dialog is displayed.

The Schedules pane contains the name of a schedule (or schedules) configured for the
policy you are going to test. The Clients pane contains the name of the client(s) listed
in the policy you are going to test.

Follow the instructions on the dialog.
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7. Click Activity Monitor on the NetBackup Administration Console.

File Edit “iew Actions Help l-
EHEEIEE I
B80S P 0% B o)
awifalcon awifalcon - Topology =
- Bl Activity Monitar =] =1
=) MetBackup Management
Reports
=3 Folicies ‘i%
@ Summany of all Polic —
L@ Sybase Backup
g sample -
: Farcan

- sybasestandard
@ sybasewindows

L rest2 =
-G testDB2 ol |,|—I
O

== Storage Units

" 5 Storage Urit Group | |@¥tfalcon: 1 Jobs (0 Queued O Active O Requeusd 1 Done]
g Catalog Job 1D [ Type [State [ Staws[Po. [Sc.[Ch. [Me. [St. [El. [En [aw. [0Op
b3l Host Properties b 4 4 Backup  Done syba.. backe gyifah gyrfalc 10/.. D003 10/ 1
-85 Media and Device Manage
{530 Device Monitor

B Media o | v
Devices —

gal | m Jobs | Services | Processes |  Drives |

For Help. press F1 [Master Server: grfalcon [Connected 2

If the manual backup does not exit with a successful status, refer to the
Troubleshooting chapter.

NetBackup Administration Console for UNIX

Use this procedure to test a policy configuration on the NetBackup Administration
Console for UNIX.

v To test the configuration settings on a UNIX server
1. Log onto the server as root.
2. Start the NetBackup Administration Console.

3. Inthe left pane, click Policies.

The right pane splits into an All Policies pane and a details pane.
4. Inthe All Policies pane, click the policy you wish to test.

5. Choose Actions > Manual Backup.
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The Manual Backup dialog is displayed.

Serwer. Ihagar min.ov com
Falicy name: oK I
Ipmme:

Cancsl

Schedules
Ful
Clents
hagar
Selent a sohedule and ane or more olients to start the backup. To start a
baskup for all oients, press OK uithout seleating any olients

The Schedules pane contains the name of a schedule (or schedules) configured for the
policy you are going to test. The Clients pane contains the name of the client(s) listed
in the policy you are going to test.

6. Follow the instructions on the dialog.

7. Click Activity Monitor on the NetBackup Administration Console.

—

File Edit ‘ew Actions  Help

He o 0B E

2
B

Jobs ] Daemons ] Processes ]

=| hagar.min.ov.com (haster Server i
Backup, Archive, and Reston Job 1d I Type I State I Status I Palicy I Schedule I Client I hediaSne
E initor 45 Backup Done 0 test? User hagar .
= NetBackup hanagement 44 Backup Done 0 test? User hagar
5] Reponts 43 Restore Dione o hagar
D, Polcies 4% Back D 0 test? [ h
FLI storage Units ackup one e zer agar
= Catalog 41 Backup Done 0 test? Uzer hagar
1.:___._ Host Properties 40 Backup Done 71 test? Uzer hagar |
- Media and Device hEnageme 17 7 Mnnes AN |
@ Devwice honitar
] Media = [pone:? frocal:v [eezlServer:hagar. min. ov.com
=) Devi g
|| EHE veviees 7| [ [ [ [ [

If the manual backup does not exit with a successful status, refer to the
Troubleshooting chapter.
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After completing the configuration, you can use the Backup, Archive, and Restore
interface to back up MS Exchange databases, mailboxes or folders. This chapter contains
the following information:

“Performing User-Directed Backups of Exchange Server”
“Restoring Exchange Server”

“Individual Mailbox Operations”

“Backing Up and Restoring the Microsoft Exchange Public Folders”

g

g

g

0 “Performing Single Instance Store Backups”
g

0O “Specifying the Virtual Exchange Server”

g

“Redirecting a Restore to a Different Client”
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Performing User-Directed Backups of Exchange Server

Note To ensure consistent and accurate backups, always check database consistency

before backing up a database.

Exchange 5.x

This section describes how to perform a user-directed backup of Exchange 5.x objects.

To perform a user-directed backup of Exchange 5.x objects

1.

2.

Open the Backup, Archive, and Restore interface.

On the File menu, click Select Files and Folders to Backup.

The Backup window is displayed.

If you are in a cluster environment, specify the name of the Virtual Exchange Server as
described in “Specifying the Virtual Exchange Server” on page 103.

In the All Folders pane expand the Microsoft Exchange Server object.

ﬁBackup, Archive, and Restore - NetBackup - Backup: Server: snowbush Client: snowbush
E Elle Edit Wew Actions Window Help - |51 5[
Bl Select for Backup | B3, Select for Restors + | TEyview Status | & ‘
g All Folders Contents of Microsoft Exchange Server
Sl R T Name: [ attributes | Siee I Time Madifisd |
e |202c O Whoirectary ds-- 0 2000-05-03 $:54:46 PM
O=0o & trfarmation Store ds-- 0 2000-05-03 :54:46 PM
- @ registry
5 svstem_state
- {29 Microsoft Exchange Server
[0 53 Microsoft Exchange Mailhoxes
Ready A
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5. Select the Information Store or Directory objects to back up.

ﬁBackup, Archive, and Restore - NetBackup - Backup: Server: snowbush Client: snowbush

Eﬁwle Edit Yiew Actions Window Help == x|
Bl Select for Backup | B3, Select for Restors v| TEyview Status | & ‘

All Folders Contents of Microsoft Exchange Server

I Attributes | Size | Time Maodified I
ds-- 0 2000-05-03 4:15:59 PM
ds-- 0 2000-05-03 4:18:59 PM

LG
[
O
Y

-] @l Registry

- OB System_sState

+ Microsoft Exchange Server
9 Microsoft Exchange Mailboxes

]
O

Ready 4

6. On the Actions menu, click Start Backup of Marked Files.
The Specify Backup Options dialog box is displayed.

7. Click Start Backup.
A dialog box is displayed informing you that the backup was successfully initiated.
8. If you want to view the progress of the backup, click Yes. If you do not want to view

the progress of the backup, click No.

Exchange 2000

This section describes how to perform a user-directed backup of Exchange 2000 objects.
v To perform a user-directed backup of Exchange 2000 objects
1. Open the Backup, Archive, and Restore interface.

2. Onthe File menu, click Select Files and Folders to Backup.

The Backup window is displayed.

3. Ifyou are in a cluster environment, specify the name of the Virtual Exchange Server as
described in “Specifying the Virtual Exchange Server” on page 103.
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[

Browsing Exchange 2000 objects

ackup, Archive, and Restore - MetBackup - [Backup: Server: lantana Client: lantana]
5 File Edt View Action: Window Help

Bl Select for Backup | B3 Select for Restare -

2y View Status | &

All Folders

Contents of C:\

| W% | &

Bl J Metwark

Bl Registry
System_State
Microsoft Infarmation Store

a
O Microsoft Exchange Mailboxes
a

O

: icrozoft Key Management Service
Dg Microsoft Exchange Public Folders

Open a Mew Restore ‘Window

Mame

O (CaADOBEAPP

O CaBeENT

[ £ Config Msi

O CaDisk_STU

O[3 Documents and Settings
OQese

O (3 gertrude. 4264

O Iretpub

O CaMeBackup

[ 2 Program Files

coocooooooao

[ 4. Size] Time Modiied -
o452 d-r

0

il
il
il
il
il
il
il
il
il
il

10/8/2002 10:50:27 AW
5/22/2002 5:54:53 PM
GA8/2002 BOGAF PM —
10/18/2002 3:40:44 PM
10/4/2002 3:32:15 PM
FATA200210:01:48 &M
9/25/2002 2:11:55 PM
9/17/2002 12:33:58 PM
2/25/2002 3:08:47 PM
B/21/2002 1:52:14 PM
8/19/2002 2:45:17 PM LI

2

Browsing Exchange objects in a cluster environment

Backup, Archive, and Restore - NetBackup - Backup: Server: FAKE Client: dewey

W3 Fle Edt View Actions Window Help

B3l Select For Backup | B3, Select for Restore -

12 view Status | @

ackup: Server: FAKE Client: dewey
All Folders

C. of Mi

Store:\First Storage Group

Oy A
O=c
O=r0o
O=¢€

| & & |

D@ storageGroupz
5B Microsaft Exchange Mailboxes

Ready

Mame

|a... Size | Time Mo... |

[ 3 Mailbox: Store (QUACKL)
[ &) public Folder Store (QUACKL)

0 2/16/200..
0 2/16/200..

4

4,

In the All Folders pane, select the objects you wish to back up. The following objects

can be backed up.

- Storage groups. Expand the Microsoft Information Store node and select the
storage group to back up.
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- Individual databases. To back up an individual database within a specific storage
group, expand the Microsoft Information Store, then the storage group, and select
the database to back up.

- Key Management Services database. Select the KMS node to back up this
database.

- Site Replication Services database. Select the SRS node to back up this database.

s_Tﬁ Backup. Archive. and Restore - NetBackup - [Backup: Server: lantana Client: lantana] M= E3 I
E File Edit “iew Actions Window Help = |ﬁ'|1|
B Selact for Backup | 3 Select for Restare ~ | 2 Wiew Status | &
g All Folders C of Mi ft Inf tion Store
= |=-Oed & MName & [ 5] Time Modified |
& | m0sc WA First Storage Group d— 0 10/22/2002 1:36:18 PM
E-0=0 Ol StorageGroup2  d— 0 10/22/2002 1:365:18 PM
— D@ IE1 Dﬁjj StoragelGroup3 d- 0 10/22/2002 1:36:18 PM
=S O StorageGroupd  d- 0 10/22/2002 13618 PM

-] o Network

B[] g Registry

B[] Spstem_State

: Mic Information Store:
[Pl First Storage Group
[P StorageGroup?
[P StorageGroup3
[P StorageGroupd

[ £ Microscft Exchange Mailboxes

B Microsoft Key Management Service
-] £ Microsoft Exchange Public Folders

Ready i

5. On the Actions menu, click Start Backup of Marked Files.
The Specify Backup Options dialog box is displayed.

6. Click Start Backup.

A dialog box is displayed informing you that the backup was successfully initiated.

7. If you want to view the progress of the backup, click Yes. If you do not want to view
the progress of the backup, click No.
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Restoring Exchange Server

This section describes how to restore Exchange Server objects.

Before Performing Restores

0O When restoring individual databases or transaction logs, the administrator should

have a thorough working knowledge of Microsoft Exchange Server databases,
transaction logs, and utilities. If the correct files have not been restored, the Microsoft
Exchange Server will fail to start.

Do not restore both Microsoft Exchange Mailbox and Microsoft Exchange Server
objects at the same time. Either the restore of the mailbox objects will fail because the
Exchange services are down to perform a restore of Exchange server databases or, if
the restore of the Exchange mailbox items finish before the restore of the Exchange
databases starts, the mailbox objects restored will be overwritten by the restore of the
Exchange databases.

Restoring Exchange 5.x Server Objects

This section contains instructions for restoring Exchange 5.x Server objects.

Notes on Restoring Exchange 5.x Objects Backed Up With Backup Exec

O

“Copy” backups in Backup Exec appear as “Full” backups in NetBackup.
“Incremental” backups appear as “Differential” backups. “Differential” backups
appear as “Cumulative Incremental” backups.

To restore Exchange 5.x Server objects

1.

2.

Log on as Administrator.
Open the Backup, Archive, and Restore interface.

Select the type of restore to perform.

- To restore from NetBackup backup images, choose File > Select Files and Folders
to Restore > from Normal Backup.

- To restore from Backup Exec backup images, choose File > Select Files and
Folders to Restore > from Backup Exec Backup.

Note Do not choose the Restore type from Normal and Backup Exec backups. This may

leave the database in an inconsistent state and may lead to loss of data.
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The Restore windowv is displayed.

4. Choose File > Specify NetBackup Machines.
The Specify NetBackup Machines dialog box is displayed.

Specify HetBackup Machines E
Servers  Source Clients | Destination Clients I

Mew Client Mame:

Cliert List:

okra[CURRENT)
hawk.

I ake Eurrent |
V' Use this client list for future backup and restore windaws
Clazs Type:
IMS-Exchange-Server j
QK I Cancel | Help |

5. Click the Source Clients tab.
6. From the Policy Type list, select MS-Exchange-Server.

7. Click OK.
NetBackup browses for Microsoft Exchange Server backup images.

The NetBackup History pane displays Microsoft Exchange Server backup
information. The top split windows show individual image information and the
bottom split gives file and folder information and also allows the user to select what
files are to be restored.

8. From the NetBackup History pane, select the image containing the objects you wish to
restore.

9. Inthe All Folders pane, select the checkbox next to the machine name or Microsoft
Information Store. This will restore the entire content of the selected backup image.
You can also select individual databases that needs to be restored.

Note If you wish to restore the public or private databases from a Backup Exec backup
image, see “Restoring the Public and Private Databases Backed Up by Backup Exec”
on page 76.
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Note A full backup of an Exchange database includes the database patch file and the
database transaction log files. When restoring a database, you must, at a minimum,
also restore the database patch file and the transaction log files.

Selecting Exchange 5.x objects to restore

';_Téﬂackup, Archive, and Restore - NetBackup - Restore: Server: morgan3 Source Client: ishmael Destination Client: snowbush
E Fil= Edt Yiew Actions ‘Window Help

1) select For Backup | B3, Select for Restore v| {ezy view Status | &

i-LResture: Server: morgan3 Source Client: ishmael Destination Client: snowbush

MetBackup Hiztory

— | _Time Backed Up | Time Expires | Files | Size I Compressed | Schedule Type | Class Mame | Ke &
@ 7000-05-03 11:03:49 AM  2000-05-17 15 13359 V] Full Backup exchange_Cluster
@ z000-05-03 10:59:51 &M 2000-05-17 g 8216 M Full Backup exchange_Cluster

e & 2000-05-02 2:01:00PM  2000-05-16 14 8237 M Full Backup exchange_Cluster

& 2000-05-02 12:29:32 PM 2000-05-16 g 8216 M Full Backup exchange_Cluster

E= & 2000-05-02 1201559 PM  2000-05-16 14 8237 M Full Backup exchange_Cluster fo
&4 2000-05-02 12:12:03PM  2000-05-16 g 8216 ] Full Backup exchange_Cluster
&4 2000-05-02 11:50021 AM  2000-05-16 14 8237 ] Full Backup exchange_Cluster -
41 P . | R
All Folders Ci of "Mi ft Exch Server'
= i [Mame | Time Backed Up | Attributes | Size | Time Modified |

I:QDirectory 2000-05-03 10:59:...

[l EFrFormation Store 2000-05-03 11:03:...
=9 Information Store

4
10. On the Actions menu, click Start Restore of Marked Files.
——— _ . R
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The Restore Marked Files dialog box is displayed.

Restore Marked Files [ %]

Restore Marked Files

V¥ Delete existing transaction lags prior to restore

Exchange 2000
Temporary location for log and patch files:

V' Commit after restore completes

¥ Mourt database after restore

Start Hestorel Cancel | Help |

The Delete existing transaction logs prior to restore option allows the user to retain
or delete existing transaction logs. See “Existing Transaction Logs” on page 14 for
further information. Transaction logs will be deleted only for the Exchange database
being restored. If the user was only restoring the Information Store, the transaction
logs for the Information Store would be deleted and the Directory transaction logs
would remain intact.

Note A restore of Microsoft Exchange Server files will always overwrite existing files (if
pub. edb already exists on the target machine, it will be replaced with the copy
from the backup).

11. Click Start Restore.

12. After a successful restore, restart the Exchange 5.x services.

If not in an Exchange cluster, you can restart the services by rebooting the system or
manually restarting the services through the Control Panel or a batch file.

In an Exchange cluster, use the Control Panel to start the services from the node
owning the Exchange resources. Then, from the Cluster Administrator, bring the
Exchange resources online.
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Restoring the Public and Private Databases Backed Up by Backup
Exec

With Backup Exec, you can choose to “Restore the public folder” (restore the public
database) or “Restore private mailboxes” (restore the private database). These databases
can also be restored separately when using NetBackup.

The databases appear as folders within the M cr osoft Exchange
Server\ I nformation Store\Dat abase folder as shown in the figure below.

Backup Exec public and private mailboxes (or databases) as displayed in NetBackup

All Folders
E- 2 quacks
EDQ Microsoft Exchange Server
&[] () Directory

The following table specifes what you should select in order to restore the public
database, private database, or both;

Restoring public and private databases

To restore Select the following in the All Folders pane
Both the public and private database Information Store
or
Public
Public database Public
Private database Private
——— _ . _
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Restoring Exchange 2000 Server Objects

Notes on Restoring Exchange 2000 Objects Backed Up With Backup Exec

O

When restoring Backup Exec Exchange 2000 images, more than one “Storage Group”
should not be selected for restore in the same NetBackup restore job. If, for example,
you wish to restore “Storage Group 1” and “Storage Group 2,” launch two separate
NetBackup restore jobs, one corresponding to “Storage Group 1” and the other
corresponding to “Storage Group 2.”

The following Exchange 2000 objects, when backed up by Backup Exec, cannot be
restored using NetBackup:

- KMS database
- SRS database

“Copy” backups in Backup Exec appear as “Full” backups in NetBackup.
“Incremental” backups appear as “Differential” backups. “Differential” backups
appear as “Cumulative Incremental” backups.

Make sure the temporary location for log and patch files is empty before you start a
restore job. If a restore job fails, check the temporary location (including
subdirectories) to make sure any previous log and patch files from a previous restore
job were deleted.

v Torestore the Information Store, Storage Groups, or Storage Group databases

1.

2.

Log on as Administrator.
Dismount all Exchange 2000 databases that need to be restored.
Open the Backup, Archive, and Restore interface.

Select the type of restore to perform.

- To restore from NetBackup backup images, choose File > Select Files and Folders
to Restore > from Normal Backup.

- To restore from Backup Exec backup images, choose File > Select Files and
Folders to Restore > from Backup Exec Backup.

Note Do not choose the Restore type from Normal and Backup Exec backups. This may

leave the database in an inconsistent state and may lead to loss of data.

The Restore windowv is displayed.

5. From the File menu, select Specify NetBackup Machines.
———
Chapter 4, Operating Instructions A



Restoring Exchange Server

The Specify NetBackup Machines dialog box is displayed.

Specify HetBackup Machines E
Servers  Source Clients | Destination Clients I

Mew Client Mame:

Cliert List:
okra[CURRENT)
hawk.

I ake Eurrent |

V' Use this client list for future backup and restore windaws

Clazs Type:
IMS-Exchange-Server j
QK I Cancel | Help |

6. Click the Source Clients tab.
7. From the Policy Type list, select MS-Exchange-Server.

8. Click OK.
NetBackup browses for Microsoft Exchange Server backup images.

The NetBackup History pane displays Microsoft Exchange Server backup
information. The top split window shows individual image information and the
bottom split gives file and folder information and also allows the user to select what
files are to be restored.
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Browsing an Exchange 2000 backup image

&% Backup. Archive_. and Restore - NetBackup - [Restore: Server- lantana Source Client: lantana Destination__ !EE
Fle Edit Wiew Actions “Window Help - |& ﬂ

@SEIEct for Backup | B3, Select for Restore v| View Status | @ ‘

MetB ackup History

Time Backed Up | Time Expires | Filasl Size | Compressed | Schedule Type | Palicy Hame AI
€ 10/14/2002 1:08.26 PM  10/28/2002 20 1243442 N Full Backup ExchangeDB__
€ 10/10/2002 45714 PM  10/24/2002 106 264016 N User Backup MBOX-515
© 10/10/2002 216:41 PM  10/24/2002 43 126489 N Diff Inct Backup Pub =

: 6'1 4N M0 A0N7 24 4-FC Okd 4M724 M0N0 F1 4790400 Ml Col O ol e, (= ;lJ

4
All Folders C of "Mi ft Inf tion Store:\First Storage Group'
=18 lantana Mame |_Time Backed Up [a.] Size | Time Mc

=-C16® Microsoft Information Store || 7] &) Log fles_1034618306 10/14/2002 10826 PM - BZB3E1E  10/14/%
! [ (@ Maibox Store [LANTANA] 10/14/2002 1:08:26 PM  — 463487410 10/14/2
Ol Storagebroup2 O] & Public Folder Store [LAMTAMA) 10/14/2002 1:08:26 PM - 353386922 10/14/2
Dﬁﬁ StorageGroup3
Dﬁﬁ StorageGroupd
1 | |
Ready 4

9. From the NetBackup History pane, select the image containing the objects you wish to
restore.

10. In the All Folders pane, select the objects you wish to restore.

- The Microsoft Information Store. To restore the entire content of the selected
backup image, select the checkbox next to the machine name or Microsoft
Information Store.

- Storage groups. Expand the Microsoft Information Store node and select the
storage group to restore.

- Individual databases. To restore an individual database within a specific storage
group, expand the Microsoft Information Store, then the storage group, and select
the database.

Note A full backup of an Exchange database includes the database patch file and the
database transaction log files. When restoring a database, you must, at a minimum,
also restore the database patch file and the transaction log files.

11. On the Actions menu, click Start Restore of Marked Files.
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The Restore Marked Files dialog box is displayed.

Restore Marked Files [ %]

Restore Marked File

V¥ Delete existing transaction lags prior to restore

Exchange 2000
Temporary location for log and patch files:

V' Commit after restore completes

¥ Mourt database after restore

Start Restore I Cancel Help |
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12. Refer to the following table for information on the restore options available.

Microsoft Exchange tab options

Option

Description

The Delete Existing
Transaction Logs Prior
To Restore

Allows the user to retain or delete existing transaction logs. See
“Existing Transaction Logs” on page 14 for further information.
Transaction logs will be deleted only for the Exchange database being
restored. If the user was only restoring the Information Store, the
transaction logs for the Information Store would be deleted and the
Directory transaction logs would remain intact.

Exchange 2000, KMS, and SRS
Note The following do not apply when restoring Exchange 5.x objects, mailboxes, or public

folders.

Temporary
location for log
and patch files

Commit after
restore completes

Mount database
after restore

Enter a location where the associated log and patch files are to be
kept until the database is restored. The default locationisc: \ t enp. If
storage groups are being restored, a subdirectory inc: \ t enp is
created for each storage group. The log and patch files for each
storage group are kept in the corresponding subdirectory.

If Commit after restore completes is selected during restore, the log
and patch files in the temporary location are applied to the database,
and then the current log files are applied. After the restore is
complete, the log and patch files are automatically deleted from the
temporary location (including any subdirectories).

Note Make sure the temporary location for log and patch files is
empty before you start a restore job. If a restore job fails, check
the temporary location (including subdirectories) to make sure
any previous log and patch files from a previous restore job
were deleted.

Use this option if your selection contains the last backup set to be
restored. This enables the restore operation to play through log files
and roll back any uncompleted transactions. If this option is not
selected, the database is left in an intermediate state and is not yet
usable.

If Commit after restore completes is selected when an intermediate

backup is being applied, you cannot restore further backups. You will
need to restart the restore operation from the beginning.

Mounts the database so that it is available to users. This option is only
available if Commit after restore completes is selected.
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v

Note A restore of Microsoft Exchange Server files will always overwrite existing files (if

pub. edb already exists on the target machine, it will be replaced with the copy
from the backup).

13. Click Start Restore.

14. If you chose to restore storage groups and you did not select Mount database after

restore (after the restore), be sure to mount the storage group databases that were
restored.

To restore the Key Management Service or Site Replication Service

1.

2.

Log on as Administrator.

Stop the KMS or SRS service.

The KMS service can be stopped using Exchange System Manager; see “Stopping and
Starting KMS” on page 84 for more information. The SRS service can be stopped using
the Services applet in the Control Panel.

Note Before stopping the KMS service, be sure that you have the KMS service password.

Delete content of the knsdat a or sr sdat a directory, located under the default
Exchange Server installation path.

Start the KMS or SRS service.
Open the Backup, Archive, and Restore interface.

Choose File > Select Files and Folders to Restore > from Normal Backup.

The Restore window is displayed.

Choose File > Specify NetBackup Machines.
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The Specify NetBackup Machines dialog box is displayed.

Specify HetBackup Machines E
Servers  Source Clients | Destination Clients I

Mew Client Mame:

Cliert List:
okra[CURRENT)
hawk.

I ake Eurrent |
V' Use this client list for future backup and restore windaws
Clazs Type:
IMS-Exchange-Server j
QK I Cancel | Help |

8. Click the Source Clients tab.
9. From the Policy Type list, select MS-Exchange-Server.

10. Click OK.
NetBackup browses for Microsoft Exchange Server backup images.

The NetBackup History pane displays Microsoft Exchange Server backup
information. The top split window shows individual image information and the
bottom split gives file and folder information and also allows the user to select what
files are to be restored.

11. From the NetBackup History pane, select the image containing the objects you wish to
restore.

12. In the All Folders pane, select the objects you wish to restore.
- To restore the Key Management Services database, select the KMS node.

- To restore the Site Replication Services database, select the SRS node.

13. On the Actions menu, click Start Restore of Marked Files.
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The Restore Marked Files dialog box is displayed.

Restore Marked Files [ %]

Restore Marked File

V¥ Delete existing transaction lags prior to restore

Exchange 2000
Temporary location for log and patch files:

V' Commit after restore completes

¥ Mourt database after restore

Start Hestorel Cancel | Help |

Refer to the Table “Microsoft Exchange tab options” on page 81 for information on the
restore options available.

14. Click Start Restore.

15. If restoring the KMS, stop and start this service.

Stopping and Starting KMS

The following section describes how to stop and start the KMS using the Exchange System
Manager.

Note Before stopping or starting the KMS, be sure that you have the KMS password.

v To stop or start the KMS
1. Choose Start > Programs > Microsoft Exchange > System Manager.

2. Inthe left pane, open the appropriate Administrator Group and click on Advanced
Security.
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3. Inthe right pane, right-click on Key Manager and choose All Tasks, then Stop
Service or Start Service.

3 age H[= R

J% LConzole  Window .ﬂelp |;|i|l|
e e e am 2R 2|2 ] = |

Tree I Advanced Security

Firzt Organization [Exchange] | Name |
+ @ Global Settings Encryption Configuration
|-l Fiecipients e

EID Administrative Groups SIELSEVIcE

{2 First Admiristrative Gr Help m"\\

Jer

&
-ﬁ gz:ne;::tors Errall Users o
= d Revoke Certificates
@ Advanced Securi A K
]ﬂ Folders oover heys
-0 Groupd, Export Users
-0 GroupB Import Users
&-{ GroupC Save KMS Certificate
-2 GroupD
-2 GroupE Change Startup Password
-2 GroupF
-2 GroupH
-] Second Admiristrativ_|
- SRS-EXCH
-8 Tools _ILI
4 I I 3
|St0p Service
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Individual Mailbox Operations

This section describes how to perform individual mailbox backup and restore operations.

Notes

O The root path of an Exchange Mailbox object (“Microsoft Exchange Mailboxes:”) is
case-sensitive.

O Mailbox folders or message subjects containing the characters “~”, “\”, or “/” are
translated as follows:

Character Translation
~ ~0
/ ~1
\ ~2

Performing a User-Directed Mailbox Backup

To perform a user-directed mailbox backup

1. Log onto the server as Administrator.

Note The administrator must have the same Exchange privileges as the NetBackup Client
Service Account. For Exchange 2000, the NetBackup Client Service Account must
also have the advanced privileges “Send As” and “Receive As.” Refer to
“NetBackup Client Service Account” on page 18 for more information about
assigning privileges.

2. Open the Backup, Archive, and Restore interface on the Exchange Server.
3. On the File menu, click Select Files and Folders to Backup.

4. Ifyou are in a cluster environment, specify the name of the Virtual Exchange Server as
described in “Specifying the Virtual Exchange Server” on page 103.

5. Inthe All Folders pane, expand the Microsoft Exchange Mailboxes node.

v
-—w
— I
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Browsing Exchange 5.x mailbox objects

% Backup, Archive, and Restore - NetBackup - [Backup: Server: snowbush Client: snowbush]

W Fle Edt Yiew Actions Window Help ==
13 Select For Backup | B3, Select for Restore - | 2y Miew Status | &
g All Folders C of Mi ft Exch Mailboxes: \CcdSHOWBUSH. YvxGroupA
f— A | Mame | Attributes | Size I Time Modified |
i [ 5B Common Views d-- 0 2000-04-06 1:04:09 PM
[l sBDeferred Action d-- 0 2000-04-06 1:04:09 PM
_— [V $EFinder d-- 0 2000-04-06 1:04:09 PM
[l sE5cheduls d-- 0 2000-04-06 1:04:09 PM
Redistry [l $Eshortouts d-- 0 2000-04-06 1:04:09 PM
System,State [l Top of Information Store d--- 0 2000-04-06 1:04:09 PM
Micrasaft Exchange Server [ sBaviews d-- 0 2000-04-06 1:04:09 PM
9 Microsoft Exchange Mailboxes b
[ CedSNOWBLSH, YxGraup
[ CrhSNOWEUSH, YmoGroupd
62 EekSNOWEBLISH, RupGraupd
63 FauSHOWBUSH, EFwGraupd
62 FldSNOWELISH, KedGroupd
D@ FuySMOWEBUSH, LliGroups
D@ GisSMOWBUSH, GlaGroups
63 HibSNOWBLISH, PbaGroupd
63 IrSHOWBUSH, FleGroupd
D@ KnrSNOWELISH, KibGroups
63 KxgSHOWBUSH, TdaGraupd
#-[]05 mail gen _ILI
1| | 3
Ready v

Browsing Exchange 2000 mailbox objects

s_T;Backup, Archive, and Restore - NetBackup - [Backup: Server: lantana Client: lantana]

E File Edit “iew Actions Window Help = |ﬁ'|1|
73l Select for Backup | 3, Select for Restore + | 2y Wiew Status | &
g All Folders C of Mi ft Exch Mailboxes:\Knsuhidaaa LANTAMA |
05 & | [ Name | 4. [ 5] Time Modiied |
O=c [ 52 Comman Yiews d- 0 8/29/2002 2:16:36 PM
O=¢0 [¥] 5 Deferred Action d- 0 8/29/2002 2:16:36 PM
O& IE1 M 5& Finder d- 0 8/29/2002 2:16:36 PM
8;?‘ Metwark B Schedule d- 0 8/29/2002 2:16:36 PM
Ao 58 Shortcuts de 0 8/23/2002 2:16:36 FM
Syftemy - G Tap of Information Store d- 0 9/14/2002 1:32:30 PM
Microsoft Information Store A iews d- 0 8/23/2002 216:36 FM
@ Knzuhitaaa LAMTAMNA [knsuhitaaa)
D@ SMTP [LANTANA-{15B00588-B577-4C
D@ SMTP [LANTAMA-{238F3C72-DB3C-4
D@ SMTP [LANTANA-{70433344-C208 -4,
D@ SMTP [LANTANA-{B0SCOBEA-FBAT-4
: @ SMTP [LANTAMA-{94540306-1 850_4.i;|
4 »
Ready i
6. Select the mailbox you wish to back up.
—
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To back up a folder of a specific mailbox, expand the appropriate mailbox and select
the the folder that needs to be backed up.

7. Click Start Backup.

A NetBackup message will indicate that the restore was successfully started. Click Yes

if you wish to open the View Status dialog box and view the progress report of the
NetBackup operation.

The following is an example of a status report for an Exchange 2000 client.

Yiew Status !E[ E

Operation Type

Time Requested

Operation Status | |

Lloze |
(= & 2 0 Pk S i’
Restare 2000-09-25 7:17:33 PM Successhul Delete
Restare 2000-09-25 7:14:10 P Successhul
Restore 20000925 7.0343PM  Successful Help
Restare 2000-09-25 7:00:55 P Successhul

-
[= . ANNN N0 IF C.F2-FA Dhd T rmmmenbil _I

— Selected Operation:

;l Befresh
v ‘erhose Frint...

Progress:

fas ]

e |

Fiefrezh Rate [seconds]: I - |
_ |

=

19:21:03 [174.001] Restoring from image created 2000-03-25 06:47: 20 P

19:21:06 [174.001) IMF - T&R STARTED

15:21:06 [174.001] INF - Beginning restore from server snowbush ta client snowbush, file E:\Disk_storagehsnowbush_0963925640_C1_F1.
19:21:09[174.001] TAR - Microzoft Information Store:\First Storage Grouph

19:21:09[174.001] TAR - Microzoft Information Store:\First Storage GroupiMailbox Store [SHOWELSH]

19:21:23[174.001] TAR - Microzoft Information Store:\First Storage Groupi\MB2_SGO

19:21:36 [174.001] TAR - Microzoft Information Store:\First Storage GrouphPublic Folder Store [SHOWELSH]

19:21:44 [174.001] TAR - Microzoft Information Store:\First Storage GrouphLog files_ 0963325640

19:22:25 [174.001) INF - TAR EXITING WITH STATUS =0

19:22:25 (174.001) INF - T4R RESTORED 5 OF 5 FILES SUCCESSFULLY

19:22:25 [174.001) INF - T&R KEPT O EXISTING FILES

19:22:25 [174.001) INF - T4R PARTIALLY RESTORED O FILES

19:22:25 [174.001] Status of restore from image created 2000-09-25 06:47:20 PM = the requested operation was successfully completed

19:22:26 INF - Server status = 0
19:22:26 [174.50] INF - Statuz = the requested operation was successfully completed.

o o

Restoring Individual Mailboxes, Folders, or Messages

NetBackup can restore individual mailboxes, mailbox folders, or mailbox messages.
NetBackup can also restore mailboxes backed up by Backup Exec.
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Notes

O When messages in folders are restored to a location where a message with the same
name already exists, the restored message does not replace the existing message, but
is added to the destination folder. Therefore, duplicate messages may exist in the
destination folder.

For example, if the Inbox folder contained two messages, “Subject A” and “Subject B”,
and the backup image for the Inbox contained the same two messages, after the
restore of backup is completed, the Inbox folder would contain four messages, two for
“Subject A” and two for “Subject B”.

O The destination mailbox must exist to successfully restore a mailbox.

O When a mailbox is restored, all folders and messages contained in the mailbox are
restored. You can choose to restore specific folders or messages or both from the
mailbox backup image.

O When a folder is restored, all subfolders and messages contained in the folder are
restored. You can also choose to restore specific subfolders or messages or both from
the folder backup image.

v Torestore a mailbox, folder or message
1. Logon as Administrator.
2. Open the Backup, Archive, and Restore interface.

3. Select the type of restore to perform.

- To restore from NetBackup backup images, choose File > Select Files and Folders
to Restore > from Normal Backup.

- To restore from Backup Exec backup images, choose File > Select Files and
Folders to Restore > from Backup Exec Backup.

Note Do not choose the Restore type from Normal and Backup Exec backups. This may
leave the database in an inconsistent state and may lead to loss of data.

The Restore window is displayed.
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The top pane of the NetBackup Restore window shows individual backup image
information. The bottom pane shows file and folder information for the select image
from the top pane and allows for selection of Exchange objects to be restored.

E File Edt Yew Actions ‘Window Help & =]
Bl Select for Backup | F3 Select for Restore - ‘iew Status | &

NetBackup History

Time Backed Up |_Time Expires__| Files | Size: | Compressed | schedule Type | Class Name | keyw =]
@ 2000-05-08 5:38:03 PM 2000-05-15 9 301 ] Full Backup test_mbz
@ 2000-05-08 5:38:02 PM 2000-05-15 11 445 ] Full Backup test_mb2
@ 2000-05-05 5:38:01 PM 2000-05-15 11 442 M Full Backup test_mbz
& 2000-05-05 4:27:45 PM 2000-05-15 24 FI96055 M Full Backup test_mailboz
a 2000-05-05 12:53:52 PM  2000-05-12 514 4756 \] Full Backup test_mailbox
0 2000-05-05 12:47:36 PM  2000-05-12 96 1047 M Full Backup kest_mailbax Alj
4| | 3
All Folders Ci of "Mi ft Exch Mailboxes:\test c’
E||:| snowbush Mame | Time Backed Up | Attribukes | Size I Time Modified |
=05 Micrasoft Exchange Mailboxes %8 Comman Yiews 2000-05-05 12:47..,  cr— 0 2000-04-14 11:05..,
- L1 mail gen CDeferred Action 2000-05-05 12:47...  d— 0 2000-04-14 11:05..,
O test 2 CI<EFinder 2000-05-05 12:47... - 0 2000-04-14 11:05...
=L test b O <Erschadule 2000-05-05 12:47...  d-— 0 2000-04-14 11:05...
& D%gt Ccommn views & shartouts 2000-05-05 12:47..,  d-— 0 2000-04-14 11:05...
[ Deferred Action <& Top of Information ... 2000-05-05 12:47..,  d-— 0 2000-04-14 11:05...
14 Finder OsEaviews Z000-05-05 12:47...  d— 0 2000-04-14 1105,
-] 4 Schedule
-] 4 Sharteuts
-4 Top of Information Store
~[J%E Calendar
~[J%E Contacts
~[J%E Deleted Items
~[J%E Drafts
F-[]5E Inbox
~[J%E Journal
-1 Notes
-5 Outbox
-[]%E Sent Items
-5 Tasks
E-[C]5E zine
D@ Yiews

4. Choose File > Specify NetBackup Machines.
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The Specify NetBackup Machines dialog box is displayed.

Specify NetBackup Machines [ %]
Servers  Source Clients | Destination Clients I
Mew Client Mame:
Add
Cliert List:
snowbush[CURRENT)
morgans
Iake Current |
[V Use this client list for future backup and restore windaws
Clazs Type:
IMS-Exchange-Server j
QK I Cancel | Help |

5. Click the Source Clients tab.
6. From the Policy Type list, select MS-Exchange-Server.

7. Click OK.

NetBackup browses for Microsoft Exchange Server backup images.

8. Select an image from the NetBackup History pane.
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9.

In the All Folders pane, select the mailbox, folder, or message to restore.

$% Backup, Archive, and Restore - NetBackup - [Restore: Server: snowbush Source Client: snowbush Destination Client: snowbush]  [Hi[=] E3
E File Edt Yiew Actions ‘Window Help = IE Iil
@Select far Backup | B3, Select for Restore ‘ {2 view Status | @ ‘
@ MetBackup History
— | Time Backed Up | Time Expires | Files | Size I Compressed | Schedule Type | Class Name | ke w;l
& a 2000-05-08 5:35:03 PM 2000-05-15 a 301 U] Full Backup test_mbz
a 2000-03-08 5:35:02 PM 2000-03-15 11 445 U] Full Backup test_mbz
u 2000-05-08 5:35:01 PM 2000-05-15 11 442 M Full Backup test_mbz
. | & 2000-05-08 4:27:45 PM 2000-05-15 24 FEOE05S M Full Backup test_mailbox
@ 2000-05-05 12:53:52 PM  2000-05-12 514 4756 M Full Backup test_mailbox
@ 2000-05-05 12:47:38 PM 2000-05-12 96 1047 ] Full Backup test_mailbox =
4| | 3
All Folders C of "Mi ft Exch Mailboxes:\mail genktop of information storehzine\f'
El-fA B snowbush Hame Time Backed Up [ attributes | Size |_Time Modified |
=-{Z] 53 Microsoft Exchange Mailboxes EAMailGen Message n..,  2000-05-05 12:47.,, - 65419 2000-04-12 1:13:..,
@ mail gen _ ) EAMailGen Message n..,  2000-05-05 12:47.., - 65410 2000-04-13 11431,
=-[£1 2 top of informatian store A MailGen Message n..,  2000-05-05 12:47,,, - 65419 2000-04-13 3461,
E‘"® ngaﬂ EAMailGen Message n...  2000-05-05 12:47.., - 65419 2000-04-13 6:061...
1 MallGen Message EdMailGen Message n..,  2000-05-05 12:47.., - 65419 Z000-04-13 6:06:..,
v -05- [E T -04-13 6061
9 MailGen Message [ MailGen Message n 2000-03-05 12:47 65419  Z000-04-13 6:06
£ MailGen Message
£ MailGen Message
£ MailGen Message
£ MailGen Message
B0 test a
B0 test b
B[]0 test ¢
4 | o
4

When selecting objects from the Microsoft Exchange Mailbox tree, all objects are
displayed as folders and messages. Some non-message objects can be identified by the
subject line. For example, if you create a Calendar event named Appointmentl, that
name is displayed in the subject line for that object.

However, some objects such as Forms and Views do not have a subject line (even
though they can be named) and may not be easily identified.

Note Do not restore Microsoft Exchange Mailbox and Microsoft Exchange Server objects

at the same time. Either the restore of the mailbox objects will fail because the
Exchange services are down to perform a restore of Exchange server databases or, if
the restore of the Exchange mailbox items finish before the restore of the Exchange
databases starts, the mailbox objects restored will be wiped out by the restore of the
Exchange databases.

10. On the Actions menu, click Start Restore of Marked Files.

Note The options on the Exchange tab do not apply to restores of individual mailboxes,

folders or messages or to restores of Public Folders.

11. Click Start Restore.

NetBackup for Microsoft Exchange Server System Administrator’s Guide



Individual Mailbox Operations

For information on restoring to different locations, see “Redirecting Mailbox Objects
to a Different Path.”

Redirecting Mailbox Objects to a Different Path

NetBackup can restore Exchange mailbox objects from NetBackup and Backup Exec
images to different locations. Following are examples of how mailbox objects are
redirected.

For example, if you back up Mailbox 1, which consists of Top of Information Store, Inbox,
and Folders 1 and 2, each containing some mail messages, and then you restore Mailbox 1
to the existing Mailbox 2, then all of Mailbox 1, including the Top of Information Store,
Inbox, Folders 1 and 2, and messages, are restored to Mailbox 2. Note that Mailbox 1 itself
is not created under Mailbox 2.

Redirecting the restore of Mailbox 1 to Mailbox 2

E-[#] 2 snowbush = & snowbush
{215 Microsoft Exchange Maiboxes - £ Microsaft Exchange Mailboxes
=[G Mailbox 1 =016 Mailbox 2
=[] % Top of Information Store -] g Top of Information Store
- [# 8 Inbox E‘D@ jr—

B Folder 1 [J55 Folder 1
[v] B Message 1 [JEA Message 1
[ Message 2 [JEA Message 2
S Folder 2 EDQ@ Folder 2
£ Message 3 [ EA Message 3
: ] Message 4 B3 Message 4

If you redirect the restore of Mailbox 1\Top of Information Store\Folder 2 to Mailbox 2,
the contents of Mailbox 1\Top of Information Store\Folder 2, Message 5 and Message 6,
are placed in Mailbox 2 in the same folder as they were in Mailbox 1.

Redirecting the restore of Folder 2 to Mailbox 2

=7 & snowbush = & snowbush
E‘Q Microsaft Exchange Mailboxes EDS Microsoft Exchange Mailboxes
E@ Mailbox 1 ED@ Mailbox 2
=[] % Top of Information Store -] g Top of Information Store
=[] Inbox =158 Inbax
= [#14& Folder 1 E-[]5& Folder 2

A Message 1 ----- [JEA Message 3
[ Message 2 ] B Message 4
[v] 5 Folder 2

£ Message 3
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Requirements

0O The NetBackup Directive (Microsoft Exchange Mailboxes:\) of the destination path
cannot be changed. NetBackup will not recognize that this is an Exchange mailbox
restore and will attempt to restore the objects as normal files.

O If the destination path’s mailbox name is changed from the original, the destination
mailbox must already exist and must have an associated user account.

O If the third segment of the destination path is modified (the Exchange folders “Top of
Information Store,” “Views,” “Finder”), the selected object will be restored to that
specified folder name. The new folder can be seen when browsing for backups and
will be backed up on subsequent backups of that mailbox. However, the folder and
any subfolders and messages in that folder cannot be viewed using Outlook.

v To restore a mailbox to a different mailbox

1. Open a Restore window.

2. Select a mailbox to restore.

3. Choose Actions > Start Restore of Marked Files.

4. Inthe Restore Marked Files dialog, select Restore everything to a different location.

Note The Browse button does not browse Exchange mailboxes or folders and should not
be used. It is only useful for browsing file systems.

5. In the Destination box, change the destination to restore to.

- When restoring from NetBackup images, change the mailbox portion of the
Destination field to another existing mailbox to restore to. For example, if you
wish to restore the contents of Mailbox 1 to Mailbox 2, specify M cr osof t
Exchange Mai | boxes: \ Mai | box 2\ inthe Destination box.

- When restoring from Backup Exec images, specify another existing mailbox you
wish to restore to. For example, if you wish to restore the contents of Mailbox 1 to
Mailbox 2, specify Mai | box 2 in the Destination box.
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Note When restoring from NetBackup images, you must indicate an explicit path (or full
path) in the Restore everything to a different location box for this option to be
successful.

Backup, Archive, and Restore : Server: snowb: =101 x|
) File Edb Wiew Actions ‘Window Help =181 x|
_@Select For Backup | 3, select for Restore - | \-'iaw Status | @ |
ﬂ HetB ackup History
— | Time Backed Up | Tirne Expires | Files | Size | Compressed | Schedule Tvpe | Class Mame | Kei w:l
& 2000-05-05 5:38:03PM 2000-05-15 =S E g =
—— | & z000-05-08 5:33:02 PM 2000-05-15 3 x|
3 & 2000-05-08 5:38:01 PM 2000-05-15 =
= @ 2000-05-08 4:27:45 M 2000-05-15 bt |
€2 2000-05-05 12:53:52 PM 2000-05-12 e A
.IZUUD'US'DS L2473g M 2000-05-12 " Pestore everything ta its original location i
4 »
% Restore everpthing to a different location [maintaining existing structurel  ————1
All Folders 5
ource:
= =) smowbush o - Modified I
.. p IMlcrosoFt Exchange Mailbaxes:\test ¢4 el
=] g Microsoft Exchange Mailboxes -04-14 11:05..,
D@ mail gen Destination: -04-14 11:05...
O testa IMicrosoft Exchange Mailboxes: \test x4 Brovise: | -04-14 11:05...
D) testb -04-14 11:05...
=) El;;tcc v " Restore individual folders and files to different locations [double-click to madifyl: -04-14 11:08, .,
| omman Yiews e -
3 Source | Destination | Time Backed Up -04-14 11:05..,
[]5E Deferred Action - -
[¥]%& Finder Microsoft Exchange Maiboxes:\test o\ 2000-05-05 12:47.38 PM -04-14 11;05,.,
[P5E Schedule
[l Shortouts
El-[#5E Tap of Information Store 4 | _>|
[A5E Calendar
Contacts :
M Delated Ttems r— Restare Optian
g If the destination file already exists:
i ; rba S % Delete existing transaction logs prior to restare
nba :
€ Bestore the fle using a termparany flename
[ 5& Journal ; 3= BE
€ Doinct restore the file:
[ 5E Motes
[P 48 Cutbox
[ [#] 4 Sent Ttems Stait Restore | Cancel | Help |
[P 5E Tasks
[P zine
[ views
Ready v

6. Click Start Restore.

v To restore a mailbox folder to a different location

Note Individual mailbox items cannot be restored to different locations when restoring
from Backup Exec images.

1. Open a Restore window.
2. Select a folder to restore.

3. Choose Actions > Start Restore of Marked Files.
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4,

In the Restore Marked Files dialog, select the Restore individual folders and files to

different locations option.

Each row under Restore individual folders and files to different locations is
associated with a selected folder to restore.

Double-click on a row to modify the folder destination.

The Enter New Destination dialog is displayed.

In the New box, change the destination to restore to.

The destination can be any valid existing Exchange folder path.

Note The Browse button cannot be used to browse for Exchange mailboxes or folders. It
is only useful for file system backups.

ckup, Archive, and Ry

File Edit ¥iew Actions ‘Window Help

=10l
-1

P

_@Select For Backup | 3 Select For Restore

NE R

NetBackup History

Time Backed Up I Time Expire

& 2000-05-08 5:36:03 P 2000-05-15
@ 2000-05-08 5:35:02 PM 2000-05-15
@ 2000-05-08 5:36:01 PM  2000-05-15
@ 2000-05-08 4:27:45PM  2000-05-15
& 2000-05-05 12:53:52 PM  2000-05-12
@ 2000-05-05 12:47:35 PM 2000-05-12

4

All Folders

[=1-[#] ) snowbush
5B Micrasaft Exchange Mailbo

[ Common Yiews
[ Deferred Action
-] % Finder
-] %E Schedule
-] E shorteuts
[=1-[Z1 8 Top of Information ¢
-] Calendar
-] Contacts
-] ¢ Deleted Items
-] Drafts
-] §E Inbox
-] Journal
]G Notes
-5 Outhox
-] 58 Sent Items
O Tasks
- zine
-] 5E Views

Ready

7. Click OK.

B &

- | BEview stabs |
Restore Marked F

5
Restore Marked Files |

[kepm =]

—

Time Modified

2000-04-14 11:05..,
2000-04-14 11:03..,

~ Restore Destination Choices
" Restore everything to its original lozation

" Restore everything to a different location [maintaining existing structure]:

Source:

|MicrUsUfL Exchangs Malboses vest chTop of Infarmation Starehinbox
Destinatior:

|M|cmsnﬂ Exchange Malboxes \test c\T op of Infarmation Store Browse..

' Rastore individual folders and files to different locations [double-click to madify]

Sliise ___ - [CETE ) | ooy
icrosoft Exchange Mailboxes: \test c\Top of Information Storeh nbox 2000-04-14 11:05...
£000-04-14 11:03...
2000-04-14 11:05...
4| | | 2000-04-14 11:05...

— Festore Option
I the destimation file alieady exists: ‘
& Delete exi Enter New Destination

£ Aestore t ) )
{5 | o it Source: Microsoft Exchange Malbowes: \test chTop of Infaormation Storesnboxt

New

Microsoft Exchange Mailboxes:\test 5T op of Information StoreSlnbosy

o]

Browse

Cancel |
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8. Click Start Restore.

v To restore a mailbox message to a different location

Note Individual mailbox items cannot be restored to different locations when restoring
from Backup Exec images.

1. Open a Restore window.
2. Select a message to restore.
3. Choose Actions > Start Restore of Marked Files.

4. Inthe Restore Marked Files dialog window, select the Restore individual folders and
files to different locations.
Each row under Restore individual folders and files to different locations is
associated with a selected message to restore.

5. Double-click on a row to modify the message destination.

The Enter New Destination dialog box is displayed.

6. Inthe New box, change the destination to restore to.
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The destination can be any valid existing Exchange folder path.

Backup, Archive, and Restor i =] 5
File Wiew Actions  Window  Help =] x]
I select For Backup | B3, select for Restore - | yview Status | & ‘
HetBackup History
Time Backed Up | Time Expires | Files | Size I Compressed | Schedule Type | Class Narne | Ke: wc:l
& 2000-05-08 5:38:03 PM 2000-05-15 ] 2 bl Eullnel. < Lock cobo:
€ 2000-05-08 5:38:02 P 2000-05-15 IRl R estore Marked Files x|
& 2000-05-08 5:38:01 PM 2000-05-15 11 Restore Marked Fil
€8 2000-05-08 42745 P 2000-05-15 24 estore Maked Files |
2 2000-05-05 12:53:52 PM 2000-05-12 514 e e
IZDDD_DS_DS par B 2 " Restore eversthing to its original location
A
A1 Folders | ® SHestore everything to a different location [maintaining existing structure]:
) cnowbush Name s z - -
5 Microsoft Exchangs Mailboss D=3 o s |M|':msofr Exchangs Mailboxes Stest chTop of Information Storebinbox\Test 1 -
O <ho s D estination:
O <ho = IMicmsoft Exchange Mailboxes \test cAT op of Information Store Browse.
[
Attach @ Restore individual folders and files to diferent locations (double-click to modif
-] % Comman Views Eg Attach ! o)
-] % Deferred Action a S_OL’"CE - -
% Finder & attach Microsoft Exchange Mailboxes:test c\Top of Infomation StorehnboxiTest 1 - T
-] % Schedule D1 Attach
-] 4 Shartcuts B EATest 1
=-[A]5E Top of Information Stare CIEaTest 1 . N
-] 5 Calendar B Test 1 Kl —
-] 5 Cantacts I E=ATest 1 S
Deleted It s !
LJ¢E Deleted Lters IF:the destination file alieady exists:
-] % Drafts = : i Tl
{2 Inbox Enter New Destination B
-] 5 Journal
- [J4E Motes Source: Miciosoft Exchange Maiboxesitest chTop of Information StorehnboxTest 1 -
¢ Outbox Testlist
-] Sent Tkems New &
p
I GE Tasks ailbones:tast #vT op of Information Storshnbox\Test 1} TestList <EFO0000 Browse |
-] zine
-] 4 Views i]'4 I Cancel |

Ready

Click OK.

8. Click Start Restore.
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| Performing Single Instance Store Backups

Microsoft Exchange Server uses single-instance storage (SIS) to store mail messages. This
capability in Exchange Server allows the database to keep one copy of a message
attachment sent to multiple users on the same server. To perform SIS backups, this feature
must be enabled on the client where Exchange Server is installed.

Note Only attachments larger than 100K are backed up as SIS objects. Attachments
smaller than 100K are backed up with each individual message.

| v To enable SIS backups

1. Open the NetBackup Adminstration Console or the Remote Administration Console.
2. In the left pane, expand Host Properties.

3. Click Clients.

4. Inthe right pane, right-click on the client you wish to configure and choose
Properties.

5. Click on the Exchange tab.

' Client Properties

= PC Client Settings I = windaws Client I J Metwark I ¢:¢ OTH I @ Timeouts

E. Client Mame I General Client I % Logging I Q Firewall
General I @ Univerzal Settings I % Servers I Bﬂ Media Servers | @1 Exclude I % Include
¢:¢ WSP I é Encryption I ‘m Laotuz Motes Q Exchange | a GOM

Mailbox for message level backup and restore
FEHITAS ‘webmaster

~ Enable single instance backup for message attachments
[for mailbox backups only)

QK I Cancel | Help |

6. Select Enable single instance backup for message attachments.
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7. Click OK.
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Backing Up and Restoring the Microsoft Exchange Public
Folders

The Public Folders and individual folders within Public Folders can be backed up and
restored like a mailbox. NetBackup needs to be configured for these types of operations
before backups and restores of individual folders in the Public Folders can be performed.
If NetBackup has already been configured for individual mailbox operations, no further
configuration for Public Folders is necessary. If not, refer to “Configuring NetBackup for
Individual Mailbox Operations” on page 18.

Notes

O When messages in folders are restored to a location where a message with the same
name already exists, the restored message does not replace the existing message, but
is added to the destination folder. Therefore, duplicate messages may exist in the
destination folder.

For example, if the Inbox folder contained two messages, “Subject A” and “Subject B”,
and the backup image for the Inbox contained the same two messages, after the
restore of backup is completed, the Inbox folder would contain four messages, two for
“Subject A” and two for “Subject B”.

O When a mailbox is restored, all folders and messages contained in the mailbox are
restored. You can choose to restore specific folders or messages or both from the
mailbox backup image.

O When a folder is restored, all subfolders and messages contained in the folder are
restored. You can also choose to restore specific subfolders or messages or both from
the folder backup image.

Backups and Restores of Public Folders

To perform backups and restores, follow the instructions in “Individual Mailbox
Operations” on page 86, but when instructed to select the objects to backup or restore,
selectthe M crosoft Exchange Publ i c Fol ders node or the desired folders within

that node.
B B ———
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Selecting items to backup in the Microsoft Exchange Public Folders node.

ackup, Archive, and Restore - NetBackup - [Backup: Server: lantana Client: lantana]

E File Edit “iew Actions Window Help = |ﬁ'|1|
73l Select for Backup | 3, Select for Restore + “Wigw Status | &
g All Folders C of Mi ft Exch Public Folders
= |=-Oed & Name [&. ][ Time Maodified |
& 2Os¢c M @ Folder. de 10/10/2002 8:52:33 AM
e |E-]J=D —
EJ-B SE <& Folded d- 10/10/2002 85233 AM
y CJsEFolder d- 10/10/2002 8:52:33 &M
SE‘?} Network Q<& Intemet Newsgioups d-  10/10/2002 8:52:33 &M
= Ao D142 New Pub Falder From Sps d- 10/10/2002 8:52:33 AM
& 01 5 Y et L1481 Test Note ltems de 10102002 8:52:33 AM
=0 Micosoft Information Store [CJ%2 Test Public: Folder d- 10/10/2002 8:52:33 &M
=- Microsoft Exchange Mailboxes
= Microzoft Key Management Service
[#- Dﬁ; Microsoft Site Replication Service
[+ Microsoft Exchange Public Folders
----- |:| Microzoft SharePoint Portal Server
[#- @ Microzoft SharePoint Portal Work spaces
[+ Oracle
Feady 4

Selecting items to restore in the Microsoft Exchange Public Folders node.

ackup, Archive, and Restore - NetBackup - [Restore: Server: lantana Source Client: lantana Destination Client: la... [Ei[=] [E3

File Edit “iew Actions Window Help = |ﬁ'|1|
73l Select for Backup | 3, Select for Restore + iew Status | &
@ MetBackup History
— | Time Backed Up | Time E=pires | Filesl Size | Compressed | Schedule Tupe | Palicy Mame ;I
€ 10/10/2002 85822 M 10/24/2002 12 32088 M Uszer Backup gla-exch-ustbackup J
— | @ 10/9/2002 4:45:12 P 10/23/2002 N 97280 M Diff Incr Backup MBOX-515
S | 104942002 4:35:02 PR 10/23/2002 N 97280 M Diff Incr Backup MBOX-515
AM/92002 4-34-3F P ANL2342002 11 97780 M Niff Iner Rackun RRM-515 i
4 | »
'H’h All Folders C of "Mi ft Exch Public Folders
,@ ) lantana MNarme | Time Backed Up [ &..] 5] Time Modified |
—] O TR (& O roers 10A10/2002 850224 d- 0 9/23/2002 5355 PM
711 Folders,
4] | B
Start Restare of Marked Files i

Redirecting Restores of Public Folders

To perform backups and restores, follow the instructions in “Redirecting Mailbox Objects
to a Different Path” on page 93, but when instructed to select the objects to restore, select
the M crosoft Exchange Public Fol ders node or the desired folders within that

node.
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Note When redirecting a restore of a Public folder, the folder does not have to exist in the
new path.

Specifying the Virtual Exchange Server

1. Choose File > Specify NetBackup Machines.
The following dialog box is displayed.

Specify NetBackup Machines [ %]
Servers | Clients |

Mew Server Mame:

Server List:

FAKE[CURRENT) N
DEWEY

HUEY

PLASTIC

RUBBER

dewey

aimend

AIMEND

setaria

|

Eemove |MakeEurrent|

()3 I Cancel |

Help |

2. Click on the Clients tab.
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If the Virtual Exchange server name is displayed under Client List, continue with
step 5.

Specify NetBackup Machines <]
Servers  Clients |

Mew Client Mame:

Iquack‘l

Cliert List:

quackB[CURRENT)
dewey

Eemove |MakeEurrent|

¥ | Wse this client list for future backup and restore windows

QK | Cancel | Help |

3. Under New Client Name, type the name of the Virtual Exchange server.
4. Click Add.
5. Under Client List, select the Virtual Exchange server name and click Make Current.

6. Click OK.
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Redirecting a Restore to a Different Client

This section describes how to redirect a restore to a different client. Most Exchange objects
that have been backed up can be redirected to a different client.

Note Because the Microsoft Exchange Directory and SRS databases contain machine and

security information, they can only be restored to the original computer or a clone
of the original computer. The Microsoft Exchange Information Store databases may
be restored to a different Microsoft Exchange Server.

Requirements for Exchange 2000

The following requirements must be met for Exchange 2000 before redirecting the restore
of storage groups or individual databases.

a
a

O

The storage groups and databases must exist on the target server.

The storage groups and databases must have the same names as the original storage
groups or databases.

The target databases must be configured so that they can be overwritten. (Using the
Exchange System Manager, right-click on the database you want to overwrite and
choose Properties. On the Database tab, select This database can be overwritten by a
restore.)

The target server must have the same Organization and Administrative Group name
as the source server.

If redirecting the KMS or SRS, this service must be installed on the destination client.

A restore redirected to a different client is performed just like a regular restore, except that
a different destination client, and, possibly, a different source client is selected. For
complete information on performing restores, see the following topics:

For information on restoring... See the following

Exchange 5.x Server Objects “To restore Exchange 5.x Server objects” on
page 72

the Information Store, Storage Groups, or Storage “To restore the Information Store, Storage

Group databases Groups, or Storage Group databases” on
page 77

the KMS or SRS “To restore a mailbox, folder or message”
on page 89

. . ———
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For information on restoring... See the following

a mailbox, folder, or message “To restore a mailbox, folder or message”
on page 89

a Public folder “Backups and Restores of Public Folders”
on page 101

v To select a different destination (and source) client
1. Ifarestore window is not already open, open a restore window.

2. Choose File > Specify NetBackup Machines.
The Specify NetBackup Machines dialog box is displayed.

3. Click on the Source Clients tab.

a. Enter the source client in the Client List box.

The source client is the Exchange Server machine name whose backup images
you would like to browse.

b. From the Policy Type drop-down list, select MS-Exchange-Server.
4. Click on the Destination Clients tab.

a. Inthe Client List box, enter the client to which to redirect the restore.

5. Click OK.
NetBackup will browse NetBackup Catalog for Microsoft Exchange Server backup
images.
———
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Troubleshooting NetBackup 5

The NetBackup master server and client software offers a comprehensive set of debug
logs for troubleshooting problems that may occur during NetBackup operations. Debug
logs are covered in detail in the NetBackup Troubleshooting Guide for Windows and UNIX.

If you are experiencing problems backing up or restoring databases or transaction logs,
and the cause of the problem cannot be determined from standard NetBackup progress
reports, you may enable NetBackup debug logs to aid in determining the cause of the
problem. Debug logging is enabled by creating certain folders under the NetBackup Logs
folder.

The following topics cover troubleshooting of NetBackup:
Backup Operation Debug Logging

Restore Operation Debug Logging

Changing the Debug Level

Verifying Exchange Online Backups

Viewing the Status of a NetBackup Operation

o o o o o g

Transaction Logs

Backup Operation Debug Logging

To turn on debug logging for backup operations, create the following folder:
i nstal | _pat h\ Net Backup\ | ogs\ bpbkar

After creating this folder and performing a backup, debug logging information will be
placed in the following file:

i nstal | _pat h\ Net Backup\ | ogs\ bpbkar\ mmddyy. | og
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Restore Operation Debug Logging

To turn on debug logging for restore operations, create the following folder:
i nstal | _pat h\ Net Backup\ | ogs\tar

After creating this folder and performing a restore, debug logging information will be
placed in the following file:

i nstal | _pat h\ Net Backup\ | ogs\tar\ mudyy. | og

For details on the contents of these debug logs, refer to the NetBackup Troubleshooting Guide
for Windows and UNIX. After the cause of the problem has been determined, debug
logging can be disabled by removing the previously created debug logging folders.

Note When debug logging is enabled, the files can become large. The same files are used
by normal file backups.

Changing the Debug Level

You can control the amount of information written to the debug log in the

i nstal |l _pat h\ Net Backup\ | ogs\ bpbkar folder by changing the General debug
level. The higher the value, the more information is logged. In everyday normal
operations, the default value of 0 is sufficient. However, VERITAS technical support may
ask you to set the value higher when a problem is being analyzed.

v To change the Debug Level

1. Choose Start > Programs > VERITAS NetBackup > Backup, Archive, and Restore.

The Backup, Archive, and Restore - NetBackup window appears.

2. Choose File > NetBackup Client Properties.
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3. Click the Troubleshooting tab.

ﬁenerall Exclude ListI Include ListI ﬁackupsl Metwork  Troubleshooting |
— Debug Level
General: TICF:
b [ =
Werbose: Flush :
o = P H
Databaze:
=
Cancel | Help |

By default, the settings are zero.
4. Setthe General debug level.

5. Click OK to save your changes.

Verifying Exchange Online Backups

To verify that the Microsoft Exchange Server online backup contains a usable copy of the
database, perform the following steps:

1. Perform an online backup.
2. Setup atest server and restore the backup.
3. Stop the Exchange services.

4. Perform an integrity check of the databases and verify that no errors are reported
when you run the following commands:

a. Eseutil /g lispriv
b. Eseutil /g /ispub

c. Eseutil /g /ds
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5. Restart the Exchange services.

If the services start at this point, the database is usable and contains no errors.

Viewing the Status of a NetBackup Operation

NetBackup provides many standard status reports to verify the completion of backup and
restore operations. In addition, users and the administrator can set up additional reports if
a site requires them.

Operational Reports

The administrator has access to operational progress reports through the NetBackup
Administration Console. Reports may be generated for Status of Backups, Client Backups,
Problems, All Log Entries, Media Lists, Media Contents, Images on Media, Media Logs,
Media Summary, and Media Written. These reports may be generated for a specific time
frame, client, or master server. Refer to NetBackup System Administrator’s Guide for UNIX or
NetBackup System Administrator’s Guide for Windows for details.

Progress Reports

Progress reports on the client allow easy monitoring of user operations. When reports are
created by the NetBackup client for each user-directed backup or restore operation,
administrators can monitor these operations and detect any problems that may occur.

v To view the status of an operation
1. Choose File > View Status.

2. Click on the task for which you want to check the progress.

3. Click Refresh.

The status of the operation is displayed in the lower pane.
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Status of a backup operation

5 View Status (cgp) M=

Operation Type | Time Requested Operation Status | | Cloge

il M) ] g 8 sful =

Delete
Festore 1075799 5:44:31 Ph4 Successful :‘ g
Fiestore 10/5/99 5:42:33 Phd Successful Help

Festore 10/5/99 5:40:14 Fhd Successful j

Selected Operation:

Fefresh Rate (seconds): 5 : Efiesh
W Wetbhose Print...

Progress:
03:58:36 10/8/93: Backup Started

L]

09:58:55 IMNF - BACKUP START

09:58:57 \Microsoft Exchange Server',

(09:58:58 YMicrosoft Exchange ServeriInfarmation Stare’

09:58:58 INF - Waiting for mount of media id TLA00Z on senser okra

09:58:58 YMicrosoft Exchange SererInfarmation StoreDatabase’

09:58:58 YMicrosoft Exchange Serverinformation Store’Database Private’,

09:55:55 IMF - vWaiting for positioning of media id TL4002 on server okra.

10:00:19 INF - Beginning backup on server okra of client okra.

10:00:22 \Microsoft Exchange Serveriinformation StorelDatabaselPrivate\PRINV.EDE
10:00:22 YMicrosoft Exchange Serernfarmation Store’ Database '\ Publich,

10:00:25 YMicrosoft Exchange Serveriinformation StorelDatabaselPublici PUB EDB
10:00:27 YMicrosoft Exchange SererInfarmation Store’ Transaction Logsh,

10:00:29 YMicrosoft Exchange Serserinformation Store’ Transaction Logs\edb00343 log
10:00:30 YMicrosoft Exchange ServerInfarmation Store’Database’,

10:00:30 YMicrosoft Exchange Serseriinformation Store’Database ) Private’,

10:00:30 YMicrosoft Exchange SerseriInfarmation Stare’Database!\Frivate\FRN . pat
10:00:30 YMicrosoft Exchange Serserinfarmation Store’ Database '\ Publich,

10:00:31 \Microsoft Exchange Serveriinformation StorelDatabaselPublichPLUB pat
10:00:31 INF - Total Size:1 2615680

10:00:31 INF - Client completed sending data for backup

10:00:39 INF - Backup by cgp on client okra: the requested operation was successtully complated.

"l

K|
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Status of restore operation

%35 View Status (cap) 1H[=] E3

| Cloze |

= Delete
Successful :I g
Restare 1045/99 54431 P Successful Help

Restore 1045799 5:42:33 PM Successful ﬂ

Selected Operation

Fefresh Rate (seconds): |5 : Befresh
¥ “erbose %

FProgress:
10:10:16 10/8/99: Restore Started J

10:10:23 (392.x00<) Restore job id 392 will require 1 image.
10:10:23 (392.000) Media id TLA002 is needed for the restare.

10:10:29 (392.001) Restoring from image created 10/08/99 09:58:49 Ak

10:10:31 (392.001) INF - TAR STARTED

10:10:32 (392.001) INF -“Waiting for mount of media id TL400Z on eerver okra.

10:11:28 (392.001) INF -Waiting for positioning of media id TL4002 on server okra.

10:11:45 (392.001) INF - Beginning restore from server okrato client okra.

10:11:50 (392.001) TAR - Microsoft Exchange Server\Information Store\Databas e Private PRIV .EDB
10:11:51 (392.001) INF - Stopping service: Microsoft Exchange Infarmation Store

10:12:06 (392.001) INF - Exchange MDB Database: Existing Transachon Logs successfully removed.
10:12:06 (392.001) INF - Restoring: d:yExchData\MDB\Privi FRIY.EDB

10:12:09 (392.001) TAR - Microsoft Exchange Server’\Information StorelDatabasetFublic\PUB.EDE
10:12:09 (392.001) INF - Restoring: d:yExchDataiMDBYPubtPUB EDB

10:12:13 (392.001) TAR - Microsoft Exchange ServerInformation Storel Transaction Logshedb00343.log
10:12:13 (392.001) INF - Restaring: o\ ExchDataMDB\Logsedbil3d3log

10:12:15 (392.001) TAR - Microsoft Exchange ServerInformation Store\DatabaselPrivate\PRIY.pat
10:12:15 (392.001) INF - Restaring: d:\ExchData\MDB\Log s\ PRIV . pat

10:12:16 (392.001) TAR - Microsaoft Exchange Senverhinformation Store\Database!PublicyPUE pat
10:12:16 (392.001) INF - Restaring: o:\ExchData\MDB\Logs\PUB.pat

(: JINF - TAR EXITING WITH STATUS = 0

; JINF-TAR BESTORED & OF 5 FILES SUCCESSFULLY

10:12:18 (392.001) INF - TAR KEPT 0 EXISTING FILES

10:12:18 (392.001) INF - TAR PARTIALLY RESTORED 0 FILES

10:12:19 (392.001) Status of restare from image created 10/08/99 09:58:49 AM = the requested operation was successfully completed

10:12:18 (392.001
107218 (392.001

10:12:20 INF - Server status = 0
10:12:21 (392500 INF - Status = the reguested operation was successfully completed

o of

Whent he requested operation was successfully conpl et ed message
appears, the NetBackup operation is finished. (See your NetBackup User’s Guide for
Windows for further information on the progress report and the meanings of the
messages.)

Transaction Logs

Transaction logs are deleted by the Exchange server after a successful backup (for full and
differential backup types). If there are any errors encountered by the Exchange server
during the deletion process, the NetBackup for Exchange agent will log this information.
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Since the actual backup was successful, NetBackup will exit with a status 0 (successful
backup). Refer to the Microsoft Exchange Server documentation for information on any
errors encountered with the transaction logs.
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Troubleshooting the Exchange Server 8

This section describes the common, however infrequent, problems encountered with the
daily operations and management of the Exchange Server. These problems range from
accidental deletion and restoration of a mailbox to the full recovery of a failed server. The
information contained here is complementary to the Exchange Disaster Recovery white
papers, Parts | and Il, and administration guides. The purpose of this chapter is to isolate
and resolve server related problems as soon as they are detected.

VERITAS NetBackup with its Exchange Extensions will be the backup application for all
of the Exchange servers. It is an enterprise solution for and will use the StorageTek 9710
DLT tape silo for storage. Backups and restores will be managed centrally from a UNIX

host. Tape management will be handled directly by the Backup Systems Group.
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Preparation Before a Disaster

Perform the following in preparation for a possible disaster:

Note Any procedure illustrated here should be followed with the assistance of PSS.

Create a Disaster Recovery Kit

Build a kit that includes items such as:

Operating configuration sheet

Hard drive partition configuration sheet

RAID configuration, hardware configuration sheet
Windows NT server configuration

DELL configuration disks

o o o o o g

Microsoft Exchange configuration sheet (including all connector configurations and
location of log files, working directory check point files and database files)

O Windows NT emergency repair diskette
0O Microsoft Exchange Performance Optimizer settings sheet

The goal is to minimize the time to recovery. See “Sample Server Configuration
Worksheets” on page 221 for sample configuration sheets.

Perform Tape Backups

0O Standardize on tape formats. Ensure tapes used to back up all servers are the same
format and are interchangeable.

0O Online full backups of the Directory and Information Stores performed daily.

0O Verify backups by reviewing backup logs and event viewer, noting any error
messages. These backup logs will be sent to the BackOffice team on a daily basis by
the Backup Systems Group for review.

0O Perform periodic file-based backups to capture all configuration information just as a
precautionary measure. This requires services to be shut down.

0O Ensure tapes are readily available on site or can be retrieved from off-site locations
very quickly.
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Create Transaction Logs

Perform the following before creating Transaction Logs:

Physical Drive Configuration

Transaction logs must be written to a separate mirrored physical FAT-formatted drive.
This separate physical drive is not part of a logical drive on a RAIDS array.

Note For performance and redundancy, it is critical that this design be adhered to.

Disable Circular Logging

While Circular Logging can help conserve disk space, the drawbacks are (1) Incremental
and Differential Backups are disabled and (2) transaction log history is cyclical and cannot
be played back. Implementing a full online daily backup strategy, transaction log files will
be purged on a regular basis thus freeing up disk space.
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Ensure Quick Access to Software and Hardware

Check or implement the following to ensure quick access to software and hardware:

Software and Utilities

Ensure that all software is readily accessible. This includes the system software, service
packs and hot fixes such as the Windows NT operating system, Microsoft Exchange, and
VERITAS NetBackup with Exchange Extensions. All software will be stored on the D:
drive (Exch Bin Partition).

Utilities such as ESEUTIL and ISINTEG are found in the \ wi nnt\ syst enB2 and
\ exchsr v\ bi n directory, respectively. See “ESEUTIL and ISINTEG Line Switches” on
page 149 for detailed command switches.

Build a Spare Server

A spare server can be used for either a single mailbox restore server or a full server
recovery. Dedicate a Windows NT Server-based machine with twice the disk capacity of
the largest store, to restore the entire private Information Store database.

Configure the server hardware as closely as possible to the production server
configurations, both hardware and software: array controller, RAIDS5 array (make sure the
transaction log drive is a separate mirrored physical spindle), NIC, etc.

Install Windows NT 4.0 with the same service packs and hot fixes as the production
servers and make it a member server or a backup domain controller. One advantage of
making it a backup domain controller is that you can start up the services without being
on the production network. It will use the SEGEXCHANGE SAM to authenticate the
EXSERVICE account. This will not be the case if you use a service account that is not the
EXSERVICE. There is no need to use EXSERVICE if you are just performing a single
mailbox restore. In this case, the intent is just to get access to the Information stores.

Since this server can be used in two roles, the server name is irrelevant as long as it does
not duplicate an existing name. Have it join the SEGEXCHANGE domain and then
configure the server software.

Install the Microsoft Exchange Server software and when prompted to Join an Existing
Site or Create a new Site, ensure that you choose the option to Create a New Site and
name it. (Installing Exchange in this way will allow you to perform a faster single mailbox
restore, since it requires the Exchange server to have a different machine name which this
server will have. Otherwise, it could not join the domain.)

Run the Performance Optimizer and move the Exchange files to the appropriate drives
and directories. After Exchange completes its installation, install any Exchange 5.5 service
packs or hot-fixes or both. This is now ready for any single mailbox restore request.
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Note Although Exchange has already been installed, a reinstall for a full server restore
can easily be performed.

Note For ease of installation, copy the installation code, for Exchange 5.5, NT-SP3,
Outlook 98, NT 4.0 on the spare server (i.e. D: \ support directory.)

Note When this server is brought into production mode as a full restore server, the IP
address must change to match the downed server. The server name must also match
exactly. With the failed server shut down, remove the server from Server Manager,
then change the name of the spare server to that of the production server. Re-join
the domain to re-establish a new SID, and remove and reinstall Exchange to acquire
the new server name.

Build a Recovery/Test Lab

Perform Periodic Disaster Recovery Drills

Conduct this drill in a test environment and simply attempt a complete recovery. Be sure
to use data from production backups. During this time it is best to record the time it takes
to recover. This information will assist you in determining time to recover in a real
disaster recovery situation.

Verify integrity of the backed-up data by periodically restoring it and logging into random
mailboxes.

Back Up Active Directory (Exchange 2000)

Make sure that Active Directory, which contains most of the server configuration
information, is backed up. You should spread multiple domain controllers throughout
each domain for efficient Active Directory replication so that if one domain controller
fails, redundancy is still provided.

Back Up Internet Information Services (Exchange 2000)

Make sure the Internet Information Services (11S) metabase is backed up. If the entire
server must be restored, the 11S metabase must be restored to the Windows 2000 server
before Exchange Server can be restored.
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Backup the Microsoft Certificate of Authority

If you are using the KMS, be sure to backup the Certificate of Authority (CA). The CA is
included in the backup of system_state of the server.
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Common Exchange Server Problems

The following are common Exchange Server problems and recommended solutions for
them.

Directory (MSExchangeDS) or Information Store
(MSExchangelS) Service Does Not Start

Check the Event Viewer for Errors
The following are some common error messages found in the Event Viewer.
- 529 = JET_errLogDiskFull

Needs more disk space for the transaction logs. Relocate transaction log location to
another drive or purge log files. Refer to the section “Ran out of disk space — Error -1808”
on page 128.

- 530 = JET_errBadLogSignature

Log file(s) are bad, move them out and restart service. Refer to the section “ERROR -550"
on page 130.

- 550 = JET errDatabaselnconsistent

Database is corrupted. Run eseutil /mh, then eseutil /r, then move all log and edb. chk
files to a temporary directory, then restore from tape and as the last resort, eseutil /p.
Refer to the section “Information Store Corruption” on page 130.

- 1018 = JET_errReadVerifyFailure

Occurs when the online backup fails to complete. Indication of a corrupted database.
Restore from tape, if unsuccessful, run eseutil /p. Refer to the section “Tape Backup
Problems” on page 122.

- 1201 = JET_errDatabaseDuplicate

A duplicate database is detected. The store detects a duplicate database based on the
paths recorded in the registry. This error could be caused by the server crashing or loss of
power. In either case, the server was not shutdown properly. Attempt to restore the
database from tape first. Run eseutil /p as the last resort. Refer to the section “ERROR
-1201” on page 132.

-1206 = JET_errDatabaseCorrupted

Database is corrupted. Run eseutil /mh, then eseutil /r, then move all log and edb. chk
files to a temporary directory, then restore from tape and as the last resort, eseutil /p.
Refer to the section on “ERROR -550"" on page 130.
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- 1808 = JET_errDiskFull

The disk where the information stores are located is full. Relocate the store(s) to another
drive via the Admin program or use Performance Optimizer. Refer to the section “Ran out
of disk space — Error -1808” on page 128.

Uninstall Fails (Manual Method)

Remove the Exchange Server

1. Stop all services.

2. Close all applications.

3. Delete the Exchange Server Setup Log file from the root of the D:\ drive.
4. Delete all \exchsrvr directories from all drives.

5. Delete all MSExchange registry entries in:
HKEY _LOCAL_MACHI NE\ Syst eml Current Cont r ol Set\ Servi ces

6. Delete the EDB, ESE97 key from:
HKEY _LOCAL_MACHI NE\ Sof t war e\ M cr osof t\ Exchange

Tape Backup Problems

When the online tape backup fails to complete, perform the following procedures.

Check the Application Event Log for Errors

Event ID: 23 ; Source: EDB; Type: Error; Category: Database Page
Cache; Description: MSM crosoft Exchangel S ((458) Direct read found
corrupted page error -1018 ((-1:550144) (0-589866), 486912 1162627398
3480849804). Pl ease restore the database from a previous backup.

The -1018 error is a JET _errReadVerifyFail ure nessage where the backup
could not read the corrupted page in the IS database. This type of
error is related to hardware failure or device driver failure. Run

di agnostics to isolate the failing hardware or device driver.
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Check Backup Logs

Each Exchange server when backed up by VERITAS does not create individual log files on
the server. VERITAS creates a summary log file on kal-el, the UNIX host that manages all
the backup jobs. The Backup Systems Group will mail a copy of the logs nightly.

VERITAS Status Codes

Status code Description

0 Backup or restore completed successfully

9 Extension not installed, Exchange API is not installed

12 File Open failed, that means Exchange Services were off

40 0r 51 Network unreachable, either system network busy causing collisions,
and such, or system off, or Network down.

There are no backup logs on the Exchange server that can be viewed other than the Event
Viewer.

Example Backup Status Message
The following is an example of a backup status message sent by kal-el UNIX host:

----- Origi nal Message-----

To: Bakh, Bob

Subj ect: Exchange

Wed May 27 20:14:16 PDT 1998 ------------mmmmmm oo oo -

Ved May 27 20:14:16 PDT 1998 CLI ENT:  pfspOl- bak
Wed May 27 20:14:16 PDT 1998 POLI CY: Exchange
Wed May 27 20:14:16 PDT 1998 SCHEDULE: daily

Wed May 27 20:14:16 PDT 1998 SCHEDULE TYPE: FULL

Wed May 27 20:14:16 PDT 1998 STATUS: O

Ved May 27 20:14:16 PDT 1998 - --=--c=cmmmmmmaamaaacaoae

If the STATUS is other than 0 | ook at the web page at
Look under Status Codes to determine the error and then report it to
the Backup teamif there are any questi ons.
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Perform an Offline Backup

Users, from their perspective, may not see any problems accessing the server or their
mailbox since the corruption is not severe enough. To ensure that a backup is performed,
since the current one failed, an offline backup is required.

1.

2.

Shut down all Exchange services.

Copy thedi r, pri v and pub. edb files to a temporary directory on that server.

Perform this function to ensure that the information store, although corrupted, is
backed up in the event the . edb could not be restored from tape and a repair may be
required against it.

Note Be aware of space availability in the event ESEUTIL /P, repair, is required. ESEUTIL

/P requires additional space equal to that of each . edb file.

Restore the Affected Information Store from the Previous Day’s Tape
Backup

1.

When restoring from tape, select Do Not Erase all existing data.

The purpose for doing this is to allow the transaction logs to play back, bringing the
database up to the time of the shutdown.

Run the DS/1S Consistency Adjustment.

From the Exchange Administrator program, highlight the server and select FILE,
PROPERTIES, ADVANCED TAB, CONSISTENCY ADJUSTER, Private
Information Store: Synchronize with the Directory...., ALL INCONSISTENCIES.
Click OK.

Review Mailboxes for Windows NT Account Association.

Highlight the Recipients container under the site.

Double-click the user.

Review the Primary Windows NT Account field to see if the Windows NT account
matches the mailbox. Repeat this for several users.

Test User Logon From Client Workstations to validate access to mailboxes.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Perform an online backup.

Check the event viewer and backup logs to confirm an error-free backup.

In the event the online backup fails on the newly restored pri v. edb, stop the service,
copy the pri v. edb from the temporary directory back to the \exchsrvr\Amdbdata

directory, then runeseuti|l /p /ispriv torepair the private information store
database.

The system will attempt to remove all bad pages in the database (considered low-level
repair).

Run| SINTEG -fix -pri -test alltests.

All tests will run. ISINTEG will find and repair high-level errors in the database. (See
“ISINTEG” on page 158 for more information).Restart System Attendant and
Directory Services.

Run| SI NTEG - pat ch.

Restart IS service.

Perform an online backup.

Check logs and event viewer for errors.

Server Failure Scenarios - Hardware Problems

This section contains details for server failure scenarios involving hardware problems.

Two drives crash in the RAIDs array (entire subsystem is down), but
the mirrored transaction log drive is still running

Perform a full server restoration using the hot spare server that has been previously built,
and relocate the transaction log drives from the production server to the spare server.

Copy the transaction log drives from the E: drive on the production server to another
server (the same result can be realized if the files are backed up to tape and restored back
to the hot-spare)
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4,

5.

After determining that the database drive (F:) is inoperative and the information
stores have been lost, stop all MSExchange services.

Copy the directories where all the transaction log files reside, \exchsrvr\dsadata and
\exchsrvr\mdbdata, from the E:\ drive to another NT file server, such as a BDC, as a
temporary location.

Shut down the server.

Boot the hot-spare server.

Change the IP address of the hot-spare server to that of the crashed production server.

Note Do not forget to change the Backup Group IP address as well.

10.

11.

12.

13.

14.

Change the netBIOS name of the server to that of the crashed production server.
Remove the original name from the domain and rejoin it in order to obtain a new SID.

Install Exchange 5.5 (remove it if previously installed). The binaries are in the
D:\Support\Exchange5.5 directory. Install Exchange according to the Design
Documents.

Create a new site, Org = xxx, SITE = xxxx or xxxxx. Do not join in a site.
Use the correct Exchange service account, EXSERVICE.

Run Performance Optimizer. (Locate all Log files to the E: drive and all others to the F:
drive.)

Once the server is up, use the Exchange Admin.exe and open the Server Properties
page.

Go to the DataBase Path tab and verify that the logs are on the E: drive, and all else is
on the F: drive.

You will notice that there are two other parameters, Directory Store Working Path and
Information Store Working Path. This is the location of the check-point files,

edb. chk. Make sure the location is D: \ exchsrvr\ dsadat a and

D: \ exchsrvr\ ndbdat a respectively. This is the default location.

Turn off (uncheck) Circular Logging from the Server properties, Advanced tab.

From Control Panel, Services, change all Exchange services, except for System
Attendant, to manual.
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15.

16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

Delete all files from the transaction log drive, E: \ exchsr vr\ ndbdat a. Stop all
services if still running.

Copy the transaction log files from the temporary location on a NT file server to the
appropriate directories on the E: drive of the hot-spare server.

After the successful copy, check the transaction log drive, E: drive and verify that the
same number and name of the logs files are present.

Perform a VERITAS Full Restore of the latest full backup, but do not delete existing
files.

Click on the Windows Start menu, point to Programs and VERITAS NetBackup, then
click on Backup, Archive, and Restore.

On the Actions menu, point to Select Restore Type and click Normal Backups.

Perform the restore procedure as documented in “Restoring Exchange Server” on
page 72.

After a complete Full Restore, check to see that all the files have been restored to their
proper locations.
Check the Restore In Progress key, found in:

HKEY LOCAL_MACHI NE\ Syst eml Curr ent Cont r ol Set\ Ser vi ces\ MSExchange
DS\ Rest or el nProgr ess

HKEY LOCAL_MACHI NE\ Syst eml Current Cont r ol Set\ Ser vi ces\ MSExchange
| S\ Rest or el nProgr ess

Confirm that the paths for the database and logs as indicated in the RestorelnProgress
key is exactly where the files must be restored to.

Launch Event Viewer, Applications Log.

Start Directory services and view Event Viewer. All logs should be played back and
service started.

Start Information Store. All logs should be played back.

Log into random mailboxes and confirm data has been updated to the time of the
crash.

29. Change services from manual to automatic.
B ———
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30. Check to see if the Information Store Working Path was changed from D:\ to E:\.. If so,
relocate it back to D:\ by using the Server Properties, Database Paths tab.

Ran out of disk space — Error -1808

If the Information Store does not start due to lack of disk space, an application event is
logged in the Windows NT Event Viewer. The source is EDB and the error test includes
theJet Blue error |ID -1808.

Confirm that the transaction logs are not being written to the same drive as the
information stores. If they are, relocate the transaction log drive to another drive that has
ample space. To change the location where the Information Store or Directory Store
Transaction logs are written, from the Exchange Admin program, click the Server object
properties page and choose the Database Paths tab. Change the path for the Information
Store and Directory Store transaction logs and click OK.

Pathnames for Transaction Logs

Data Path Name

Private Information Store Exchsrvr\ Mibdat a\ Pri v. edb
Public Information Store Exchsrvr\ Mibdat a\ Pub. edb
Directory Exchsrvr\ Dsadat a\ Di r. edb
Information Store Transaction Logs Exchsrvr\ Mibdat a\ *. | og
Directory Transaction Logs Exchsrvr\ Dsadat a\ *. | og

Recovering Space Used by Log Files

To recover space used by log files, perform a full or incremental online backup. This will
automatically delete the transaction logs.

Recovering Space on Drive F: Where the Exchange Server Store Is Located
Use the following procedure to recover Space on Drive F: Where the Exchange Server
Store Is Located

1. Determine if there is space on another drive where the Exchange Information Store or
the Directory can be relocated.

2. Run the Exchange Admin program, select the server, FILE, PROPERTIES, DATABASE
PATHS and select the object that will be moved.
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3. Indicate to which drive and directory the store is to be moved.

4. Click OK.

The service will stop and relocate the files, then restart.

5. Delete unnecessary files such as sample apps, games, client installs, readme files, etc.

Caution As a precaution, place a size limit on the mailboxes and run performance
monitor to continually monitor % Free Space and take appropriate steps when
free space reaches a set threshold.

Transaction Log Drive Crashes

1. Select another drive with ample disk space. Replace the hard drives, then relocate the
transaction logs back.

2. To change the location where the Information Store or Directory Store Transaction
logs are written, select the Server object properties page and choose the Database
Paths tab.

3. Change the path for the Information Store and Directory Store transaction logs and
click OK. Performance Optimizer can perform this function as well.

Memory, System Board, NIC, Array Controller Failure

Replace with identical configurations. Spare components should be purchased as hot
spares. If unavailable, the spare server’s components can be used. Be sure to replace those
borrowed parts immediately.

Drive Crashes After Creating New Mailboxes but Before a Backup Is
Performed

If the RAID5 array concurrently loses more than one drive, the entire subsystem fails. If a
backup is not performed prior to the disk crash, you cannot restore those mailboxes from
tape. However, by restoring from the previous day’s backup of the directory and
information stores, the mailboxes can be restored/recreated, since the directory and
information transaction log files are intact.

Caution When restoring the DS and IS, do not restore the log files and do not replace
existing log files. You will need these log files to recreate the mailboxes that
were previously created.

Chapter 6, Troubleshooting the Exchange Server 129 —d



Common Exchange Server Problems

Server Failure Scenarios - Information Store Problems

This section contains details for server failure scenarios involving Information Store
problems.

Information Store Corruption

The only way to determine if the information store is corrupted before it crashes and stops
the services is during the online backup. That is why the event viewer and backup logs
need to be reviewed on a daily basis. Refer to “Tape Backup Problems” on page 122.

ERROR -550

If the computer running Microsoft Exchange Server stops responding or was not shut
down gracefully after stopping all the services properly, the following error may be
displayed on screen and in the event logs:

Error -550 may be displayed on screen and in the event logs. The typical Event ID will
be Event | D 1005 and in the body of the event the - 550 error will be displayed and will
indicate which store has the problem: directory, private or public.

Cause

This error usually means that the database is in an inconsistent state and cannot start.
There may be several causes for this condition. The log file(s) could be damaged, thus
preventing transactions from being committed to the database or the database is
corrupted due to a bad page. Power loss or a server crash can cause an ERROR - 550.

Resolution
Before taking any remedial action, back up the affected file, di r . edb, pri v. edb or
pub. edb to a temporary directory on the server.
1. Confirm that the state of the database is inconsistent by running:

ESEUTIL /WH F:\exchsrvr\directory\file.edb > F:\tenp\edbdunp.txt
2. Replace\directory\fil e.edb witheither\ dsadat a\di r. edb,

\ ndbdat a\ pri v. edb or\ ndbdat a\ pub. edb, depending on what is displayed in
the Event ID error message.

3. Read the Edbdump.txt file and confirm what state the database is in. The file will
indicate whether St at e is consistent or inconsistent. (See Sample Edbdump.txt File.)

4. If the database state is inconsistent, run:
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ESEUTIL /R /IS

This is for recovery, not repair mode (/1S for information store, /DS for directory
store). This command will attempt to commit transactions, that were not done so
automatically, from the log files to the database.

5. If the service will not start:

- Move all files from Exchsr vr\ Dsadat a directory, except for di r . edb, or from
the \ Exchsr vr\ Mibdat a directory, except for pri v. edb, and pub. edb to a
temporary directory.

This causes the system to try to determine if the log files are corrupted. Try to
restart the services. The new log files will get recreated upon startup.

- Copy back the files that were moved to a temporary directory, then restore from
tape only the information store that is exhibiting the - 550 error.

Once the IS is restored, it will replay the log files.

- IfError -550isstill exhibited and the service does not start, the last recourse is to
repair the database by using ESEUTI L / P / <dat abase opti ons>.
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Sample Edbdump.txt File

M crosoft <R> W ndows NT<TM>
<C> Copyright 1985-1996 M crosoft Corp.

C.\>eseutil

/[ mh f:\exchsrver/ ndbdat a/ priv. edb >c:\edbdunp. t xt

C \>edit edbdunp.txt

C\>_

M cr osof t <R> Exchange Server

Version 5.5

Copyright <C M crosoft Corporation 1991-1997. All

Dat abase Utilities

Ri ghts Reserved.

Initiating FILE DUVMP node. ..

Dat abase: f:\exchsrvr\ndbdata\priv.edb
For mat ul Magi c: 0x89abcdef
Engi ne ul Magi c: 0x89abcdef
For mat ul Versi on: 0x620, 2
Engi ne ul Versi on: 0x620, 2

DB Si gnhature:

Create tine:4/21/1998 12:53:34 Rand: 67798 Computer:

dbti ne: 75997
St ate: Consi stent
Shadowed: Yes
Last Objid: 214
Repair Count: O

Last Consi stent:
Last Attach:
Last Detach:

(3,468, 470) 4/22/1998 12:1:21
(1, 6071, 445) 4/21/1998 13: 42: 48
(3,468, 470) 4/22/1998 12:1:21

ERROR -1201

The Information Store does not start due to an error message DuplicateDatabase. This
error means that when the store is started up it goes down to the registry to find the paths
tothe pri v. edb and pub. edb. Once it retrieves this information, it goes to that directory
and looks for the files. If it retrieves an invalid path or the registry is corrupt, it will
default to creating a new pri v. edb and pub. edb. When it tries to do this, the file system
does not allow it because these files actually do exist and, thus, the DuplicateDatabase
error is returned.

Cause

This points to the cause as being (1) registry corruption, (2) access problems to the registry
or (3) invalid paths in the registry. This error can be caused by power loss or a server
crash, similar to the ERROR -550.
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Resolution

Before taking any remedial action, back up the affected file, di r . edb, pri v. edb or
pub. edb to a temporary directory on the server. Attempt to restore the database from
tape first. Run eseut i | / p as the last resort.

Server Restoration Procedures

Server Restoration Procedures are covered in the following topics:
0O “Single Mailbox Restore” on page 133

0O “Full Server Restore (Exchange NT)” on page 135

0O “Full Server Restore (Exchange 2000)” on page 137

0O “Backup Tapes Are Unreadable or Non-Existent” on page 137

0O “How Many Tape Rotations Back to Find a Good Tape to Restore?”” on page 138
0O “Single Mailbox Restore” on page 133

Single Mailbox Restore

This feature is designed for when you need to restore a mailbox because it was
accidentally deleted or a user deleted a message and needs to recover it.

Note A user can recover any deleted items (mailbox or public folder) from the server for
up to three days without any administrator intervention. This new feature in
Exchange 5.5 is called the Deleted Item Recovery. Outlook client has a new feature
called Recover Deleted Items, which enables the user to recover any deleted items.
The messaging team has agreed to set the maximum days to keep deleted items to
three days.

The hot-spare server should already have been configured with Windows NT and
Exchange Server (Org and Site) to receive the restoration of the private information store.
If not, Windows NT Server needs to be installed and configured, the server name must be
unique (EXSP99, EXRC99), and it must join the SEGEXCHANGE NT domain.

Install the Exchange Server software and when prompted to Join an Existing Site or
Create a new Site, ensure that you choose the option to Create a New Site and name it
accordingly, Org:xxx and Site:xxxx or xxxx as in the production system. The server should
also be on the production network for ease of transferring the recovered PST file to the
target host. Also, install the Outlook client on this recovery server.
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Note The server name of the restore machine must be unique for the single mailbox

restore procedure. Also, the di r . edb will not be restored from tape, only the
priv. edb.

In the event that the di r . edb is restored, no replication will occur, since the spare server
will have a different server name than the server from which the tape is being restored.
The worse case if this happens is the di r . edb will sense that the server name and the
Exchange server name from the di r . edb is different and the DS service will not start.

Caution As an ultimate precaution to prevent unwanted directory replication,

administrators can unhook the cabling linking the restore server to the network
until the restore is complete and the mailbox is recovered.

Restore the Information Store from Tape

1.

Restore the private information store to the server. (Include the pri v. edb, patch files
and transaction logs)

Click Erase all existing data.

After the restore, start the DS and IS services and then perform the DS/IS Consistency
Adjustment.

Recover User Mailbox

Log onto the recovery server as the Windows NT Administrator.

Open the Microsoft Exchange Administrator.

Select the recipient’s container and double-click on the desired user’s mailbox name.
On the General tab, click Primary Windows NT Account.

Select Select an Existing Windows Account.

Click OK.

In the Add User or Group screen, select Administrator.

Click Add, then OK.

On the User Property screen, click OK.
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10. Configure a profile for the desired user.

11. Add a Personal folder file to the profile.

12. On the recovery server, run the Microsoft Outlook client.
13. In the left panel, highlight Mailbox - USERNAME.

14. Select the first folder or item in the list on the right panel.
15. From the pull-down menu, select EDIT, SELECT ALL.
16. From the pull-down menu, select FILE, COPY.

17. Inthe Copy screen, highlight the PERSONAL FOLDER and click OK. All data will be
copied to this PST file.

18. Copy the PST file to the destination location. This can be done via tape backup and
restore if necessary.

19. Add this PST to the user’s profile on the production server and send the PST to the
end-user with instructions. You may need to send this on a tape. If you have network
access, you might copy this recovered PST to the desired server.

Full Server Restore (Exchange NT)

This section describes what is necessary to perform a full server recovery of Exchange NT.

Using the Hot Spare Server

Assuming the entire server is not operational, the preconfigured hot server must be
implemented. Replace the downed server with the hot-spare. Use the original server’s IP
address and the original server’s netbios name and rejoin the SEGEXCHANGE NT
domain but only after a new SID is created. To create a new SID, remove the old server
name from Server Manager. Re-joining the domain from the hot-spare, which is using the
original server’s name, will create a new SID.

In the case of full server recovery, keep installation code on the recovery server (i.e.
D:\support).

Note Refer to the Server Configuration sheet that was prepared for the original server to
replicate all configurations.
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v

Install Exchange Server

1. Install Microsoft Exchange Server on the hot-spare server and create a new site.

Caution Do not attempt to join an existing site. Give the server its original organization
and site name (Org:xxX, Site:XXXXX Or XXXXX).

2. Run through Performance Optimizer and select the appropriate locations for the files.

3. Check the working Path for the directory and Information stores via the database path
property page on the server object that it is set for the D: drive.

4. Install Microsoft Outlook Client on the recovery server.

5. Perform a Full Restore, which will include the Directory, Information Store and
transaction logs/patch files from the latest tape backup.

Note Be sure to erase all existing data.

6. Start all Exchange services (System Attendant first, then the Directory, IS, MTA and
Event Services) and review the Event Viewer for any errors.

7. RunaDS/IS Consistency Adjustment (from the Server properties, choose Advanced).

8. To verify that your users’ mailboxes have a Windows NT account associated with
them, follow these steps.

a. Inthe Microsoft Exchange Administrator program, select a server, and choose
Recipients.

b. Double-click a user’s name.

c. Review the Primary Windows NT Account box to verify that the Windows NT
account matches the mailbox. Repeat this procedure as needed for each user.

Testing a User's Logon from a Client Workstation

To test a user’s logon from a Microsoft Outlook Client workstation, perform these steps.
1. Start the Microsoft Outlook Client.
2. \Verify that the user’s password is accepted.

3. Confirm that the data has been restored.
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Full Server Restore (Exchange 2000)

This section describes what is necessary to perform a full server recovery of Exchange
2000.

Requirements
The following are required before an Exchange 2000 restoration can be performed:

O If the Exchange 2000 server you are restoring is a member server in a domain, the
Active Directory must be running. If Active Directory does not exist, you must restore
it before restoring Exchange 2000.

O If the Exchange 2000 server you are restoring is a domain controller, you must restore
Active Directory on the machine before you can restore Exchange 2000.

Steps

For detailed information about Exchange 2000 disaster recovery, refer to the Microsoft
Exchange 2000 Database recovery white paper at http://www.microsoft.com/exchange.

1. Install Windows 2000 on the new or repaired server.
2. Restore the IIS Metabase.

3. Restore Exchange 2000.

4. Restore the Information Stores.

5. Ifyou have KMS or SRS, these have to be restored independently of an Exchange 2000
server restore.

6. If you have KMS, restore the Certificate of Authority. The CA can be restored from a
backup of the system_state of the server.

Backup Tapes Are Unreadable or Non-Existent

Cannot Restore From Tape, None Available

There are no valid tapes available. The only alternative is to repair the existing database.
Perform an offline backup to tape or to a temporary directory.

To repair the information store, run ESEUTI L /P F:\ exchsrvr\ ndbdat a\ pri v. edb.
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How Many Tape Rotations Back to Find a Good Tape to Restore?

Previous day’s backup vs. ESEUTIL /P

This scenario depicts a situation where either the backup tape media is damaged or the
data is unreadable and due to a disaster the database (pri v, pub or di r . edb) needs to be
restored with the most current data immediately.

If you restore the previous day’s backup, the log files for the current day will play back
and bring the store up to date. However, if the tape is bad from the previous day, should a
tape be used from two days ago or should ESEUTIL /P be used to repair the current
database be implemented? This is the immediate question that needs to be answered. The
trade-offs are the time it takes to perform an ESEUTIL /p for repair.

Going back two days to find a good tape is a solution. However, the information store will
only contain the current day’s transactions due to the existing log files, and messages from
two days ago. No messages will be available from the previous day. For example, if the
store became corrupted on Wednesday afternoon, Tuesday’s backup would be used for
restoration but if that tape was bad Monday’s tape would be used.

If Monday'’s tape was good and was restored, the current transaction logs for Wednesday,
which contain logs from the time a full online backup was performed to the time the store
stopped, would be rolled into the Monday database. The result would be a database
missing Tuesday’s transactions. Essentially, Tuesday’s messages would be lost.

The alternative is to repair the Wednesday database by using ESEUTIL /P, as follows:

1. Ifthe private store was affected, back up the pri v. edb to a temporary directory. The
IS service must be stopped in order to do this.

2. Run\w nnt\systenB2\ESEUTIL /P F:\exchsrvr\ndbdata\ priv.edb
from the \mdbdata directory.

3. After it completes, run
ESEUTIL /MH F:\exchsrvr\ndbdat a\priv.edb d:\esedunp.txt.

4. Edit the ESEDUMP.TXT file and confirm that the state of the database is consistent.
5. [Ifitis not consistent, re-run ESEUTI L until it is consistent.

6. Run | SINTEG -pri -test alltests (refertothe Appendix for details on
ISINTEG switches)

7. After this completes, run ISI NTEG —pat ch, then start the service.

8. RunDS/|S Consi stency Adjustnent.
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9. Test access to mailboxes.

Administrative Errors

Refer to the following topics for details on resolving administrative errors:

Authoritative Restore

Due to an administrative error, a considerable number of mailboxes or configuration data
was deleted. What do you do?

Once mailboxes or configuration data is deleted from Exchange, the directory replication
process occurs quickly and all the servers in the organization update their directories to
reflect this change. To restore the deleted mailboxes is not a problem but to restore the
directory information for the mailboxes is. Authoritative Restore tool (Authrest.exe)
allows you to force a restored directory database to replicate to other servers after
restoring from a backup. You can receive assistance using this tool from Microsoft Product
Support Services.

Normally, a restored database is assumed to be more out-of-date than the collective
information held on all the other directory replicas in the organization. A restored
directory would normally replace its own in formation with the more recent data held by
other servers. This functionality is correct when the reason for the restore is that a
database or server was destroyed, but it is not correct in all cases. For example, if an
administrative error deleted thousands of mailboxes or vital configuration information,
the goal of restoring from backup is not to restore one server to functionality, but to move
the entire system back to before the undesired changes were made.

Without Authoritative Restore, you would need to restore every server in the organization
from a backup that predates the error or restore every server in the site, and then force all
bridgeheads in other sites to resynthesize from scratch. If only one server were restored, or
if servers were restored one at a time, the restored server would quickly overwrite its
restored data with the more recent (incorrect) information held by all other servers in the
site.

Using the Authoritative Restore tool, object versions and USNs can be advanced on all
writable objects held by that directory so that the data held on the backup appears to be
more recent than any copy held by other servers. Normal replication, therefore, causes the
restored information to spread to all servers throughout the organization. This tool allows
you to restore one server (presumably the one server with the most recent premistake
backup) rather than all servers.

If Authres is not used, the restored mailboxes are automatically deleted.
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Installing Authoritative Restore

Copy Aut hr est . exe from the Support\util s\ pl at f or mdirectory of the Microsoft
Exchange Server CD-ROM to the Exchsr vr\ bi n directory of the Microsoft Exchange
Server computer that has had its directory restored.

Using Authoritative Restore

Run Authoritative Restore from a command prompt. You can specify two parameters on
the command line. The first is the object version increment and the second is the USN
increment. These numbers specify how many versions ahead to increment the version
numbers of objects in the directory so that they appear to be later versions than the objects
in other replicas of the directory in your organization. A reasonable number to enter for
both of these parameters is 1000.

After running the Authoritative Restore tool, restart the directory. Its objects replicate to
the rest of your organization, superseding objects in the other replicas.
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Recommendations

The following are recommendations for optimal performance.

Use Hardware RAID5 and Mirroring

Use hardware RAIDS5 so that a disk drive failure can be remedied real-time by plugging in
a replacement drive. System partitions should be mirrored or RAID5 for redundancy.

Enable Write-Back Cache on the Controller

Leave write-back cache on hard disk array controllers enabled if the controller has ECC
memory and battery backup. If the controller has no battery backup, disable the cache.
Hard drives that have caching enabled must be disabled regardless of the cache status of
the controller.

Perform Online Backups Using Software That Uses Exchange
APls

Perform online backups using VERITAS NetBackup with Exchange Extensions. The
online backup using the Exchange Agents will read every 4K page from the database as it
is being backed up, thus ensuring the integrity of the database.

Locate Transaction Log Files on Separate Dedicated Physical
Disk

This is the single most important aspect of Microsoft Exchange-based server performance.
However, there are recovery implications as well. Transaction logs provide an additional
mechanism for recovery. For optimal redundancy, mirror (Raidl) the transaction log
drive.

Disable Circular Logging

While Circular Logging can help conserve disk space, the drawbacks are (1) Incremental
and Differential Backups are disabled and (2) transaction log history is cyclical and cannot
be played back. Implementing a full online daily backup strategy, transaction log files will
be purged on a regular basis thus freeing up disk space.
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Dedicate Spare Recovery Servers, Replacement Server
Components and Build a Recovery Lab

It is important to have a server dedicated for emergencies. This hot-spare must be equal to
or greater than its configuration to the largest production server. It must have a dedicated
tape drive identical to those in production. This server will be used for single mailbox
restores, full server recovery, testing of tape backup integrity and simulated fire drills for
server restorations. This server will also be used for testing of new upgrades,
configurations, service packs and hot fixes.

Don’t fall into the trap of allowing test equipment to become production equipment
without replacement. Make sure that the recovery equipment is always in working order
and available at a moments notice. What tends to happen is that companies purchase
recovery equipment, install some test only software and then become dependent on this
equipment for production use. In short, keep recovery equipment in a dedicated mode.

Note that up to 2X the disk space of the largest production server Information Store
database is required for recovery and database defragmenting using the ESEUTIL utility.
It is more cost-effective for an organization to maintain one recovery server with sufficient
disk space.

Create and Verify Daily Backups

This is a very critical step in disaster recovery. It sounds simplistic but you can only
recover data if you have a valid backup. It is often assumed that backup tapes are being
swapped and that data is being properly backed up. It should be a daily routine to review
all back up logs and to follow up on any errors or inconsistencies. Furthermore, full
(normal) backups reset and remove transaction logs. This results in free disk space (this is
less of an issue if circular logging is enabled). If circular logging is not enabled and daily
full backups are failing, transaction logs will not be purged and can fill up the entire
transaction log disk drive. Failure to verify backups is one of the most common mistakes
made.

Perform Periodic File-Based Backup

To capture all configuration data, it is best to perform a full file-based backup periodically.
Services should be shut down so that open files can be backed up. Shutting down sevices
will ensure that you have backed up all possible Microsoft Exchange-related files. This
might be performed during the scheduled maintenance window. Note that file-based
backup is not required for backing up the Information Store and Directory databases.
Online backups are recommended for backing up the Information Store and Directory.
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Standardize Tape Backup Formats

Recovery equipment must be compatible with production tape equipment. If you deploy
a new type of tape drive, make sure that you equip recovery equipment with a compatible
model. You should also test reading and restoring production tape backups on the tape
drive used for recovery.

Deploy a UPS and Test It Periodically

Don’t take the approach that if the Microsoft Exchange-based server goes due to a power
outage, all other servers will go, too. Make sure that you are UPS protected. Many
computer rooms are supposedly UPS protected. Even though this may be the case, it is
very possible that not all outlets are UPS protected. Also note that server class UPS system
batteries can wear out every 3 years or so and require replacement.

Perform Periodic Fire Drills

The purpose of performing periodic fire drills is to measure your ability to recover from a
disaster and to certify your disaster recovery plans. Conduct these drills in a test
environment and simply attempt a complete recovery. Be sure to use data from
production backups. During this process, it is best to record the time it takes to recover.
This information will assist you in determining time to recovery in a real disaster recovery
situation. Performing these drills will be the most valuable experience that you will have
in your disaster recovery planning.

Check Windows NT Event Logs Daily

It is best to take a proactive approach and review logs regularly. This can help you identify
problems before they have an impact. Extensive logging is available in Microsoft
Exchange and this should be leveraged. Logging tools such as Evtscan.exe, that will
monitor for specific events and send notifications, are available on the Microsoft Exchange
Server Technical Resource CD-ROM.

Create a Disaster Recovery Kit

Planning ahead will reduce the time to recovery. It is critical to build a kit that includes
items such as the following:

0O operating system configuration sheet
O hard drive partition configuration sheet

0O RAID configuration
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hardware configuration sheet
configuration disks
Microsoft Exchange configuration sheet

Windows NT emergency repair diskette

o o o o o

Microsoft Exchange Performance Optimizer settings sheet

The goal is to minimize the time to recovery. In order to account for configuration
changes, this information should be reviewed and updated on a monthly or quarterly
basis.

Publish a Microsoft Exchange Maintenance Window

Unlike mainframes, servers often get overlooked when it comes to scheduling downtime
for maintenance. It is a simple formula: planned maintenance generally reduces
unplanned downtime. It is important, however, to set user expectation levels by
publishing a maintenance window especially when users expect 7x24 service.
Maintenance is inevitable since the nature of the data processing business includes service
pack updates, software upgrades, and hardware upgrades.

Maintain Off-Site Tapes

Send tapes off-site to a secure location in the event of a disaster at the local site. Ensure
quick retrieval of these tapes in event that an emergency restore is required.

Keep Solid Records of All Configuration Done to the
Production Server

This will be necessary when configuring the recovery server. Records include Windows
NT tuning settings, path information, protocol addresses, Microsoft Exchange connector
configuration, etc. These records should be part of the disaster recovery kit discussed
above.
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Take a Proactive Approach to Monitoring the Information Store

Monitor the growth of the Information Store and server performance and be prepared
with a plan to remedy these issues. Windows NT disk space alerts can be set up as well to
monitor remaining disk space. Performance Monitor objects exist for the Information
Store and should be used.

Exchange Server Problem Summary

Problem

Symptom

Cause

Remedial Action

Comments

Error =529, IS or DS
Services stop

IS or DS service
stops and do not
restart

Drive where the
transaction logs are
being written to is
full.

JET_errLogDiskFull

Relocate transaction
log location to
another drive.

Remove logs

Enable circular
logging to remove
logs except for the
four latest.

Refer to the section
on “Ran out of disk
space, Error -1808”

Error =530, IS or DS
Services stop

IS or DS service
stops and do not
restart

Log file(s) and/or
database is possibly
corrupt.

JET_errBadLogSign
ature

Relocate transaction
logs and edb. chk
to a temporary
directory, then
restart services.

Refer to the section
on “Information
Store Corruption,
Error -550”

Error =550, IS or DS
Services stop

IS or DS service
stops and do not
restart

Log file(s) and/or
database is possibly
corrupt.

JET_errDatabaselnc
onsistent

Relocate transaction
logs and edb. chk
to a temporary
directory, then
restart services.

Refer to the section
on “Information
Store Corruption,
Error -550”

Online tape backup | Event Viewer A page or pages in | Restore database Refer to the section
does not complete displays ID 23, the database have from previous good | on “Tape Backup
successfully. source EDB, become corrupted tape backup and test | Problems”.

Description: and the tape backup | accounts and

MSMiicrosoft could not read it. mailboxes.

ExchangelS

corrupted page .

error —1018. Backup JI_ET_errReadVerlfyF

log indicates backup ailure

failed.
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Exchange Server Problem Summary

Problem

Symptom

Cause

Remedial Action

Comments

Error-1201, ISor DS
Services do not start

IS or DS service
stops and do not
restart

Store cannot find
correct path to
database. Possible
corrupted registry
or access problems
to the registry or
invalid paths in the
registry.

JET_errDatabaseDu
plicate

Copy affected
database to a
temporary directory
as a backup. Restore
from tape, run
eseutil /d /ras a
last resort.

Refer to the section
on “Information
Store Corruption,
Error -1201”

Error-1206, IS or DS
Services stop

IS or DS service
stops and do not
restart

Log file(s) and/or
database is possibly
corrupt.

JET_errBadLogSign
ature

Relocate transaction
logs and edb. chk
to a temporary
directory, then
restart services.

Refer to the section
on “Information
Store Corruption,
Error -550”

Error-1808, IS or DS
Services stop

IS or DS service
stops and do not
restart

Drive where the
information store(s)
are located are full.
No disk space
available.

JET_errDiskFull

Relocate transaction
log location to
another drive if it is
sharing the same
drive as the IS or
DS.

Remove logs

Enable circular
logging to remove
logs except for the
four latest.

Relocate the IS or DS
location via the
Exchange Admin
program or use
Performance
Optimizer.

Refer to the section
on “Ran out of disk
space, Error -1808”
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Exchange Server Problem Summary

Problem

Symptom

Cause

Remedial Action

Comments

RAID5 Array fails,
drives crash

Server does not
start, services
stopped, drive lights
indicate drives
inoperative

Hardware failure
either controller
and/or disk drives.

Replace controller.
Replace entire array
from the spare
server or completely
replace server with
hot spare and
perform a full serer
restore.

Transaction log
drive crashes, may
get Error =529 in the

Event Viewer

IS and DS services
stop and do not
restart.

Hardware failure

Relocate the IS and
DS log location via
the Exchange
Admin program or
use Performance
Optimizer.

Replace drive(s)

Refer to the section
on “Transaction Log
Drive Crashes”.

Replace Transaction
Log hard drives

Server does not boot

Server does not boot

Hardware problems

Inform NT server

Hardware problems

engineers with possible NT
Server issues to
follow.
Server boots but Incomplete NT boot | Damaged NT Inform NT Server May have to
does not completely | sequence. configuration or engineers reinstall NT or
boot to NT. missing files. restore

configuration.

Other hardware
related errors such
as memory, NIC,
system board, etc.

Hardware related
errors displayed
upon bootup.

Hardware failure or
misconfiguration.

Inform NT Server
engineers
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ESEUTIL and ISINTEG Line Switches A

This appendix provides detailed information on the ESEUTIL and ISINTEG command
line switches.
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ESEUTIL

Note Call PSS before using this tool.

ESEUTIL is a multifunctional database utility for the Microsoft Exchange Server
information store and directory. Unlike ISINTEG, which is sensitive to the use and content
of data in the information store, ESEUTIL operates at the level of the architecture,
scanning for unreadable records in messaging databases with no knowledge of their
application. It can be used on Microsoft Exchange Server directory service and
information store.

ESEUTIL is in \WINNT\SYSTEM32. It is run from the Windows NT Server command
line. The database service must be stopped for the utility to run. It runs on one database at
atime.

Most often you will use ESEUTIL in consultation with Microsoft Product Support, but you
can use several of its functions.

Defragmentation = Compacts, defragments, and reduces the size of the database.
Performs offline compaction of database.

Upgrade Upgrades the database architecture if it is incompatible with the
current version of Microsoft Exchange Server. This is intended
for future use and is to be used only at the advice of a Microsoft
Product Support Specialist.

Integrity Scans the database for unreadable records and eliminates them,
restoring database functions. Does not repair any errors it finds.

Recovery Commits entries in the transaction log files to an offline
database. It is to be used only at the advice of a Microsoft
Product Support Specialist. Brings all databases to a consistent
state.

File Dump Writes the database header record or checkpoint file to a file.
This is to be used only at the advice of a Microsoft Product
Support Specialist.

Defragmentation  Repairs a damaged or corrupted database.
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Defragmenting a Database

The ESEUTIL defragmentation utility makes used storage contiguous, eliminates unused
storage, compacts the database, and reduces its size. It can be run on the directory or
information store.

The amount of free disk space needed to defragment a database (Eseutil /d) is 110 percent
of the size of the file being defragmented.

When you repair a database (Eseutil /p), the amount of free disk space required depends
on the number of corrupt pages in the database. This is different from how the older
Edbutil.exe program repaired databases. Normally, 25 percent of the file being repaired is
a conservative estimate of the amount of free disk space required.

ESEUTIL copies database records to a new database. When the defragmention is
complete, the original database is deleted or saved elsewhere and the new version
renamed as the original. In normal mode, if it encounters a bad record, the utility stops
and displays an error. However, in repair mode, bad records are not copied to the new
version of the database and the utility is not interrupted.

Caution ESEUTIL defragmentation with repair eliminates unreadable data from the
database. Some of this data may be required for the operation of the service and
may not be recoverable. It may take 30 minutes to an hour per gigabyte to
complete. If it concludes with an error message, consult Microsoft Product
Support for assistance

Note ESEUTIL requires disk space equal to twice the size of the database being
processed.

1. Stop the information store or directory.

2. At the command prompt, type eseut i | /d, a database switch, and any desired
options.
For example:
C:\ W NNT\ SYSTEMB2> eseutil /d /ds /t c:\dbback

runs the standard defragmentation utility on the directory service and saves the copy
in the user-defined file.

C.\ W NNT\ SYSTEMB2> eseutil /d /ispriv

runs the defragmentation utility on the private information store and discards the

original.
B R R ————
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Select a database switch to run ESEUTIL on that database. ESEUTIL runs on one database
at a time.

/ds Directory
/ispriv Private information store
/ispub Public information store

Select one or more options to determine the disposition of the old and new copies of the
database.

/b pathname Makes a backup copy of the original uncompacted database at the
specified location

/p Retains the old uncompacted database in its original location and stores
the new compacted database in the default file,
\EXCHSRVR\BIN\TEMPDFRG.EDB

/tfilename  Renames the new compacted database as specified in filename

Checking Database Integrity

The ESEUTIL integrity checker is a read-only utility that searches the database for
damaged or unreadable records and reports its results to the console. It verifies the
integrity of the database but does not repair any errors it finds. Checking database
integrity (Eseutil /g) is an in-place operation and does not require any additional free disk
space.

In the case of the defrag or repair operations, the /7t command line switch should be used
to specify the location of a temporary file. This should be located on a drive that has the
required free disk space. This can be a local or a network drive.

To save the displayed messages to a file, use the standard MS-DOS redirection convention,
> filename.
1. Stop the information store or directory.
2. At the command prompt, type eseut i | /g followed by a database switch and any
desired options and press Enter.
For example:
C. \ W NNT\ SYSTEMB2> eseutil/g /ispub
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runs the integrity check on the public information store of the server.

/ds Directory (DO NOT ATTEMPT TO USE THIS - CALL PSS)
/ispriv  Private information store

/ispub  Public information store

The following information applies to Microsoft Exchange Server 5.5 Utility)

DESCRIPTION: Maintenance utilities for Microsoft® Exchange Server databases.

MODES OF OPERATION:

Defragmentation: ESEUTIL /d database name [options]
Recovery: ESEUTIL /r [options]

Integrity: ESEUTIL /g database name [options]

Upgrade: ESEUTIL /u database name /dprevious .DLL [options]
File Dump: ESEUTIL /m[mode-modifier] filename

o o o o o g

Repair: ESEUTIL /p database name [options]

DEFRAGMENTATION/COMPACTION: (D)
DESCRIPTION: Performs offline compaction of a database.
SYNTAX: ESEUTIL /d database name [options]

PARAMETERS: database name - filename of database to compact, or one of Zispriv, Zispub,
or /ds (see NOTES below)

OPTIONS: zero or more of the following switches, separated by a space:
/lpath - location of log files (default: current directory)
/spath - location of system files (e.g., checkpoint file)
(default: current directory)
/bdb - make backup copy under the specified hame
/tdb - set temporary database name (default: TEMPDFRG. EDB)

/p - preserve temporary database (i.e., don't instate)
/0 - suppress logo
NOTES:
————
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0O The switches Zispriv, Zispub, and /ds use the Registry to automatically set the
database name, log file path, and system file path for the appropriate Microsoft
Exchange store

0O Before defragmentation begins, soft recovery is always performed to ensure the
database is in a consistent state.

O If instating is disabled (i.e., /p), the original database is preserved uncompacted, and
the temporary database will contain the defragmented version of the database.

RECOVERY: (R)
DESCRIPTION: Performs recovery, bringing all databases to a consistent state.
SYNTAX: ESEUTIL /r [options]
OPTIONS: zero or more of the following switches, separated by a space:
/is or /ds - see NOTES below
/lpath - location of log files
(default: current directory)
/spath - location of system files (e.g., checkpoint file)
(default: current directory)
/0 -suppress logo
NOTES:

O The special switches Zis and /ds use the Registry to automatically set the log file path
and stem file path for recovery of the appropriate Microsoft Exchange stores.

INTEGRITY: (G)
DESCRIPTION: Verifies integrity of a database.
SYNTAX: ESEUTIL /g database name [options]

PARAMETERS: database name - filename of database to verify, or one of Zispriv, Zispub, or
/ds (see NOTES below)

OPTIONS: zero or more of the following switches, separated by a space:
/tdb- set temp database name (default: INTEG.EDB)

/v -verbose
/x - give detailed error messages
/0  -suppress logo

NOTES:
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0O The consistency-checker performs no recovery and always assumes that the database
is in a consistent state, returning an error if this is not the case.

0O The special switches Zispriv, Zispub, and /ds use the Registry to automatically set the
database name for the appropriate Microsoft Exchange store.

UPGRADE: (U)

DESCRIPTION: Upgrades a database (created using a previous release of Microsoft®
Exchange Server) to the current version.

SYNTAX: ESEUTIL Zu database name Zdprevious .DLL [options]

PARAMETERS: database name - filename of the database to upgrade. /Zdprevious .DLL -
path filename of the .DLL that came with the release of Microsoft® Exchange Server from
which you're upgrading.

OPTIONS: zero or more of the following switches, separated by a space:
/hdb - make backup copy under the specified name
/tdb - set temporary database name (default: TEMPUPGD.EDB)
/p - preserve temporary database (i.e., don't instate)
/0 -suppress logo
NOTES:

O This utility should only be used to upgrade a database after an internal database
format change has taken place. If necessary, this will usually only coincide with the
release of a major, new revision of Microsoft® Exchange Server.

O Before upgrading, the database should be in a consistent state. An error will be
returned if otherwise.

O Ifinstating is disabled (i.e., /p), the original database is preserved unchanged, and the
temporary database will contain the upgraded version of the database.

FILE DUMP: (M)
DESCRIPTION: Generates formatted output of various database file types.
SYNTAX: ESEUTIL /m[mode-modifier] filename

PARAMETERS: [mode-modifier] - an optional letter designating the type of file dump to
perform. Valid values are:

h - dump database header (default)

k - dump checkpoint file filename - name of file to dump.
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The type of the specified file should match the dump type being requested (e.g., if
using /mh, then filename must be the name of a database).

REPAIR: (P)
DESCRIPTION: Repairs a corrupted or damaged database.
SYNTAX: ESEUTIL /p v [options]

PARAMETERS: database name - filename of database to compact, or one of Zispriv, Zispub,
or /ds (see NOTES below)

OPTIONS: zero or more of the following switches, separated by space:
/tdb - set temp database name (default: REPAIR.EDB)
/d- don't repair the database, just scan for errors
/v- verbose output
/Xx- give detailed error messages
/0- suppress logo
NOTES:

O The switches Zispriv, Zispub, and /ds use the registry to automatically set the
Database name for the appropriate Exchange store.

O Recovery will not be run.

Output of ESEUTIL /d /ispriv

M crosoft <R> Exchange Server Database Uilities
Version 5.5
Copyright <C M crosoft Corporation 1991-1997. Al Rights Reserved.

Initiati ng DEFRAGVENTATI ON node. . .
Dat abase: F:\exchsrvr\ NDBDATA\ PRI V. EDB
Log files: e:\exchsrvr\ MDBDATA
System files: d:\exchsrvr\ MDBDATA
Tenp. Dat abase: TEMPDFRG. EDB

Defragnentation Status ( %conplete )

Not e:
It is recommeded that you imediately performa full backup
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of this database. If you restore a backup made before the
defragnentati on, the database will be rolled back to the state
it was in at the tinme of that backup.

Qperation conmpl eted successfully in 5.156 seconds.

C\>

Output of ESEUTIL /r /ds

M crosofta(R) W ndows NT(TM
(C) Copyright 1985-1996 M crosoft Corp.

C \>eseutil /r /ds

M crosoft (R) Exchange Server Database Utilities
Version 5.5
Copyright (C) Mcrosoft Corporation 1991-1997. Al Rights Reserved.

Initiati ng RECOVERY node. . .
Log files: e:\exchsrvr\DSADATA
System files: d:\exchsrvr\ DSADATA

Perform ng soft recovery...

Operation conpl eted successfully in 1.594 seconds.

C\>_

Output of ESEUTIL /g /ispriv

C \>eseutil /g /ispriv

M crosoft (R) Exchange Server Database Utilities
Version 5.5
Copyright (C) Mcrosoft Corporation 1991-1997. Al Rights Reserved.

Initiating | NTEGRITY node. ..
Dat abase: F:\exchsrvr\ MDBDATA\ PRI V. EDB
Tenp. Dat abase: | NTEG EDB

checki ng dat abase integrity

Scanning Status ( % conplete )
0 10 20 30 40 50 60 70 80 90 100
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integrity check conpl eted.
QOperation conmpl eted successfully in 2.922 seconds.

C\>

ISINTEG

Note Call PSS before using this tool.

The Information Store Integrity Checker (ISINTEG) utility finds and eliminates errors
from the Microsoft Exchange Server public and private information store databases. These
errors can prevent the information store from starting or prevent users from logging on
and receiving, opening, or deleting mail. ISINTEG is not intended for use as a part of
normal information store maintenance. Its purpose is to assist you in situations where the
database has become damaged.

Installing ISINTEG

ISINTEG is located in the Exchsr vr\ Bi n directory of the Microsoft Exchange Server
compact disc. You can run it from the Windows NT Server command line.

Using ISINTEG

ISINTEG has two main functions:

O Itcan test, and optionally, fix errors in the information store. When run in Patch mode,
ISINTEG repairs information stores that will not start after being restored from an
offline backup.

O It can patch the information store after a restore from an offline backup.

In Test mode, ISINTEG searches the information store databases for table errors, incorrect
reference counts, and unreferenced objects. During this operation, ISINTEG displays the
results and also writes them to a log file.

The Fix option in the Test mode should be used only with the advice of Microsoft
Technical Support. In Test and Fix modes, ISINTEG tests the information store database
and corrects any errors it finds. It is recommended that you back up the information store
before you run this utility to fix errors in the database.
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Testing and Fixing Information Store Integrity

ISINTEG validates the referential integrity of the information store database by scanning
it and examining all references. The utility creates a temporary database to store the
reference counts. At the end of the process, the reference counts collected in the temporary
database are compared with those in the information store database. If errors exist, and if
you have selected the -fix option ISINTEG corrects the problem. By default, the temporary
database is created in the same directory as the existing database. But you can specify
different a directory for the location of the temporary database.

In either case, the temporary database is removed upon completion of the test. When run
in Test mode, ISINTEG must be run separately on the public and private information
stores.

By default, ISINTEG errors are displayed on your screen as well as being saved in a log
file. It is recommended that you save the log file created by ISINTEG in case you require
the assistance of Microsoft Technical Support to solve any of the problems.

The -fix option instructs ISINTEG to repair any errors it finds. Details of all repairs are
recorded in a log file. If a log file name is not specified, the results are written to either

i sinteg.pri orisinteg. pub,depending on whether you choose the private or public
information store for testing.

Note The -fix option should be used only on the advice of Microsoft Technical Support.

Running ISINTEG in Test Mode

Note To run ISINTEG in Test mode, you must first stop the information store service if it
is running.

1. Open the Services application in Control Panel.
2. Select the Microsoft Exchange Information Store service, and click Stop.
3. Atacommand prompt, switch to the Exchsr vr\ Bi n directory.

4. Enter the following command:
isinteg -test options

where options is one or more of the command-line options listed in the following table.

-? Displays the list of options. Does not run the utility.
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-pri Tests the private information store.
-pub Tests the public information store.
-fix Tests and corrects errors in the specified information store. This

option should be used only with the advice of Microsoft
Technical Support.

-detailed Performs additional tests beyond what is normally covered in
the default test mode.

-verbose Reports the details of all testing activity.

-1 filename Specifies the name of the log file. The default name is Isinteg.pri
or Isinteg.pub.

-t RefDbLocation  Specifies the location of the temporary reference database that
ISINTEG constructs while it is running. If you specify the
location for the temporary database on a different disk than the
one on which the information store database is stored you can
improve the tool’s performance.

-test testnamel,  Specifies the specific test(s) to perform.

testname? ... Specific testname parameters are covered in the following table.

ISINTEG can take a long time to run on large information stores
because of the intensive nature of the referential integrity
checking operation.

Rather than running the entire set of tests, it is strongly
recommended that you select tests based upon the specific
problem you encounter (as recommended by Microsoft
Technical Support). This reduces the amount of time ISINTEG
takes to run.

Tip Ifyou are performing multiple tests, indicate all the test names, separated by
commas, e.g.:
isinteg -pri -test fol der, nessage

Tip  If you wish to perform all the tests, use the following command;
isinteg -pri -test alltests
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ISINTEG Tests
Each of the ISINTEG tests are described in the following table.

ISINTEG Tests

Test Name Description Test Length Depends On
aclitemref Verifies reference counts for access control list Number of folders in the information
items. store and the number of members of

each access control list.

acllist Examines folders and validates access control lists. Number of folders in the information
store.

acllistref Verifies the access control list reference counts. Number of folders in the information
store.

allacltests Combines the acllist, acllistref, and aclitemref tests. (See description for each subtest).

allfoldertests Combines the folder, fldsub, and search tests. (See description for each subtest).

alltests Combines ALL of the tests indicated in this table

artidx (public store Tests the consistency of the NNTP article index. Number of NNTP messages and

only) folders.

attach Validates properties for all attachments. Number of attachments in the

information store.

attachref Validates attachment reference counts. Number of messages and attachments
in the information store.

deleteextracolumn Deletes all cached indexes and some extra Number of folders in the information

S columns. store.

delfld Examines deleted folders, validates properties,and Number of deleted folders and number
accumulates reference counts. of messages in each folder.

dumpsterref Combines the msgref and msgsoftref tests. Also (See description for msgref and

checks the item count of recoverable items and the msgsoftref.)
size of the recoverable items available for Deleted
Item Recovery.

dumpsterprops Runs the dumpsterref test and validates the (See description for dumpsterref.)
presence of some required columns in the folder
table.
B R R ————
Appendix A, ESEUTIL and ISINTEG Line Switches 161 ~



ISINTEG

ISINTEG Tests

fldrcv (private
store only)

fldsub

folder

mailbox (private

store only)

message

morefld

msgref

msgsoftref

namedprop
newsfeed (public
store only)

newsfeedref
(public store only)

oofhist (private

Validates counts of special system folders,
including Restrictions, Categorization, Inbox,
Outbox, SentMail, Deleted Items, Finder, Views,
Common Views, Schedule, and ShortCuts.

Validates the number of child folders and number
of recoverable child folders available for Deleted
Item Recovery.

Examines folder tables and validates properties.
Also examines message tables, validates
properties, and accumulates reference counts.

For each mailbox, examines folders, deleted
folders, and tables. Also validates properties,
special folders (for example, Inbox, Outbhox, Sent
Items, Deleted Items, and others) in the folder
table, and checks the respective sizes.

Examines message tables and validates message
table properties.

Checks the search links (subset of the search test).
In Fix mode, deletes all of the cached
categorization and restriction tables.

Validates message reference counts in the
messages.

Validates message reference counts for messages
marked for Deleted Item Recovery in the message
table.

Examines the folder, message, and attachment
tables, and also validates the named properties.

Validates newsfeed table properties, including
permissions.

Validates newsfeed reference counts.

Validates out-of-office history information for all

Number of mailboxes and folders in the
information store.

Number of folders in the information
store.

Number of folders and messages in the
information store.

Number of mailboxes, folders, deleted
folders, and messages in the
information store.

Number of messages in the information
store.

Total number of cached categorization
and total number of restriction tables.
Number of folders, messages, and
attachments in the information store.
Number of folders and messages in the
information store.

Number of folders, messages, and

attachments in the information store.

Number of folders in the information
store.

Number of folders in the information
store.

Number of out-of-office rules set.

store only) users.
——— _ . _
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ISINTEG Tests

peruser Validates per user read/unread information. Number of folders per user in the
information store

revfld (private Cross-checks receive folders with the folder table. Number of receive folders in the
store only) information store.
rowcounts Validates the number of rows for all tables. Number of folders, messages, and

attachments in the information store.

search Validates the search links. Number of folders in the information
store.
timedev Counts the number of timed events (maintenance, Number of timed events.

periodic tasks, and so forth).

Microsoft Exchange Error Numbers

This information can be obtained by running the ERROR.EXE program located on the
Microsoft Exchange CD in\ support\util s\i 386.

For example, to learn what Error 200 means, run the following:
D:\server\support\utils\i386\error 200
Error 200 (0 x C8) = w nBFNot Synchr onous

The following is a list of the ESE97 error codes, including Error Number (in Decimal and
Hex), Error Message, Description (from source code comments), and Decimal Equivalent.

SUCCESS

Decimal: 0

Hex: 0x00000000

Error Message: JET_errSuccess
Description: /* Successful Operation */

Decimal from Hex: ERRORS */
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Decimal: -1

Hex: OXFFFFFFFF

Error Message: JET_wrnNyi

Description: /* Function Not Yet Implemented */

Decimal from Hex: 4294967295

SYSTEM errors

Decimal: -100

Hex: OXFFFFFFOC

Error Message: JET_errRfsFailure
Description: /* JET _errRfsFailure */

Decimal from Hex: 4294967196

Decimal: -101

Hex: OXFFFFFF9B

Error Message: JET_errRfsNotArmed
Description: /* JET_errRfsFailure */
Decimal from Hex: 4294967195

Decimal: -102

Hex: OXFFFFFF9A

Error Message: JET errFileClose

Description: /* Could not close DOS file */

Decimal from Hex: 4294967194

Decimal: -103

Hex: OXFFFFFF99

Error Message: JET_errOutOfThreads
Description: /* Could not start thread */

Decimal from Hex: 4294967193
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-105

OXFFFFFF97

JET_errTooManylO

/* System busy due to too many 10s */
4294967191

BUFFER MANAGER errors

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

200

0x000000C8

wrnBFCacheMiss

/* page latch caused a cache miss */
200

-201

OXFFFFFF37
errBFPageNotCached

/* page is not cached */
4294967095

-202

OXFFFFFF36
errBFLatchConflict

/* page latch conflict */
4294967094

-250

OXFFFFFFO6

errBFIPageEvicted

/* page evicted from the cache */
4294967046
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-251

OxFFFFFFO05
errBFIPageCached

/* page already cached */
4294967045

-252

OXFFFFFFO4
errBFIOutOfOLPs
/* out of OLPs */
4294967044

-253

OXFFFFFFO3
errBFIOutOfBatchlOBuffers
/* out of Batch 1/0 Buffers */
4294967043

-254

OXFFFFFFO2

errBFINoBufferAvailable

/* no buffer available for immediate use */
4294967042

-255

OXFFFFFFO1
JET_errDatabaseBufferDependenciesCorrupted
// buffer dependencies were improperly set
4294967041
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VERSION STORE errors

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

275

0x00000113

wrnVERRCEMoved

/* RCE was moved instead of being cleaned */

275

DIRECTORY MANAGER errors

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-300

OXFFFFFED4
errPMOutOfPageSpace
/* Out of page space */
4294966996

-301

OXFFFFFED3

errPMItagTooBig

/* Itag too big */ // XXX -- to be deleted
4294966995

-302

OXFFFFFED?2

errPMRecDeleted

/* Record deleted */ // XXX -- to be deleted
4294966994

-303

OXFFFFFED1

errPMTagsUsedUp

/* Tags used up */ // XXX --to be deleted
4294966993
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ISINTEG

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

304

0x00000130

wrnBMConflict

/* conflict in BM Clean up */
304

-305

OXFFFFFECF
errDIRNoShortCircuit

/* No Short Circuit Avail */
4294966991

-306
OxFFFFFECE
errDIRCannotSplit

/* Cannot horizontally split FDP */

4294966990

-307

OXFFFFFECD
errDIRTop

/* Cannot go up */
4294966989

308

0x00000134
errDIRFDP

/* On an FDP Node */
308
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-309

OxFFFFFECB
errDIRNotSynchronous

/* May have left critical section */
4294966987

310

0x00000136

wrnDIREmptyPage

/* Moved through empty page */
310

-311

OXFFFFFEC9

errSPConflict

/* Device extent being extended */
4294966985

312

0x00000138
wrnNDFoundLess
/* Found Less */
312

313

0x00000139
wrnNDFoundGreater
/* Found Greater */
313
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

314

0x0000013A
wrnNDNotFoundlnPage
/* for smart refresh */
314

-312
OXFFFFFECS
errNDNotFound
/* Not found */
4294966984

-314

OXFFFFFEC6
errNDOutSonRange
/* Son out of range */
4294966982

-315

OXFFFFFEC5
errNDOutltemRange
/* Item out of range */
4294966981

-316

OXFFFFFEC4
errNDGreaterThanAllltems
/* Greater than all items */

4294966980
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-317

OxFFFFFEC3
errNDLastltemNode

/* Last node of item list */

4294966979

-318

OXFFFFFEC2
errNDFirstitemNode

/* First node of item list */

4294966978

319

0x0000013F
wrnNDDuplicateltem
/* Duplicated Item */
319

-320

OXFFFFFECO
errNDNoltem

/* Item not there */

4294966976

321

0x00000141
JET_wrnRemainingVersions

/* Some versions couldn't be cleaned */
321
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-322

OxFFFFFEBE
JET_errPreviousVersion

/* \ersion already existed */
4294966974

-323

OXFFFFFEBD
JET_errPageBoundary

/* Reached Page Boundary */
4294966973

-324

OXFFFFFEBC
JET_errKeyBoundary

/* Reached Key Boundary */
4294966972

-325

OXFFFFFEBB
errDIRInPageFather

/* sridFather in page to free */
4294966971

-326

OXFFFFFEBA

errBMMaxKeylnPage

/* used by OLC to avoid cleanup of parent pages */
4294966970
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Decimal: -327

Hex: OxFFFFFEB9

Error Message: JET_errBadPageLink

Description: /* next/previous page link page does not point back to source */

Decimal from Hex: 4294966969

Decimal: -328

Hex: OXFFFFFEB8

Error Message: JET_errBadBookmark

Description: /* bookmark has no corresponding address in database */

Decimal from Hex: 4294966968

Decimal: 329

Hex: 0x00000149

Error Message: wrnBMCleanNullOp

Description: // BMClean returns this on encountering a page

Decimal from Hex: 329

Description: // deleted MaxKeylInPage [but there was no conflict]
Decimal: -330

Hex: OXFFFFFEBG

Error Message: errBTOperNone

Description: // Split with no accompanying

Decimal from Hex: 4294966966

Description: // insert/replace
Decimal: -331
Hex: OXFFFFFEB5

Error Message: errSPOutOfAvailExtCacheSpace
Description: // unable to make update to AvailExt tree since
Decimal from Hex: 4294966965

Description: // in-cursor space cache is depleted
B R R ————
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Decimal: -332

Hex: OxFFFFFEB4

Error Message: errSPOutOfOwnExtCacheSpace

Description: // unable to make update to OwnEXxt tree since

Decimal from Hex: 4294966964

Description: // in-cursor space cache is depleted
Decimal: 333
Hex: 0x0000014D

Error Message: wrnBTMultipageOLC
Description: // needs multipage OLC operation

Decimal from Hex: 333

Decimal: -334

Hex: OxFFFFFEB2

Error Message: JET_errNTSystemCallFailed
Description: // can not get OS version
Decimal from Hex: 4294966962

Decimal: 335

Hex: 0x0000014F

Error Message: wrnBTShallowTree

Description: // BTree is only one or two levels deeps

Decimal from Hex: 335

Decimal: -336

Hex: OxFFFFFEBO

Error Message: errBTMergeNotSynchronous

Description: // Multiple threads attempting to perform merge/split on same page

(likely OLD vs. RCEClean)
Decimal from Hex: 4294966960
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RECORD MANAGER errors

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

400

0x00000190
wrnFLDKeyTooBig

/* Key too big (truncated it) */
400

-401

OXFFFFFEGF
errFLDTooManySegments

/* Too many key segments */
4294966895

402

0x00000192
wrnFLDNullKey

/* Key is entirely NULL */
402

403

0x00000193
wrnFLDOutOfKeys

/* No more keys to extract */
403

404

0x00000194
wrnFLDNullSeg

/* Null segment in key */
404
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ISINTEG

Decimal:
Hex:
Error Message:

Decimal from Hex:

Decimal:

Hex:

Error Message:
Description:

Decimal from Hex:

Decimal:

Hex:

Error Message:
Description:
Decimal from Hex:
Error Message:
Error Message:

Error Message:

Decimal:

Hex:

Error Message:
Description:

Decimal from Hex:

Decimal:

Hex:

Error Message:
Description:
Decimal from Hex:

Description:

405

0x00000195
wrnFLDNotPresentinindex
405

406

0x00000196
JET_wrnSeparateLongValue
/* Separated long value */
406

407

0x00000197
wrnRECLongField

/* Separated long value */
407
JET_wrnRecordFoundGreater
JET_wrnRecordFoundLess

JET_errColumnlllegalNull

408

0x00000198
wrnFLDNullFirstSeg

/* Null first segment in key */
408

-408

OXFFFFFE68

JET_errKeyTooBig

/* Key with column truncation still truncated */
4294966888

/* LOGGING/RECOVERY errors
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-500

OxFFFFFEOC
JET_errinvalidLoggedOperation

/* Logged operation cannot be redone */
4294966796

-501

OXFFFFFEOB

JET _errLogFileCorrupt
/* Log file is corrupt */
4294966795

-502

OXFFFFFEOA
errLGNoMoreRecords

/* Last log record read */
4294966794

-503

OXFFFFFEQ9
JET_errNoBackupDirectory

/* No backup directory given */
4294966793

-504

OXFFFFFEO8
JET_errBackupDirectoryNotEmpty

/* The backup directory is not empty */
4294966792
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ISINTEG

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-505

OxFFFFFEQ7
JET_errBackuplnProgress

/* Backup is active already */

4294966791

-506

OXFFFFFEO6
JET_errRestorelnProgress
/* Restore in progress */
4294966790

-509

OXFFFFFEO3
JET_errMissingPreviousLogFile

/* Missing the log file for check point */
4294966787

-510

OXFFFFFEQ02

JET_errLogWriteFail

/* Fail when writing to log file */
4294966786

-514

OXFFFFFDFE

JET_errBadLogVersion

/* \ersion of log file is not compatible with Jet version */
4294966782
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Description:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-515

OxFFFFFDFD

JET_errinvalidLogSequence

/* Timestamp in next log does not match expected */
4294966781

-516

OXFFFFFDFC
JET_errLoggingDisabled
/* Log is not active */
4294966780

-517

OXFFFFFDFB

JET_errLogBufferTooSmall

/* Log buffer is too small for recovery */
4294966779

-518

OXFFFFFDFA
errLGNotSynchronous
/* retry to LGLogRec */
4294966778

-519

OXFFFFFDF9

JET _errLogSequenceEnd

/* Exceed maximum log file number */
4294966777
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-520

OxFFFFFDF8
JET_errNoBackup

/* No backup in progress */
4294966776

-521

OXFFFFFDF7
JET_errinvalidBackupSequence
/* Backup call out of sequence */
4294966775

-523

OXFFFFFDF5
JET_errBackupNotAllowedYet
/* Can not do backup now */
4294966773

-524

OXFFFFFDF4
JET_errDeleteBackupFileFail

/* Could not delete backup file */
4294966772

-525
OxFFFFFDF3
JET_errMakeBackupDirectoryFail

/* Could not make backup temp directory */

4294966771
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:

Error Message:

-526

OxFFFFFDF2

JET_errinvalidBackup

/* Cannot incremental backup when circular logging enabled */
4294966770

-527

OXFFFFFDF1
JET_errRecoveredWithErrors

/* For repair, restored with errors */
4294966769

-528

OXFFFFFDFO
JET_errMissingLogFile

/* current log file missing */
4294966768

-529

OXFFFFFDEF
JET_errLogDiskFull
/* log disk full */
4294966767

-530
OxFFFFFDEE
JET_errBadLogSignature

Description: /* bad signature for a log file */
Decimal from Hex: 4294966766
Appendix A, ESEUTIL and ISINTEG Line Switches 181 ~



ISINTEG

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-531

OxFFFFFDED
JET_errBadDbSignature

/* bad signature for a db file */
4294966765

-532

OXFFFFFDEC
JET_errBadCheckpointSignature

/* bad signature for a checkpoint file */
4294966764

-533

OXFFFFFDEB

JET_errCheckpointCorrupt

/* checkpoint file not found or corrupt */
4294966763

-534

OXFFFFFDEA

JET_errMissingPatchPage

/* patch file page not found during recovery */
4294966762

-535

OXFFFFFDE9
JET_errBadPatchPage

/* patch file page is not valid */
4294966761
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-536
OxFFFFFDES8
JET_errRedoAbruptEnded

/* Redo abruptly ended due to sudden failure in reading logs from

log file */
4294966760

-550

OXFFFFFDDA
JET_errDatabaselnconsistent

/* database is in inconsistent state */
4294966746

-551

OXFFFFFDD9
JET_errConsistentTimeMismatch

/* database last consistent time unmatched */
4294966745

-552

OXFFFFFDDS8
JET_errDatabasePatchFileMismatch

/* patch file is not generated from this backup */
4294966744

-553

OXFFFFFDD7

JET_errEndingRestoreLogTooLow

/* the starting log number too low for the restore */
4294966743
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-554

OxFFFFFDD6

JET_errStartingRestoreLogTooHigh

/* the starting log number too high for the restore */
4294966742

-555

OXFFFFFDD5
JET_errGivenLogFileHasBadSignature
/* Restore log file has bad signature */
4294966741

-556

OXFFFFFDDA4
JET_errGivenLogFilelsNotContiguous
/* Restore log file is not contiguous */
4294966740

-557

OXFFFFFDD3
JET_errMissingRestoreLogFiles

/* Some restore log files are missing */
4294966739

558

0x0000022E
JET_wrnExistingLogFileHasBadSignature
/* Existing log file has bad signature */
558
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

559

0x0000022F
JET_wrnExistingLogFilelsNotContiguous
/* Existing log file is not contiguous */
559

-560
OxFFFFFDDO
JET_errMissingFullBackup

/* The database miss a previous full backup befor incremental
backup */

4294966736

-561

OXFFFFFDCF
JET_errBadBackupDatabaseSize

/* The backup database size is not in 4k */
4294966735

-562

OXFFFFFDCE

JET_errDatabaseAlreadyUpgraded

/* Attempted to upgrade a database that is already current */
4294966734

-563
OxFFFFFDCD
JET_errDatabaselncompleteUpgrade

/* Attempted to use a database which was only partially converted to
the current format -- must restore from backup */

4294966733
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

564

0x00000234

JET_wrnSkipThisRecord

/* Skip this record, used by convert, internal only */
564

-900

OXFFFFFC7C

JET_errinvalidGrbit

/* Grbit is not valid in the context of this API call */
4294966396

-1000

OXFFFFFC18
JET_errTermInProgress

/* Termination in progress */
4294966296

-1001

OXFFFFFC17
JET_errFeatureNotAvailable
/* API not supported */
4294966295

-1002

OXFFFFFC16
JET_errinvalidName
/* Invalid name */
4294966294
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1003

OxFFFFFC15

JET _errinvalidParameter

/* Invalid API parameter */
4294966293

1004

0x000003EC
JET_wrnColumnNull

/* Column is NULL-valued */
1004

1006

0x000003EE
JET_wrnBufferTruncated

/* Buffer too small for data */

1006

1007

0x000003EF
JET_wrnDatabaseAttached

/* Database is already attached */
1007

-1008

OXFFFFFC10

JET_errDatabaseFileReadOnly

/* Attach a readonly database file for read/write operations */
4294966288
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

1009

0x000003F1
JET_wrnSortOverflow

/* Sort does not fit in memory */

1009

-1010

OXFFFFFCOE
JET_errinvalidDatabaseld
/* Invalid database id */
4294966286

-1011

OXFFFFFCOD
JET_errOutOfMemory
/* Out of Memory */
4294966285

-1012
OxFFFFFCOC
JET_errOutOfDatabaseSpace

/* Maximum database size reached */

4294966284

-1013

OXFFFFFCOB
JET_errOutOfCursors

/* Out of table cursors */

4294966283
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1014

OxFFFFFCOA
JET_errOutOfBuffers

/* Out of database page buffers */
4294966282

-1015

OXFFFFFC09
JET_errTooManylndexes
/* Too many indexes */
4294966281

-1016

OXFFFFFCO08

JET_errTooManyKeys

/* Too many columns in an index */
4294966280

-1017

OXFFFFFCO7
JET_errRecordDeleted

/* Record has been deleted */
4294966279

-1018

OXFFFFFCO06
JET_errReadVerifyFailure
/* Read verification error */
4294966278
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1019

OxFFFFFCO05

JET_errPageNotinitialized

/* Repair Only: Read an unused page */
4294966277

-1020

OXFFFFFCO04
JET_errOutOfFileHandles
/* Out of file handles */
4294966276

-1022

OXFFFFFCO02
JET_errDisklO

/* Disk 10 error */
4294966274

-1023

OXFFFFFCO01
JET_errinvalidPath
/* Invalid file path */
4294966273

-1024

OXFFFFFCO00
JET_errlnvalidSystemPath
/* Invalid system path */
4294966272
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1025

OxFFFFFBFF
JET_errlnvalidLogDirectory
/* Invalid log directory */
4294966271

-1026

OXFFFFFBFE

JET_errRecordTooBig

/* Record larger than maximum size */
4294966270

-1027

OXFFFFFBFD
JET_errTooManyOpenDatabases
/* Too many open databases */
4294966269

-1028

OXFFFFFBFC
JET_errinvalidDatabase
/* Not a database file */
4294966268

-1029

OXFFFFFBFB
JET_errNotlInitialized

/* Jetlnit not yet called */
4294966267
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1030

OxFFFFFBFA
JET_errAlreadylnitialized
/* Jetlnit already called */
4294966266

-1031

OXFFFFFBF9

JET _errInitInProgress

/* Jetlnit is underway */
4294966265

-1032

OXFFFFFBF8
JET_errFileAccessDenied
/* Cannot access file */
4294966264

-1034

OXFFFFFBF6

JET_errQueryNotSupported

/* Query support unavailable */ // XXX -- to be deleted
4294966262

-1035

OXFFFFFBF5

JET_errSQLLinkNotSupported

/* SQL Link support unavailable */ // XXX -- to be deleted
4294966261

192

NetBackup for Microsoft Exchange Server System Administrator’s Guide



ISINTEG

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1038

OXxFFFFFBF2
JET_errBufferTooSmall
/* Buffer is too small */

4294966258

1039

0x0000040F

JET_wrnSeekNotEqual

/* SeekLE or SeekGE didn't find exact match */
1039

-1040

OXFFFFFBFO
JET_errTooManyColumns

/* Too many columns defined */
4294966256

-1043

OXFFFFFBED
JET_errContainerNotEmpty
/* Container is not empty */
4294966253

-1044

OXFFFFFBEC
JET_errinvalidFilename
/* Filename is invalid */
4294966252
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1045

OxFFFFFBEB

JET errinvalidBookmark
/* Invalid bookmark */

4294966251

-1046

OXFFFFFBEA
JET_errColumninUse

/* Column used in an index */
4294966250

-1047

OXFFFFFBE9

JET _errlnvalidBufferSize

/* Data buffer doesn't match column size */
4294966249

-1048

OXFFFFFBES8
JET_errColumnNotUpdatable
/* Cannot set column value */
4294966248

-1051

OXFFFFFBES
JET_errindexinUse
/* Index is in use */
4294966245
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1052

OxFFFFFBE4
JET_errLinkNotSupported

/* Link support unavailable */
4294966244

-1053

OXFFFFFBE3
JET_errNullKeyDisallowed

/* Null keys are disallowed on index */
4294966243

-1054

OXFFFFFBE2

JET_errNotInTransaction

/* Operation must be within a transaction */
4294966242

1055

0x0000041F

JET_wrnNoErrorinfo

/* No extended error information */
1055

1058

0x00000422
JET_wrnNoldleActivity

/* No idle activity occured */
1058
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1059

OxFFFFFBDD
JET_errTooManyActiveUsers

/* Too many active database users */

4294966237

-1061

OXFFFFFBDB

JET_errinvalidCountry

/* Invalid or unknown country code */
4294966235

-1062

OXFFFFFBDA
JET_errinvalidLanguageld

/* Invalid or unknown language id */
4294966234

-1063

OXFFFFFBD9
JET_errinvalidCodePage

/* Invalid or unknown code page */
4294966233

1067

0x0000042B

JET_wrnNoWriteLock

/* No write lock at transaction level 0 */
1067
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

1068

0x0000042C
JET_wrnColumnSetNull

/* Column set to NULL-value */
1068

-1069

OXFFFFFBD3
JET_errVersionStoreOutOfMemory

/* IMaxVerPages exceeded (XJET only) */
4294966227

-1070

OXFFFFFBD2

JET_errCurrencyStackOutOfMemory

/* ICSRPerfFUCB * IMaxCursors exceeded (XJET only) */
4294966226

-1071

OXFFFFFBD1

JET_errCannotindex

/* Cannot index escrow column */
4294966225

-1072

OXFFFFFBDO
JET_errRecordNotDeleted

/* Record has not been deleted */
4294966224
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1101

OxFFFFFBB3
JET_errOutOfSessions
/* Out of sessions */

4294966195

-1102

OXFFFFFBB2

JET_errWriteConflict

/* Write lock failed due to outstanding write lock */
4294966194

-1103

OXFFFFFBB1
JET_errTransTooDeep

/* Xactions nested too deeply */
4294966193

-1104

OXFFFFFBBO
JET_errinvalidSesid

/* Invalid session handle */
4294966192

-1105

OXFFFFFBAF

JET_errWriteConflictPrimarylndex

/* update attempted on uncommitted primary index */
4294966191
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Decimal: -1108

Hex: OXFFFFFBAC

Error Message: JET_errInTransaction

Description: /* Operation not allowed within a transaction */

Decimal from Hex: 4294966188

Decimal: -1109
Hex: OxFFFFFBAB
Error Message: JET_errRollbackRequired

Description: /* Must rollback current transaction -- cannot commit or begin a new
one*/

Decimal from Hex: 4294966187

Decimal: -1201

Hex: OXFFFFFB4F

Error Message: JET_errDatabaseDuplicate
Description: /* Database already exists */

Decimal from Hex: 4294966095

Decimal: -1202

Hex: OxFFFFFBA4E

Error Message: JET_errDatabaselnUse
Description: /* Database in use */

Decimal from Hex: 4294966094

Decimal: -1203

Hex: OXFFFFFB4D

Error Message: JET_errDatabaseNotFound
Description: /* No such database */

Decimal from Hex: 4294966093
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1204

OxFFFFFB4C

JET errDatabaselnvalidName
/* Invalid database name */
4294966092

-1205

OxXFFFFFB4B
JET_errDatabaselnvalidPages
/* Invalid number of pages */
4294966091

-1206

OXFFFFFB4A
JET_errDatabaseCorrupted

/* non-db file or corrupted db */
4294966090

-1207

OXFFFFFB49
JET_errDatabaselocked

/* Database exclusively locked */
4294966089

-1208

OXFFFFFB48

JET_errCannotDisableVersioning

/* Cannot disable versioning for this database */
4294966088
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1209

OxFFFFFB47

JET_errlnvalidDatabaseVersion

/* Database engine is incompatible with database */
4294966087

-1210

OXFFFFFB46
JET_errDatabase200Format

/* The database is in 200 format */
4294966086

-1211

OXFFFFFB45
JET_errDatabase400Format

/* The database is in 400 format */
4294966085

-1212

OXFFFFFB44
JET_errDatabase500Format

/* The database is in 500 format */
4294966084

1301

0x00000515
JET_wrnTableEmpty

/* Open an empty table */
1301
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1302

OXxFFFFFAEA

JET errTableLocked

/* Table is exclusively locked */

4294965994

-1303

OXFFFFFAE9

JET _errTableDuplicate
/* Table already exists */
4294965993

-1304

OXFFFFFAES

JET errTablelnUse

/* Table is in use, cannot lock */
4294965992

-1305

OXFFFFFAE7
JET_errObjectNotFound

/* No such table or object */
4294965991

-1307

OXFFFFFAES

JET _errDensityInvalid

/* Bad file/index density */
4294965989
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1308

OxFFFFFAE4
JET_errTableNotEmpty

/* Cannot define clustered index */
4294965988

-1310

OXFFFFFAE2

JET errinvalidTableld
/* Invalid table id */
4294965986

-1311
OxFFFFFAE1
JET_errTooManyOpenTables

/* Cannot open any more tables (cleanup already attempted) */

4294965985

-1312

OXFFFFFAEQ

JET _errlllegalOperation

/* Oper. not supported on table */
4294965984

-1314

OXFFFFFADE
JET_errObjectDuplicate

/* Table or object name in use */
4294965982

Appendix A, ESEUTIL and ISINTEG Line Switches

203



ISINTEG

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1316

OxFFFFFADC
JET_errinvalidObject

/* object is invalid for operation */
4294965980

-1317

OXFFFFFADB

JET_errCannotDeleteTempTable

/* use CloseTable instead of DeleteTable to delete temp table */
4294965979

-1318

OXFFFFFADA
JET_errCannotDeleteSystemTable

/* illegal attempt to delete a system table */
4294965978

-1319

OXFFFFFAD9
JET_errCannotDeleteTemplateTable

/* illegal attempt to delete a template table */
4294965977

-1320

OXFFFFFADS

errFCBTooManyOpen

/* Cannot open any more FCB's (cleanup not yet attempted) */
4294965976
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1321
OXFFFFFAD7
errFCBAboveThreshold

/* Can only allocate FCB above preferred threshold (cleanup not yet

attempted) */
4294965975

-1322

OXFFFFFADG6
JET_errExclusiveTableLockRequired

/* Must have exclusive lock on table. */
4294965974

-1323

OXFFFFFADS

JET_errFixedDDL

/* DDL operations prohibited on this table */
4294965973

-1324
OxFFFFFAD4
JET_errFixedInheritedDDL

/* On a derived table, DDL operations are prohibited on inherited
portion of DDL */

4294965972

-1325

OXFFFFFAD3

JET_errCannotNestDDL

/* Nesting of hierarchical DDL is not currently supported. */
4294965971
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1326
OxFFFFFAD?2
JET_errDDLNotInheritable

/* Tried to inherit DDL from a table not marked as a template table.
*/

4294965970

1327

0x0000052F

JET_wrnTablelnUseBySystem

/* System cleanup has a cursor open on the table */
1327

-1328

OXFFFFFADO

JET_errinvalidSettings

/* System parameter were set improperly */
4294965968

-1329

OXFFFFFACF
JET_errClientRequestToStopJetService
/* Client has requested stop service */
4294965967

-1401

OXFFFFFA87
JET_errIndexCantBuild
/* Index build failed */
4294965895
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1402

OXFFFFFAB86
JET_errindexHasPrimary

/* Primary index already defined */
4294965894

-1403

OXFFFFFA85
JET_errIndexDuplicate

/* Index is already defined */
4294965893

-1404

OXFFFFFA84
JET_errindexNotFound
/* No such index */
4294965892

-1405

OXFFFFFA83
JET_errIndexMustStay

/* Cannot delete clustered index */
4294965891

-1406

OXFFFFFA82
JET_errindexInvalidDef

/* lllegal index definition */
4294965890
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

-1409

OXFFFFFATF

JET errinvalidCreatelndex

/* Invalid create index description */
4294965887

-1410

OXFFFFFATE
JET_errTooManyOpenindexes

/* Out of index description blocks */
4294965886

-1411
OXFFFFFA7D
JET_errMultiValuedIndexViolation

/* -unique inter-record index keys generated for a multivalued index
*/

4294965885

- 1412
OXFFFFFA7C
JET_errindexBuildCorrupted

/* Failed to build a secondary index that properly reflects primary
index */

4294965884

- 1413

OXFFFFFATB

JET_errPrimarylndexCorrupted

/* Primary index is corrupt -- defrag required */
4294965883
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1414

OXFFFFFATA

JET_errSecondarylndexCorrupted

/* Secondary index is corrupt -- defrag required */
4294965882

1415

0x00000587

JET_wrnCorruptindexDeleted

/* Out of date index of the attached db is removed */
1415

- 1501

OXFFFFFA23
JET_errColumnLong

/* Column value is long */
4294965795

- 1502

OXFFFFFA22
JET_errColumnNoChunk

/* no such chunk in long value */
4294965794

- 1503

OxXFFFFFA21
JET_errColumnDoesNotFit

/* Field will not fit in record */

4294965793
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1504

OXFFFFFA20
JET_errNullinvalid
/* Null not valid */
4294965792

- 1505

OXFFFFFALF
JET_errColumnindexed

/* Column indexed, cannot delete */
4294965791

- 1506

OXFFFFFALE
JET_errColumnTooBig

/* Field length is > maximum */
4294965790

- 1507

OXFFFFFALD
JET_errColumnNotFound
/* No such column */
4294965789

- 1508

OXFFFFFALC
JET_errColumnDuplicate

/* Field is already defined */
4294965788
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1510

OXFFFFFA1A

JET_errColumnRedundant

/* Second autoincrement or version column */
4294965786

-1511

OxXFFFFFA19
JET_errinvalidColumnType

/* Invalid column data type */
4294965785

1512

0x000005E8
JET_wrnColumnMaxTruncated

/* Max length too big, truncated */
1512

- 1514

OXFFFFFA16
JET_errTaggedNotNULL

/* No non-NULL tagged columns */
4294965782

- 1515

OXFFFFFA15
JET_errNoCurrentindex

/* Invalid w/0 a current index */
4294965781
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1516

OxFFFFFAl4

JET_errKeylsMade

/* The key is completely made */
4294965780

- 1517

OXFFFFFA13
JET_errBadColumnlid

/* Column Id Incorrect */
4294965779

- 1518

OXFFFFFA12

JET_errBadltagSequence

/* Bad itagSequence for tagged column */
4294965778

- 1519

OXFFFFFA1l

JET_errColumnlinRelationship

/* Cannot delete, column participates in relationship */
4294965777

1520

0x000005F0
JET_wrnCopyLongValue

/* Single instance column bursted */
1520
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Decimal: -1521

Hex: OxFFFFFAOF

Error Message: JET_errCannotBeTagged

Description: /* Autolncrement and Version cannot be tagged */

Decimal from Hex: 4294965775

Decimal: 1522

Hex: 0x000005F2

Error Message: wrnLVNoLongValues

Description: /* Table does not have a long value tree */

Decimal from Hex: 1522

Decimal: 1523

Hex: 0x000005F3

Error Message: JET_wrnTaggedColumnsRemaining

Description: /* RetrieveTaggedColumnList ran out of copy buffer before

retrieving all tagged columns */
Decimal from Hex: 1523

Decimal: - 1524

Hex: OXFFFFFAQC

Error Message: JET_errDefaultValueTooBig

Description: /* Default value exceeds maximum size */
Decimal from Hex: 4294965772

Decimal: - 1601

Hex: OXFFFFFOBF

Error Message: JET_errRecordNotFound
Description: /* The key was not found */

Decimal from Hex: 4294965695
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1602

OxFFFFF9BE
JET_errRecordNoCopy
/* No working buffer */
4294965694

- 1603

OXFFFFF9BD
JET_errNoCurrentRecord

/* Currency not on a record */
4294965693

- 1604

OXFFFFF9BC
JET_errRecordPrimaryChanged
/* Primary key may not change */
4294965692

- 1605

OXFFFFF9BB
JET_errKeyDuplicate

/* lllegal duplicate key */
4294965691

- 1607

OXFFFFF9B9
JET_errAlreadyPrepared

/* Already copy/clear current */
4294965689
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1608

OxFFFFF9B8
JET_errKeyNotMade

/* No call to JetMakeKey */
4294965688

- 1609

OXFFFFF9OB7
JET_errUpdateNotPrepared

/* No call to JetPrepareUpdate */
4294965687

1610

0x0000064A
JET_wrnDataHasChanged
/* Data has changed */
1610

-1611

OXFFFFF9B5

JET_errDataHasChanged

/* Data has changed, operation aborted */
4294965685

1618

0x00000652
JET_wrnKeyChanged
/* Moved to new key */
1618
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1619
OXFFFFFOAD
JET_errLanguageNotSupported

/* WindowsNT installation does not support language */

4294965677

-1701

OXFFFFF95B
JET_errTooManySorts

/* Too many sort processes */
4294965595

- 1702

OXFFFFF95A
JET_errinvalidOnSort

/* Invalid operation on Sort */
4294965594

- 1803

OXFFFFF8F5
JET_errTempFileOpenError

/* Temp file could not be opened */
4294965493

- 1805

OXFFFFF8F3
JET_errTooManyAttachedDatabases
/* Too many open databases */
4294965491
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1808

OxFFFFF8FO

JET errDiskFull

/* No space left on disk */
4294965488

- 1809

OXFFFFFSEF
JET_errPermissionDenied
/* Permission denied */
4294965487

-1811

OXFFFFF8ED
JET_errFileNotFound
/* File not found */
4294965485

1813

0x00000715
JET_wrnFileOpenReadOnly
/* Database file is read only */
1813

-1850

OXFFFFF8C6
JET_errAfterlnitialization

/* Cannot Restore after init. */
4294965446
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1852

OxFFFFF8C4

JET_errLogCorrupted

/* Logs could not be interpreted */
4294965444

- 1906

OxFFFFF88E
JET_errinvalidOperation
/* invalid operation */
4294965390

- 1907

OXFFFFF88D
JET_errAccessDenied
/* access denied */
4294965389

1908

0x00000774
JET_wrnldleFull

/* ilde registry full */
1908

- 1909

OxFFFFF88B
JET_errTooManySplits

/* Infinite split. Call PSS */
4294965387
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Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

Decimal:
Hex:
Error Message:

Description:

Decimal from Hex:

- 1910

OxFFFFF88A

JET_errSessionSharingViolation

/* Multiple threads are using the same session */
4294965386

-1911

OxFFFFF889

JET_errEntryPointNotFound

/* An entry point in a DLL we require could not be found */
4294965385

2000

0x000007D0

JET_wrnDefragAlreadyRunning

/* Online defrag already running on specified database */
2000

2001

0x000007D1

JET_wrnDefragNotRunning

/* Online defrag not running on specified database */
2001
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Sample Server Configuration Worksheets B

Use the worksheets in this chapter when preparing a disaster recovery kit. Refer to
“Create a Disaster Recovery Kit” on page 116 for additional information that should be
included in such a kit.

Hardware

Computer Model

Display Model

S/N

BackPlane

CPU

Hard Disk(s)

Floppy Disk

RAM

NIC

SCSI® Card

CDROM

Tape Backup
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Windows Installation

Windows Server \Version:

Windows Server Role:

Domain Name:

Computer Name:

Install Directory:

Swap File:

Protocols

Disk Configuration:

Licensing

Printer

Special Groups

This Machine IP

Subnet Mask

Default Gateway

222

NetBackup for Microsoft Exchange Server System Administrator’s Guide



Microsoft Exchange Server Installation

Org Name

Site Name

Computer Name

Service Account

Service Account Password

Connectors
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Microsoft Exchange Performance Optimizer

This is important during recovery to ensure that the recovery server is tuned properly.
Hardware being equal, similar performance can be experienced following a full restore
where Microsoft Exchange is reinstalled to a recovery server. Note that the performance
optimizer log stored in c: \ wi nnt 35\ syst enB82\ per f opt . | og does not reveal the
specific settings that were chosen during optimization.

Server Name:

1-25 Private Store Less than 100 MB
26-50 Public Store 100-999

51-100 Connector/Directory Import 1,000-9,999

101-250 Multi-Server 10,000 - 99,999

251-500 100,000 or more

More than 500

Private Information Store

F:\exchsrvr\mdbdata

Public Information Store F:\exchsrvr\mdbdata
Information Store Logs E:\exchsrvr\mdbdata
Directory Service F:\exchsrvr\dsadata

Directory Service Logs

E:\exchsrvr\dsadata

Message Transfer Agent

F:\exchsrvr\mtadata

Directory Store Working Path

D:\exchsrvr\dsadata

Information Store Working Path

D:\exchsrvrAmdbdata

Internet Mail Connector Files

\exchsrvr\imcdata
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Index

B

Activity logs See Debug logs.
Activity Monitor
Admin Console for UNIX 66
Admin Console for Windows 65
Alternate client restore See Redirected
restores, to different clients.
Alternate path restore See Redirected
restores, to different paths.
Automatic backups
of Exchange 5.x objects 42, 61
of mailbox objects 35, 52
of storage groups and databases 39, 58
of the Key Management Service 41, 60
of the Microsoft Information Store 38, 56
of the MS Exchange Public folder 54
of the MS Exchange Public folders 37
of the Site Replication Service 41, 59

Backup Exec images
restoring 77
Backup types
cumulative-incremental 32, 49
differential-incremental 31, 48
full 31, 48
user 31, 48
Backups
automatic, described 4
manual See Manual backups.
manual, described 4
of Exchange Public Folders 101
of mailboxes 86
of Public folders 101
requirements in order to perform 12
user-directed, described 5
Backups, user-directed
and cluster environments 68, 69
of Exchange 2000 objects 69

of Exchange 5.x objects 68
of mailboxes, services which must be
running 12

Circular logging, and incremental
backups 32, 49
Client
operational reports 110
permissions 13
troubleshooting 107
Client list
Admin Console for UNIX 62
Admin Console for Windows 43
Commit after restore completes 81
Configuration
database debug level 108
Configuring NetBackup
for individual mailbox and folder
operations 18
for Public Folders operations 18
to use the mailbox associated with the
Client service account 22
Cumulative -incremental backup 32, 49
Cumulative-incremental backups See Also
Incremental backups

Database circular logging, and incremental
backups 32, 49
Database patch files 6, 7
Debug logs 107
for backup operations 107
for restore operations 108
Defragmenting databases with
EDBUTIL 151
Delete Existing Transaction Logs Prior To
Restore 81
Differential-incremental backups 31, 48
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Differential-incremental backups See Also
Incremental backups

Directives
for Exchange 2000 database 6
for Exchange 5.x database 5, 42, 61
for mailbox items 52, 54
for mailbox itemsMailboxes

automatic backups of 35

for storage groups and databases 39, 58
for the Key Management Service 41, 60
for the Microsoft Information Store 38,
56
for the MS Exchange Public Folders 37
for the Site Replication Service 41, 59
mixing directive sets 33, 50

Directory
troubleshooting with EDBUTIL 153

EDB.LOG 7
ESEUTIL
checking database consistency 152
defragmenting databases 151
overview 150
Exchange 2000 database
automatic backups of 6
Exchange 5.x database
automatic backups of 5, 42, 61
Exchange Public Share, backing up and
restoring 101

Features 1

Files backed up
Exchange 2000 database 6
Exchange 5.x database 5

Files list
adding Exchange 5.x objects 42, 61
adding mailbox items 35, 52, 54
adding storage groups and databases 39,
58
adding the Key Management Service 41,
60
adding the MS Exchange Public
folders 37
adding the MS Information Store 38, 56
adding the Site Replication Service 41, 59
example mailbox entries 36, 53
example public folder entries 38, 55
example storage group entries 40, 58

specifying objects to back up
Admin Console for UNIX 50
Admin Console for Windows 33
Full backup 31, 48
process 7

Glossary. See NetBackup Help.

Incremental backups, objects backed up 32,
49
Installation 16
requirements 12
for an Exchange Cluster
environment 12

jnbSA 25

Key Management Service
automatic backups of 41, 60
Key Management Services (KMS)
restores of 82
user-directed backup of 71

License key, registering 16
Log files
how applied after a restore 15
transaction 7, 14
where kept until database restored 14
Logs
debug 107
directory 107
transaction 9

Mailboxes
automatic backups of 52, 54
configuring NetBackup for backups and
restores of 18
permissions required for backing up and
restoring 19
user-directed backups, services which
must be running 12

Manual backups

Media
backup 7
reports 110

Microsoft Exchange Public Folders
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automatic backups of 37

Microsoft Information Store
automatic backups of 38, 56

Mount database after restore 81

MS Exchange services
that need to run on the Exchange 2000
client 13
that need to run on the Exchange 5.x
client 12
that need to run on the NetBackup
client 14

Multiple data streams 34, 51

NetBackup Administration Console for
UNIX, launching 25
NetBackup Administration Console for
Windows, launching 24
NetBackup Client service account
associating with an Exchange 2000
mailbox 20
associating with an Exchange 5.x
mailbox 19
configuring NetBackup to use the
mailbox associated with 22
verifying/modifying 18

Patch files
how applied after restore 15
where kept until database restored 14
Permissions
for clients 13
for restores 13
required for mailbox operations 19
Policy configuration
adding clients
Admin Console for UNIX 62
Admin Console for Windows 43
adding new
Admin Console for UNIX 44
Admin Console for Windows 27
adding schedules
Admin Console for UNIX 46
Admin Console for Windows 29
attributes 29, 46
overview 27
specifying objects to back up 50
Admin Console for Windows 33, 50
testing

Admin Console for UNIX 65
Admin Console for Windows 64
Private information stores
troubleshooting 153
Progress reports 110, 112
client 110
Progress reports, client 110
Public Folders operations
Configuring NetBackup for 18
Public information stores
troubleshooting with EDBUTIL 153

Recovery
and cumulative-incremental backups 32,
49
and differential-incremental backups 31,
48
Redirected restores
to different clients 9, 105
to different clients, requirements for
Exchange 2000 105
to different paths 9
Redirected restores, of mailbox objects
to different paths 93
Remote restores 8
Reports
client 110
media 110
operational 110
progress 112
Restores
failure of 15
of a mailbox message to a different
message 97
of a mailbox to a different mailbox 94
of an entire Exchange 2000 database 79
of Backup Exec objects 72
of Exchange 5.x objects 72
of Exchange Public Folders 101
of mailbox objects
to different paths 93
of mailboxes, folders, messages 89
of Public folders 101
of Storage Groups 77
of the Key Management Service
(KMS) 82
of the MS Information Store 77
of the Site Replication Service 82

Index
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of the Storage Group databases 77
permissions 13
redirected, to different client 9, 105
remote 8
requirements in order to perform 13
requirements in order to perform for
Exchange 2000 14
to different locations
requirements 94

user-directed 8

Retention period 33, 50

Schedules
adding
Admin Console for UNIX 46
Admin Console for Windows 29
frequency 33, 50
properties 32, 49
retention 33, 50
Site Replication Service (SRS)
automatic backups of 41, 59
restores of 82
user-directed backup of 71
Storage groups
automatic backups of 39, 58

Temporary location for log and patch
files 81
Testing (manual backup) 64
Testing policy configuration
Admin Console for UNIX 65
Admin Console for Windows 64
Transaction logs 7, 9, 14
and cumulative-incremental backups 32,
49
and differential-incremental backups 31,
48
deleting prior to a restore 81
deleting prior to restore option 75
Troubleshooting
client 107
Troubleshooting utilities 153

User backup 31, 48

Virtual Exchange Server, specifying 103

Wildcard characters
rules when using 35, 51
supported 34, 51
used to define groups of objects 34, 51
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